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Warranty.
This Agilent Technologies 
instrument product is war-
ranted against defects in 
material and workmanship for 
a period of one year from date 
of shipment. During the war-
ranty period, Agilent Technol-
ogies will, at its option, either 
repair or replace products 
which prove to be defective. 
For warranty service or repair, 
this product must be returned 
to a service facility desig-
nated by Agilent Technolo-
gies. Buyer shall prepay 
shipping charges to Agilent 
Technologies and Agilent 
Technologies shall pay ship-
ping charges to return the 
product to Buyer. However, 
Buyer shall pay all shipping 
charges, duties, and taxes for 
products returned to Agilent 
Technologies from another 
country.

Agilent Technologies war-
rants that its software and 
firmware designated by Agi-
lent Technologies for use with 
an instrument will execute its 
programming instructions 
when properly installed on 
that instrument. Agilent Tech-
nologies does not warrant that 
the operation of the instru-
ment, or software, or firmware 
will be uninterrupted or error-
free. 

Limitation of Warranty.
The foregoing warranty shall 
not apply to defects resulting 
from improper or inadequate 
maintenance by Buyer, Buyer-
supplied software or interfac-
ing, unauthorized modifica-
tion or misuse, operation 
outside of the environmental 
specifications for the product, 
or improper site preparation 
or maintenance.

No other warranty is 
expressed or implied. Agilent 
Technologies specifically dis-
claims the implied warranties 
of merchantability and fitness 
for a particular purpose.

Exclusive Remedies.
The remedies provided herein 
are buyer's sole and exclusive 
remedies. Agilent Technolo-
gies shall not be liable for any 
direct, indirect, special, inci-
dental, or consequential dam-
ages, whether based on 
contract, tort, or any other 
legal theory.
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to, could result in damage to 
or destruction of the product. 
Do not proceed beyond a cau-
tion sign until the indicated 
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WARNING
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hazard. It calls attention to a 
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to, could result in injury or 
loss of life. Do not proceed 
beyond a warning sign until 
the indicated conditions are 
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The instruction man-
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uct is marked with this 
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user to refer to the 
instructions in the 
manual.

The laser radiation 
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symbol is marked on 
products which have a 
laser output.
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required nature of the 
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power.
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used to mark the posi-
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power line switch.
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are used to mark the 
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ment power line 
switch.

The CE mark is a reg-
istered trademark of 
the European Commu-
nity.

The CSA mark is a reg-
istered trademark of 
the Canadian Stan-
dards Association.

The C-Tick mark is a 
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of the Australian Spec-
trum Management 
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This text denotes the 
instrument is an 
Industrial Scientific 
and Medical Group 1 
Class A product.

Typographical Conven-

tions.

The following conventions are 
used in this book:

Key type for keys or text 
located on the keyboard or 
instrument.

Softkey type for key names that 
are displayed on the instru-
ment’s screen.

Display type for words or 
characters displayed on the 
computer’s screen or instru-
ment’s display.

User type for words or charac-
ters that you type or enter.

Emphasis type for words or 
characters that emphasize 
some point or that are used as 
place holders for text that you 
type.

ISM1-A
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General Safety Considerations

This product has been designed and tested in accordance with IEC Publica-
tion 61010-1, Safety Requirements for Electrical Equipment for Measurement, 
Control and Laboratory Use and the standards listed on the Manufacturer’s 
Declaration of Conformity, and has been supplied in a safe condition. The doc-
umentation contains information and warnings that must be followed by the 
user to ensure safe operation and to maintain the product in a safe condition.

W A R N I N G No operator serviceable parts inside. Refer servicing to qualified 

personnel. To prevent electrical shock, do not remove covers.

W A R N I N G For continued protection against fire hazard, replace line fuse only 

with same type and ratings, (type T 0.315A/250V for 100/120V 

operation and 0.16A/250V for 220/240V operation). The use of other 

fuses or materials is prohibited. 

W A R N I N G Verify that the value of the line-voltage fuse is correct. 

• For 100/120V operation, use an IEC 127 5×20 mm, 0.315 A, 250 V, Agilent  
part number 2110-0449.

• For 220/240V operation, use an IEC 127 5×20 mm, 0.16 A, 250 V, Agilent 
Technologies part number 2110-0448.

W A R N I N G This is a Safety Class 1 product (provided with a protective earthing 

ground incorporated in the power cord). The mains plug shall only be 

inserted in a socket outlet provided with a protective earth contact. 

Any interruption of the protective conductor inside or outside of the 

product is likely to make the product dangerous. Intentional 

interruption is prohibited.

W A R N I N G To prevent electrical shock, disconnect the Agilent 8509C from mains 

before cleaning. Use a dry cloth or one slightly dampened with water 

to clean the external case parts. Do not attempt to clean internally.

W A R N I N G If this instrument is not used as specified, the protection provided by 

the equipment could be impaired. This product must be used in a 

normal condition (in which all means for protection are intact) only.
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W A R N I N G Do not stare directly into any optical port or into the ends of optical 

fiber patch cords. Any emitted light, although divergent, will cause 

permanent eye damage at sufficient power levels. Avoid exposure to 

light reflected by mirrors or other reflective surfaces.

W A R N I N G When a laser source is connected to the Agilent 8509C external source 

input, the Optical Output will emit laser light. This light, although 

divergent, will cause permanent eye damage at sufficient power levels.

W A R N I N G To avoid inadvertent exposure to laser light, extinguish the external 

laser source and enable the Agilent 8509C internal shutter before 

removing optical connectors from any optical port on the Agilent 

8509C. Refer to “Using the Shutter functions” on page 6-19 for more 

details on activating the internal shutter.

W A R N I N G Use of controls or adjustments or performance of procedures other 

than those specified herein may result in hazardous radiation 

exposure.

C A U T I O N Always use the three-prong ac power cord supplied with this product. Failure 
to ensure adequate earth grounding by not using this cord may cause product 
damage.

C A U T I O N This product is designed for use in Installation Category II and Pollution 
Degree 2 per IEC 61010-1 and 664 respectively.

C A U T I O N VENTILATION REQUIREMENTS: When installing the product in a cabinet, the 
convection into and out of the product must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the product by 4°C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater than 800 watts, 
then forced convection must be used.

C A U T I O N Maximum input power: The optical damage level for the Agilent 8509C Optical 
Input port is +16 dBm. Exceeding this power level may result in permanent 
damage to the instrument. Refer to “Receiver characteristics” on page 9-10 for 
more information.

Maximum output power: The power appearing at the Agilent 8509C Optical 
Output is the power inserted at the External Source Input port minus the 
External Source path insertion loss. Refer to “External Source Input Port, 
Fiber Size, and Analog Output Range Characteristics” on page 9-12.
iv
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Optical Output Port beam divergence: The Agilent 8509C input and output 
ports use standard SMF-28 9-micron single-mode fiber with a numerical aper-
ture of 0.14. This results in a beam divergence angle of 8° at 1550 nm.

Laser Aperture 

Location

Measurement accuracy—it’s up to you!

Fiber-optic connectors are easily damaged when connected to dirty or damaged cables 
and accessories. The Agilent 8509C’s front-panel INPUT connector is no exception. 
When you use improper cleaning and handling techniques, you risk expensive instru-
ment repairs, damaged cables, and compromised measurements.

Before you connect any fiber-optic cable to the Agilent 8509C, refer to “Cleaning Con-
nections for Accurate Measurements” on page 7-14.
v
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Setting Up the Lightwave Polarization Analyzer

This chapter shows how to set up your lightwave polarization analyzer, con-
nect power and accessories, and verify general operation.

Refer to Chapter 7, “Reference” for the following information:

• Tips on avoiding costly repairs by proper optical connection cleaning tech-
niques.

• List of available options, accessories, and power cords.

• Instructions on returning your instrument to Agilent Technologies for service.

• Agilent Technologies service offices.

• Accuracy enhancement and troubleshooting information.
1-2
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Installation 

The lightwave polarization analyzer is preconfigured at the factory and 
requires a minimal amount of time to complete. All that is required to install 
the system is to unpack the pieces, correctly connect them, and turn them on.

For the quickest installation of your Agilent 8509C system, use the Installa-

tion Quick Reference Card that came attached to the top cover of your light-
wave polarization analyzer.

Tools needed No special tools are required for the basic installation of the Agilent 8509C 
system. A small flat-blade screwdriver may be used to secure the monitor and 
analyzer interconnect cables. 

Installation 

overview 

The installation consists of unpacking the pieces of the system, correctly con-
necting them, and then turning them on. 

After installation is complete, operation verification is performed to verify that 
the system is operating properly. 

If you encounter a problem while performing the installation or operation ver-
ification, refer to “If You Have a Problem” on page 7-24.
1-3
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Power Requirements

The power requirements include line frequency in the range of 47 to 66 Hz, 
and 200 VA maximum. Other power requirements for the lightwave polariza-
tion analyzer are listed in Table 1-1. 

On the lightwave polarization analyzer, set the line-voltage selector to the 
voltage corresponding to the power source used. The line voltage selector is 
located on the rear panel of the polarization analyzer. 

Table 1-1. Fuses

Available ac 
Voltage 

Voltage Range Fuse Type Agilent Part 
Number

100 V 90 to 110 V rms 2.00 A F 2110-0002

120 V 108 to 132 V rms 2.00 A F 2110-0002

220 V 198 to 242 V rms 1.00 A F 2110-0001

240 V 216 to 250 V rms 1.00 A F 2110-0001

Note

If you need to change the switch setting or the fuse, refer to Figure 1-1 and use a small 
flat-blade screwdriver to pry open the line module cover door. 
1-4
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Figure 1-1. Voltage selector

C A U T I O N Do not attempt to rotate the voltage selector cam while it is installed in the line 
module or non-repairable damage will result. The cam must be completely 
removed from the line module, rotated to the proper position, and reinstalled. 
Refer to the instruction below.

Replacement of Fuse

1 Pry open line module cover door.

2 Pull out fuse carrier.

3 Insert fuse of proper rating.

4 Place carrier back into line module.

Selection of Operating Voltage

1 Pry open line module cover door.

2 Remove cam from the line module.

3 Rotate the cam to the desired voltage. (When the line module cover is closed, 
the selected voltage will be visible through a small window).

4 Insert the cam back into the line module.

5 Close the line module cover door.
1-5
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Step 1. Unpack and Inspect the System

 

Figure 1-2. Package contents for the Agilent 8509C

� Inspect the shipping container for damage.

� Inspect the instrument.

� Verify that you received the options and accessories you ordered. 

� Gather the items shown in Figure 1-2, and put all other hardware, documenta-
tion, and software aside for now. 

Keep the shipping container and cushioning material until you have inspected 
the contents of the shipment for completeness and have checked the light-
wave polarization analyzer mechanically and electrically.
1-6
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If anything is missing or defective, contact your nearest Agilent Technologies 
Sales Office. If the shipment is damaged, contact the carrier, then contact the 
nearest Agilent Technologies Sales Office. Keep the shipping materials for the 
carrier’s inspection. The Agilent Technologies Sales Office will arrange for 
repair or replacement at Agilent Technologies’ option without waiting for 
claim settlement.
1-7
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Step 2. Stack and Connect the System 

Figure 1-3. Agilent 8509C system

1 Set the lightwave polarization analyzer on your work surface. Place the 
instrument controller next to the lightwave polarization analyzer, place the 
monitor on top of the instrument controller. Place the keyboard in front of the 
instrument controller and place the mouse to the side of the system. Refer to 
Figure 1-3 for an example of how to stack your system. 

2 Connect the system as shown in Figure 1-4. 

a Connect the lightwave polarization analyzer to the instrument controller us-
ing the dedicated interface cable. 

b Connect the monitor, keyboard, and mouse to the instrument controller. Re-
fer to Figure 1-4 for locations of ports. 

Note

Do not stack the instrument controller or monitor on top of the lightwave polarization 
analyzer.
1-8
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c Tighten connections with a small flat-blade screwdriver. 

 

Figure 1-4. System connections 
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Step 3. Power Up the System 

1 Connect the three power cords (one each from the instrument controller, the 
monitor and the analyzer) to the line voltage. 

2 Press the front-panel power switches on the analyzer, instrument controller, 
and monitor. 

3 After the instrument controller is turned on, Microsoft Windows1 and the 
Agilent 8509C software are automatically loaded. After about 45 seconds the 
basic measurement screen should appear on the instrument controller display, 
similar to Figure 1-5. 

Figure 1-5. The Agilent 8509C user interface basic measurement screen

You will hear a series of clicks as the internal mechanical polarizer is initial-
ized; then the zeroing routine is performed. You will notice a green zeroing 
message in the power display while this procedure is being executed. 

1. Microsoft Windows is a U.S. registered trademark of Microsoft Corporation.
1-10
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4 Perform the operation verification now to ensure the lightwave polarization 
analyzer is working properly.

If you encounter a problem while performing the installation or operation ver-
ification, refer to “If You Have a Problem” on page 7-24.
1-11
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Step 4. Operation Verification

Figure 1-6. Agilent 8509C front panel

The operation verification is designed to be performed when you first receive 
and install your Agilent 8509C (option 210, 220) and thereafter on a regular 
basis. If performed successfully, it will give you a high degree of confidence 
that your analyzer is working properly. 

Required 

Equipment 

The following items are needed to perform the operation verification: 

• Optical source of known wavelength in one of the two following ranges. 

between 1280 and 1340 nm 
between 1470 and 1640 nm

• High-quality single mode patchcords. Refer to Table 1-2.
1-12
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Preliminary Steps 

1 Turn on the lightwave polarization analyzer and allow it to warm up for at least 
one hour. 

2 Clean all optical connectors and adapters using isopropyl alcohol and cotton 
swabs. Refer to “Cleaning Connections for Accurate Measurements” on 
page 7-14.

3 Ensure that the optical cable connecting the external source to the lightwave 
polarization analyzer’s OPTICAL INPUT is stable. This can be accomplished by 
taping the cable to the work surface if necessary. 

4 Connect the equipment as shown in Figure 1-7 on page 1-14. 

5 Zero the analyzer by selecting System and then Zero. You will notice the green 
zero message will appear in the Power display while the analyzer is zeroing. 

Table 1-2. Recommended Patchcords

Connector Type Option Number

HMS-10 011

FC/PC 012 (shipped with instrument)

DIN 013

ST 014

Biconic 015

SC 017
1-13
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Figure 1-7. Equipment setup 

Setup Your Source 

6 Select λ. The Optical Source Setup window will appear on the display, as shown 
in Figure 1-8.

 

Figure 1-8. Optical Source Setup window 

7 Select your source type from the Optical Source Selection menu. 

8 Input the wavelength of your optical source (to an accuracy of ±1 nm) using 
the keyboard. 

9 Select Done. The optical source setup window will disappear. 
1-14



Setting Up the Lightwave Polarization Analyzer
Step 4. Operation Verification

book.book  Page 15  Thursday, March 29, 2001  12:14 PM
Adjust For Maximum Power 

10 Adjust the two large External Source Polarization knobs to obtain maximum 
power into the receiver. Observe the power display while turning the knobs to 
monitor power. 

 

Figure 1-9. Agilent 8509C basic measurement screen 

Operation Verification 

The operation verification procedure is a fully automatic pass/fail indicator of 
your system’s performance. 

11 Make sure that the optical cable connecting the polarizer to the lightwave 
polarization analyzer’s OPTICAL INPUT is stable. This can be accomplished by 
taping the cable to the work surface if necessary. 

12 Select System from the main window display, then select Operation Verification. 
1-15
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Figure 1-10. Operation Verification window 

13 Select Start. When the verification procedure is finished, the message 
Operation Verification passed will be displayed in the message 
window, and the Max, Min, and Mean DOP values and polarizer angles will be 
displayed.

14 The operation verification is now complete. You may select Done to clear the 
window and begin your measurement.

If you encounter a problem while performing the installation or operation ver-
ification, refer to “If You Have a Problem” on page 7-24.
1-16
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A Quick Tour

The Agilent 8509C lightwave polarization analyzer offers high-speed, cali-
brated polarization measurements of optical signals and components. 

This chapter describes the functions that are available from the basic mea-
surement screen initially displayed when the analyzer is turned on and a brief 
overview of the functions accessed from the main menu.
2-2
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The Main Menu

 

Figure 2-1. The Agilent 8509C basic measurement screen

Screen shots may reflect an older software version than the currently used 
version.
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Data Displays

Refer to Figure 2-1 on page 2-3 for the location of the displays on the basic 
measurement screen. 

Power

The power of the optical signal under test is displayed as both a horizontal bar, 
and a digital readout. When the receiver zeroing routine is being performed, a 
green zero message appears in the power display. Red Overrange and 
Underrange messages appear here also. 

DOP

The Degree of Polarization (DOP) is displayed as both a horizontal bar and a 
digital readout. For the most reliable and accurate measurements, use polar-
ized light that approaches 100% DOP. 

Polarization ellipse 

The polarization ellipse provides a two-dimensional visual representation of 
the state of polarization of an optical signal and corresponds with points on 
the Poincare sphere. 
2-4
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Markers 

The marker window, in the lower-left corner of the Agilent 8509C display, 
always displays the Stokes parameters, comprised of the average optical 
power (S0), in dBm, and the normalized Stokes parameters (s1, s2, and s3). 
Stokes parameters for the current data point are on the top line(s) of the 
marker table.

When marker A, B, or C is set, the respective parameters will also be displayed 
adjacent to the respective marker button (A, B, or C). For additional informa-
tion regarding Stokes parameters, refer to “Stokes parameters” on page 4-100.

 

Figure 2-2. The Marker window 

To set a marker

There are two ways to set markers on the Poincare sphere: 

• set a marker at the current data point, or 

• set a marker at a user-specified point on the sphere (regardless of where the 
current data point is). 

In both of these cases, when a marker is set, the Stokes parameters for the 
particular marker (A, B, or C) always appears in the table in the Markers win-
dow. However, for the marker to appear on the Poincare sphere, the Markers 
must be turned ON. 
2-5
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To set a marker at the current data point 

1 Select A, B or C (on the left side of the Marker window) to set a marker on the 
Poincare sphere at the current data point. (See Figure 2-3.) 

Once a marker has been set, the Stokes parameters for the marker point will 
be displayed in the marker table.

 

Figure 2-3. Setting a marker 

To set a marker at a user-specified point 

1 Move the mouse pointer to the point on the front face of the sphere where you 
want to place a marker. 

2 Double-click the left button on the mouse. The Set Marker window appears 
below the Poincare sphere (see Figure 2-4). 

3 Use the mouse to select A, B, or C to set a marker at the place on the sphere 
where you double-clicked the mouse. 

4 Notice that the Stokes parameters for that point appear in the marker table in 
the marker window. 

5 If you have decided not to set a marker and wish to close the Set marker 
window, select None. 

Additional Information

Once a marker has been set, it is fixed on the sphere and cannot be adjusted to move 
along a trace. 
2-6



A Quick Tour
Data Displays

book.book  Page 7  Thursday, March 29, 2001  12:14 PM
 

Figure 2-4. Set marker window 

To turn the markers on and off

When the markers are turned ON, there is an "X" in the Markers On box (see 
Figure 2-5). 
 

Figure 2-5. Turn markers on/off 

When the markers are turned ON and you set a marker, the Stokes parameters 
appear in the marker table, and the marker appears on the Poincare sphere. 

When the markers are turned OFF, the Stokes parameters still appear in the 
marker table, but the marker will not appear on the Poincare sphere. 
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To clear the markers

 

Figure 2-6. Clear markers 

Select Clear Markers to remove the markers from the sphere and clear the 
Stokes data in the marker table associated with markers A, B, and C. 

To center the sphere on a marker or current point

 

Figure 2-7. Center sphere on marker 

The buttons along the right side of the marker box correspond to the current 
data point and the three markers. These buttons can be used to rotate the 
sphere so that the selected point or marker is front and center. 
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To set a two- or three-point polarization reference

For information on setting a two- or three-point polarization reference frame, 
refer to “Making Polarization Reference Frame Measurements” on page 4-85. 

Poincare sphere 

The Agilent 8509C Poincare sphere is a three-dimensional graphing system 
showing all possible states of polarization. A dot or trace on the sphere repre-
sents the polarized portion of the lightwave signals as measured inside the 
instrument’s receiver. The reference frame feature allows the Poincare sphere 
to display a signal’s state of polarization relative to a user-defined reference 
frame. 

Zoom and Rotate

 

Figure 2-8. Zoom and Rotate 

To zoom in or out

To zoom in on data on the Poincare sphere, select either In→ or → →. Use In→ 
to advance the zoom factor in increments of one. Use → → to advance the 
zoom factor more rapidly. 

To zoom out, select either ←Out or ← ←. Use ←Out to decrease the zoom fac-
tor in increments of one. Use ← ← to decrease the zoom factor more rapidly. 
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To set the zoom factor

You can use the zoom factor function in two ways: 

• Select this function in a zoomed condition to immediately bring the zoom factor 
back to 1 without having to use the Out buttons. 

• Select this function when the factor is 1 to set the zoom factor to the most re-
cently visited zoom factor. 

To rotate the sphere 

To rotate the sphere, select any of the four arrows in the Rotate area (refer to 
Figure 2-8). The sphere will rotate in the direction of the selected arrow. 

To return the sphere to the default orientation

To return the sphere to the default orientation, select Home. 

C A U T I O N Any time you rotate the sphere, the trace is cleared. The only exception to this 
is when you are viewing a recalled data trace or a timed measurement. (Refer 
to Chapter 3, “Using the File Menu”.) In these cases, the recalled trace will not 
be cleared as the sphere is rotated. 

Additional Information 

Since the Poincare sphere is a three-dimensional representation, it is helpful to know 
that the graticules (equator and longitude lines) are solid lines on the front of the sphere, 
and broken lines on the back of the sphere. Data on the front of the sphere is shown in 
red, and data on the back of the sphere is shown in blue. 
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Clear Trace and Hold

 

Figure 2-9. Clear Trace and Hold 

To clear the Poincare sphere of previously displayed data points

Select Clear Trace. The Agilent 8509C will immediately resume data display 
unless the Hold function has been activated. 

To activate the hold function

When Hold is activated, the Agilent 8509C does not update the Poincare 
sphere display, the power display, the DOP display, the polarization ellipse, or 
the Stokes parameters (in the Marker window). When the Hold function is 
activated, there is an "X" in the Hold box. Hold is toggled on and off by select-
ing Hold (refer to Figure 2-9). Putting the instrument on Hold dramatically 
speeds up graphics and computational activity in the computer. Put the 
Agilent 8509C in Hold when running other software programs. 
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λ and Cal

 

Figure 2-10. λ and Cal 

To display the Optical Source window

Select λ. Refer to “Using the Optical Source functions” on page 6-4 for more 
information.

To display the source wavelength 

The source wavelength is displayed next to the λ function. 

To display whether a user-performed calibration has been applied

The Cal function indicates whether or not a user-performed calibration has 
been applied. If a wavelength calibration has been applied, the word Cal 
appears in bold (black) lettering. If a calibration has not been applied, the 
word Cal appears in gray lettering. Refer to “Using the Calibration functions” 
on page 6-6 for instructions on performing a wavelength specific calibration. 
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The Menu Bar

The Menu bar includes the File, Edit, Measurement, Display, System, and Help 
drop down menus.

File menu

Most of the menu items under this selection are explained in Chapter 3, “Using 
the File Menu”.
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Edit menu

This selection allows you to copy the display or a measurement window to the 
Clipboard.

Note: The Edit Menu allows you to print the screen in bitmap format, but will 
not print the data.
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Measurement menu

The measurement selections are discussed in Chapter 4, “Using the Measure-
ment Menu”. 
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Display menu

The items in the Display menu are discussed in Chapter 5, “Using the Display 
Menu”. 
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System menu

The system functions are described in Chapter 6, “Using the System Menu”. 
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Help menu

The About Agilent 8509 menu allows you to determine information such as the 
software version, free memory, and the 8509 serial number.
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The File Menu

This chapter contains information about the File menu (in the main window), 
which allows you to print, save, and recall measurement results and instru-
ment configurations. 
 

Figure 3-1. File menu

The following functions are available:
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Function See....

Load “To save and recall instrument configurations” on page 3-4 
“To create a configuration file with factory defaults” on page 3-5
“To recall the preset configuration” on page 3-5
“To recall a user configuration” on page 3-6
“To recall measurement results” on page 3-7

Save “To save measurement results” on page 3-11 
“To save a user configuration” on page 3-13

Print “To print measurement results” on page 3-14

Database.... “To retrieve previously archived measurements” on page 3-18
“To perform database operations” on page 3-19

Additional Information

For step-by-step instructions on making measurements and for more detailed informa-
tion about a particular measurement, refer to Chapter 4, “Using the Measurement 
Menu”. For information regarding calibrations, refer to Chapter 6, “Using the System 
Menu”. 
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Using the Load functions

 

Figure 3-2. Load menu 

To save and recall instrument configurations

The Agilent 8509C always starts up with a set of default conditions. These sets 
of conditions are called "configurations", and the necessary parameters are 
stored in configuration files which are loaded at start-up. 

You can change conditions via the pull-down menus. If you want to save par-
ticular sets of conditions to use later without having to reset all the conditions 
manually, you can save configurations in files and recall them later.

Note: At start-up, the default configuration file, hp8509.cfg, is used to initial-
ize the lightwave polarization analyzer. Any changes to the default configura-
tion file will change the default power-on conditions of the analyzer.

The Agilent 8509C recalls the configuration file hp8509.cfg at start-up. The 
polarization analyzer searches in the following sequence: 

• First in the windows working directory. 
• Second in the application’s directory. 
• Finally in the Windows system directory. 

The polarization analyzer uses the first file it finds. If it cannot find a file, the 
polarization analyzer uses the preset configuration. The preset configuration is 
set in the factory and never changes. 

To start the Agilent 8509C with other than the default hp8509.cfg configura-
tion file, add this command line parameter to the icon’s properties: /CFG=file-

name, where filename is the name of the configuration file you want to use. A 
command line parameter follows the name of the program in the Windows 
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Program Manager properties Command Line entry. This window is accessed 
by highlighting the Agilent 8509C icon and selecting File, Properties in the Win-
dows Program Manager, or pressing ALT+ ENTER on the keyboard. 

To create a configuration file with factory defaults 

1 From the lightwave analyzer Windows menu, select File, Load, PRESET 
Configuration. 

2 Select File, Save, User Configuration. 

3 Name the file. The application default file name is hp8509.cfg. Give the file this 
name if you wish to restore the default configuration to the preset (factory 
default) configuration. 

To recall the preset configuration 

The default or preset configuration puts the lightwave polarization analyzer in 
the default state. This is the configuration the lightwave polarization analyzer 
is in at power-on. 

Procedure 

1 Load the preset condition by selecting File, Load, PRESET Configuration. 

2 A window appears asking you to confirm the load preset command. See 
Figure 3-3. Select OK to load the preset configuration, or select Cancel to cancel 
the command. 

Additional Information 

Some instrument conditions are saved automatically to the database when you use the 
Save to Database features. Examples include the wavelength start, stop, and delta 
parameters for PMD measurements. However, these parameters alone are not sufficient 
to configure the instrument. 
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Figure 3-3. PRESET confirmation window 

To recall a user configuration 

User configurations allow you to store instrument states you want to use 
again. Use the procedure below to recall a user configuration. 

Procedure 

To call up an instrument state that has been stored: 

1 Select File, Load in the main menu. 

2 Select User Configuration. 

3 The Load: Configure File window opens. See Figure 3-4 on page 3-6. 

4 Choose a configuration to open by specifying the drive, directory and filename 
by typing the complete path in the File Name box. You can also use the mouse 
to select the drive, path and file. 

5 Select OK when the file you want appears in the File Name box. 

 

Figure 3-4. Load: Configure File window 
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To recall measurement results

After saving measurement results, you can recall and view the results as sum-
marized in Table 3-1 on page 3-17. Recall the results using the Agilent 8509C 
instrument controller software and/or separate word processor, spreadsheet, 
or database program as noted. Agilent 8509C procedures are discussed in 
detail below. Numeric word processor, spreadsheet, or database file formats 
are discussed briefly at the end of this section.

Agilent 8509C File Recall

Procedure 

The following procedure describes how to use the analyzer’s FILE, LOAD menus 
to recall measurement results. The measurement FILE, LOAD menus for the 
PMD measurements are explained within the PMD:JME and PMD:Wavelength-
scanning measurement sections in Chapter 4, “Using the Measurement Menu”. 

1 Select FILE, LOAD, and then one of the Load sub-menu selections shown in 
Figure 3-2 on page 3-4. 

2 For text files, select the drive, directory, and file where the desired trace is 
stored, and then select OK. Measurement results will be recalled and displayed 
as summarized in Table 3-1 on page 3-17. 

3 For database files, select the desired measurement from the drop-down list 
then select LOAD.

4 For a detailed description of the database file loading operation, refer to “To 
perform database operations” on page 3-19.

5 To resume normal operation of the lightwave polarization analyzer, toggle the 
Hold function by selecting Hold. See Figure 3-5 on page 3-8. 

Additional Information

While a recalled trace is being viewed on the Poincare sphere, the lightwave polariza-
tion analyzer data displays become inactive. See Figure 3-5 on page 3-8. Also note that 
the wavelength readout in the upper-right corner is gray (inactive). This is to remind the 
user that the displayed wavelength is the wavelength with which the Single Sweep was 
taken, but not necessarily the current wavelength.
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Agilent 8509C File Recall 

Results 
 

Figure 3-5. Viewing a stored Timed measurement trace on the Poincare sphere 

Word Processor, Spreadsheet and Database Numeric File

Format 

The "comma delimited ASCII format" for each measurement is shown below. 
This format is useful for spreadsheet users and database analysis programs. 

The following symbols are used in the format descriptions of this section. 

λ = wavelength 

S
x
 = Stokes parameter 

S
0
 = average optical power 

s
x
 = normalized Stokes parameter (= S

x 
/ S

0
) 

DGD = differential group delay 

DOP = degree of polarization 

( ) = units 
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Refer to the appropriate user information outside of this manual if measure-
ment results are being recalled using a separate word processor, spreadsheet 
or database program. 

PMD: Jones Matrix Eigenanalysis Save

Format

λ
n
,λ

n+1
,DGD (units are unspecified) 

Example

1500,1501,.2310215 

PMD: Wavelength-Scanning Save

Format

λ
n
(nm),S

0
(dBm),s

1
,s

2
, s

3
,DOP(%) 

Example

1525,-2.704419,-.9104293,-.3429706,.2233345,99.81926 

PDL: Jones Matrix and Jones Matrix Save

Format

Absolute Measurement Flag, PDL Delta, PLD Max, PDL Min 
J00.real, j00.imag 
J01.real, j01.imag 
J10.real, j10.imag 
J11.real, j11.imag 

where: Absolute Measurement Flag is "1" if the Jones matrix PDL measure-
ment is absolute and "0" if it is relative. In the case of a relative measurement, 
PDL Max and PDL Min are both "0". 

Example

1,3.017851E-02,.0171138,-1.306471E-02
.296185061242171,-.746302479489197 
.137726371786746,.58206929707534 
.488929498642804,.3450943751558 
.800210126957622,0 

Timed Measurement As Text Save 

Format

λ
n
(nm) 

S
0
(mW),S

1
,S

2
,S

3
,DOP(%) 
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Example

1537 
.1844145,-8.568172E-02,-.1516657,-5.691557E-02,99.37248 

Additional Information 

The Save format for Timed Measurements to database uses normalized Stokes parame-
ters. 
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Using the Save functions

 

Figure 3-6. Save menu 

To save measurement results

PMD, PDL, Jones matrix, and Timed polarization measurements can be saved 
for future use. 

The Agilent 8509C provides two ways to save data for PMD:JME, PMD:WS, 
and Timed measurements: Microsoft Access database and text files. The data 
stored in Agilent 8509C text files is very limited and is primarily useful for 
importing data into a spreadsheet. Database files are much more versatile. You 
can move the database file to another computer to do sophisticated analysis of 
the measurements, and continue using the instrument. For example, you may 
wish to examine the PMD measurements for a particular device type during 
the month of May. Since the Agilent 8509C database is a relational database, it 
allows you to filter out all the unwanted data and view only those measure-
ments that are of interest. In addition, Microsoft Access also has many mathe-
matical functions built in, so that the measurements can be analyzed 
statistically. This is helpful in a production environment where Statistical Pro-
cess Control (SPC) can spot production trends early and lead to improved 
processes. You can extend the Microsoft Access database file, created by the 
Agilent 8509C, to add fields and tables which are updated by other stages in 
the production process or by sales or shipping departments. 

See the database read-me file in the Agilent 8509C program group for addi-
tional information and for a map of the Agilent 8509C database. 

After performing a measurement, the results can be saved as summarized in 
Table 3-1 on page 3-17. Use the FILE, SAVE menu selections shown in 
Figure 3-6. The measurement FILE menus for the PMD measurements are 
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located within the PMD: JME and PMD: wavelength-scanning measurement 
sections of this manual. All other measurement FILE menus are located in the 
analyzer’s main window as shown in Figure 3-6. 

Procedure 

1 To save measurement results, first make the desired measurement. 

2 Save the resulting data by selecting File, Save. 

3 Select one of the following items. 

Timed Measurement to Database 
Timed Measurement as Text 
Jones Matrix & PDL: Jones Matrix 

4 You will see either the Save As: Text File window (Figure 3-7), or a dialog box 
for adding the measurement to the database. 

 

Figure 3-7. Save As: Text File window 

5 Specify the drive, path and filename by typing it in the File Name window, or 
type the filename in the File Name window and use the mouse to select the 

Additional Information 

Refer to Figure 3-6. You must make a measurement before the lightwave polarization 
analyzer allows you to save data. Once you make a measurement, the corresponding 
command in the Save menu appears in black lettering. 
3-12



Using the File Menu
The File Menu

book.book  Page 13  Thursday, March 29, 2001  12:14 PM
drive and the directory. 

The filename will have the default extension ".txt". 

6 Once you have named the file, drive and directory, select OK, and the 
measurement data will be stored. 

To save a user configuration

You can save any instrument configuration to a file for later use. This is useful 
for recalling the configuration of an instrument setup you use frequently. 

Procedure 

To save a particular configuration, first set the lightwave polarization analyzer 
to the configuration you want to save, and then follow the steps below: 

1 Select File, Save from the main menu. 

2 Select User Configuration. 

3 The Save As: Configure File window opens. See Figure 3-8 on page 3-13. 

4 Enter the drive, path and filename by typing it in the File Name box, or by 
typing the filename in the File Name box and using the mouse to select the 
drive and directory. 

The filename will have the default extension ".cfg". 

5 Select OK, and the file is stored. 

 

Figure 3-8. File Save As: Configure File window
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Using the Print functions

 

Figure 3-9. Print menu 

To print measurement results 

The lightwave polarization analyzer print function uses the Microsoft Windows 
print drivers. It is necessary that you use the proper Microsoft Windows print 
drivers to print your documents. The printer used is the default printer in the 
Windows control panel. 

Detailed instructions for installing serial (RS-232) and parallel interfaced 
printers are provided in the Microsoft Windows User’s Guide. 

Standard printing Procedure 

Once you make a measurement, you can print the results. 

1 Select File, Print.

2 Select one of the following options:

Sphere Display Prints only the Poincare sphere. 

Analyzer Window Prints the entire main measurement window display.

PDL: Jones Matrix Window Prints the Jones matrix PDL measurement window. 

PDL: Power Max-Min Window Prints the power max-min PDL measurement window.

Jones Matrix Window Prints the entire Jones matrix measurement window.

Calibration Window Prints the entire wavelength calibration measurement window.
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Customized 

printing 

An Agilent 8509C measurement window can be customized and inserted into a 
text document or slide presentation for printing by using the following proce-
dure. An example is shown in Figure 3-10. This procedure uses the Clipboard 
and Paintbrush graphics program which are included with the Agilent 8509C 
instrument controller. 

Results 
 

Figure 3-10. Customized printing example

Procedure 

1 Create the desired Agilent 8509C measurement display. You may choose to 
maximize the display by selecting the double carrot located in the upper-right 
corner of the Agilent 8509C measurement window. 

2 Press Print Screen on the upper-right side of the Agilent 8509C instrument 
controller keyboard. 

3 Select Hold. 
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4 Use the mouse to minimize the Agilent 8509C measurement window by 
selecting the down carrot in the upper-right corner of the Agilent 8509C 
measurement window. This will cause the Agilent 8509C window to become a 
small icon at the bottom of the screen and reveal the Windows Program 
Manager. 

5 Locate the Accessories icon and select it using the mouse. 

6 When the Accessories icon opens, select the Paintbrush icon. 

7 When the Paintbrush program is running, select the View menu at the top of 
the screen. Select Zoom Out. 

8 Highlight the Edit menu and select Paste and Paste again. 

9 From the View menu, select Zoom In and begin customizing graphics and text. 

10 When the desired Paintbrush display is achieved, save it to a file name using 
the appropriate format. The appropriate format depends on the word 
processor or graphics program that will be used. AmiPro and Freelance for 
example can easily import or receive pasted graphics using a bit map (BMP) or 
PCX format. 

Measurement data is saved and recalled according to the formats and viewing 
options listed in Table 3-1. 
3-16



Using the File Menu
The File Menu

book.book  Page 17  Thursday, March 29, 2001  12:14 PM
Table 3-1. Summary of Agilent 8509C Measurement Results Save/Recall Features

MEASUREMENT 
DATA

SAVE OPTIONS FORMAT RECALL (LOAD) 
OPTIONS

VIEWING OPTIONS 

PMD: Jones Matrix 
Eigenanalysis

PMD JME to Database Microsoft Access 
Database Format 

PMD JME from 
Database 

Graph, Tabular Data 

PMD JME to Text Comma Delimited 
ASCII

Word Processora, 
Spreadsheet 

File Contents 

PMD Statistics 
program 

DGD vs Wavelength 
and DGD Histogram 

PMD: Wavelength-
Scanning 

PMD WS to Database Microsoft Access 
Database Format

Microsoft Access 
Database

Graph Poincare Sphere 
Tabular Data 

PMD WS to Text Comma Delimited 
ASCII

Word Processora, 
Spreadsheet

File Contents 

PDL: Jones Matrix Jones Matrix & 
PDL: Jones Matrix

Comma Delimited 
ASCII

Word Processora, 
Spreadsheet

File Contents 

Jones Matrix Jones Matrix & 
PDL: Jones Matrix

Comma Delimited 
ASCII

Word Processora, 
Spreadsheet

File Contents 

State of Polarization 
(using timed 
measurement only)

Timed Measurement 
to Database 

Microsoft Access 
Database Format

Timed Measurement 
from Database

Poincare Sphere 

Timed Measurement 
to Text

Comma Delimited 
ASCII

Timed Measurement 
from Text

Poincare Sphere 

Word Processora, 
Spreadsheet

File Contents via other 
software applications 

Degree of Polarization 
(using timed 
measurement only)

Timed Measurement 
to Database

Microsoft Access 
Database Format

Microsoft Access only 

Timed Measurement 
to Text

Comma Delimited 
ASCII

Word Processora, 
Spreadsheet

File Contents 

a. Refer to the Microsoft 7410 Windows User’s Guide for information regarding “Notepad” and “Write”, the word processors provided with
Microsoft Windows.
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Using the Database functions

The database interface allows you to retrieve previously archived measure-
ments, create a new database file, open a previously created database, repair a 
corrupted database structure, reduce the database size, and close the cur-
rently open database.

Figure 3-11. Database Interface

To retrieve previously archived measurements

Polarization mode dispersion (PMD) is a fundamental physical property of 
optical fiber and components in which a lightwave is split into two waves of 
slightly different speed on the basis of the polarization state. The Jones matrix 
eigenanalysis (JME) method is a typical measurement result showing the dif-
ferential group delay as a function of wavelength. Refer to “Using the Jones 
matrix eigenanalysis method” on page 4-5 for additional information and mea-
surement setup.

The wavelength-scanning (WS) method includes the measurement of medium 
to long optical fibers and cables. It can also be applied to the measurement of 
some components, and may be used to characterize amplified systems in 
which the level of PMD is large enough to produce a usable number of peaks 
and valleys in the response within the system passband. Refer to “Using the 
wavelength-scanning method” on page 4-38 for additional information and 
measurement setup.

The Timed Measurements provide a means for measuring and saving the 
polarization parameters of an optical signal as a function of time. Saved mea-
surements can be recalled for viewing on the Poincare sphere or imported to a 
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spreadsheet for analysis. Timed Measurement data is preserved when the 
Poincare sphere is rotated or zoomed. Refer to “Making Timed Measurements” 
on page 4-103.

The three measurement retrievals are:

• PMD:JME
• PMD:WS
• Timed: Timed Measurement

The Database Interface window displays the saved information at the time of 
the measurement. Such as:

• Date and Time
• Wavelength ranges and step sizes
• Device date codes and serial number
• Data points
• PMD values (PMD only)
You can Load or Delete a particular measurement from the database.

To perform database operations

You can create, open, repair, reduce database size, and close currently opened 
databases from this menu.

The following database menus are available:

New Database creates a new database file
Open Database opens a previously created database
Repair Database attempts to repair a corrupted database structure
Compact Database attempts to reduce the database size
Close Database closes the currently open database
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4

Making PMD Measurements 4-4
Using the Jones matrix eigenanalysis method 4-5
Using the wavelength-scanning method 4-38

Making PDL Measurements 4-54
Using the Jones matrix method 4-54
Using the power max-min method 4-64

Making Jones Matrix Measurements 4-70
Making Polarization Maintaining Fiber Launch Alignments 4-79
Making Polarization Reference Frame Measurements 4-85
Making State of Polarization Measurements 4-93
Making Marker Angles 4-101
Making Timed Measurements 4-103

Refer to “Accuracy Enhancement and Troubleshooting” on page 7-2 for information 
regarding measurement accuracy enhancements and troubleshooting information.
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The Measurement Menu

This chapter contains information about the Measurement menu (in the main 
window), which allows you to make polarization mode dispersion (PMD), 
polarization dependent loss (PDL), Jones matrix, PM fiber launch alignments, 
marker angles, and timed measurements.

Figure 4-1. Measurement menu
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The following functions are available:

Function See....

PMD measurements “Making PMD Measurements” on page 4-4

PMD:Jones Matrix Eigenanalysis.... “Using the Jones matrix eigenanalysis method” on page 4-5

PMD:Wavelength Scanning.... “Using the wavelength-scanning method” on page 4-38

PDL measurements “Making PDL Measurements” on page 4-54

PDL: Jones Matrix.... “Using the Jones matrix method” on page 4-54

PDL: Power Max - Min.... “Using the power max-min method” on page 4-64

Jones Matrix.... “Making Jones Matrix Measurements” on page 4-70

PM Fiber Launch “Making Polarization Maintaining Fiber Launch Alignments” on page 4-79

Marker Angles “Making Marker Angles” on page 4-101

Timed Measurement “Making Timed Measurements” on page 4-103
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Making PMD Measurements

Function See....

PMD:JME measurements “To make a PMD:JME measurement” on page 4-6
“To manipulate the measurement results” on page 4-17
“To change the measurement format” on page 4-19
“To change the graph’s Y-scale” on page 4-20
“To display data in tabular format” on page 4-21
“To print data in tabular format” on page 4-21
“To display data in a statistical format” on page 4-22
“To print the PMD:JME graph” on page 4-27
“To save your measurement as text” on page 4-28
“To save in database format” on page 4-28

Specialized measurements “To perform a cascade measurement” on page 4-29
“To use a voltage-tuned source” on page 4-33
“To use a manually-tuned source” on page 4-34

Concepts “Polarization mode dispersion” on page 4-34
“Fiber PMD statistics” on page 4-35
“Source spectral characteristics” on page 4-36
“Should I use the reference frame?” on page 4-36
“Cascade measurements” on page 4-37

PMD:WS measurements “To make a PMD:WS measurement” on page 4-39
“To manipulate the measurement results” on page 4-43
“To change the measurement format” on page 4-46
“To display data in tabular format” on page 4-48
“To print data in tabular format” on page 4-48
“To print the PMD:WS graph” on page 4-49
“To save your measurement as text” on page 4-49
“To save in database format” on page 4-50

Concepts “Polarization mode dispersion” on page 4-51
“Optimizing the setup for fiber or component test” on page 4-52
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Using the Jones matrix eigenanalysis method

Polarization mode dispersion (PMD) is a fundamental physical property of 
optical fiber and components in which a lightwave is split into two waves of 
slightly different speed on the basis of polarization state. At a given wave-
length, these two polarization modes experience a difference in propagation 
time known as "differential group delay" (DGD). The DGD of long optical 
fibers varies with wavelength. The "PMD" of a test device also refers to the 
average value of the differential group delay. PMD is fundamentally expressed 
in units of time, typically picoseconds (1 ps = 10–12 s). In the case of long 
fibers, it may be normalized to the square root of fiber length with the units of 
picoseconds per root kilometer. 

This section explains how to measure the PMD of a test device using the Jones 
matrix eigenanalysis (JME) method, available in the Agilent 8509C. A typical 
measurement result, showing the differential group delay as a function of 
wavelength, is shown in Figure 4-2. 
 

Figure 4-2. Example of data display for a PMD:JME measurement 
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Typical applications of the JME method include measurement of EDFA’s, cou-
plers, isolators, fibers, and optical connectors. Cables and systems consisting 
of any number of amplifiers and fiber spans can also be tested. Consider the 
following aspects of the JME method when deciding which PMD measurement 
method to use: 

• Differential group delay (DGD) is measured as a function of wavelength. 

• Measurement of low PMD components can be accomplished with a narrow 
wavelength range. 

• The measurement is independent of pigtail position and polarization launch 
condition. 

• Optical fiber DGD data can be shown in a histogram and compared with the ex-
pected distribution to assess the statistical confidence of the measurement. 

To make a PMD:JME measurement

The following measurement procedure illustrates the simplest and most 
straightforward path in using the Agilent 8509C lightwave polarization ana-
lyzer to make a PMD:JME measurement. Other specialized measurement 
applications and techniques are included later in this section. 

Measurement setup

1 Connect your measurement system as shown in Figure 4-3. Install the thru 
cable for the one-time adjustment of external source polarization.

Enhancing Accuracy 

The fiber cable leading from the external source to the Agilent 8509C EXTERNAL 
SOURCE INPUT must be taped down to prevent any movement after source polarization 
has been adjusted. Movement of this source cable may jeopardize PMD measurement 
accuracy. 
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Figure 4-3. Measurement setup 

External source preparation 

Before performing the PMD:JME measurement, external source polarization 
must be adjusted via the two knobs on the front panel of the Agilent 8509C. 
The following procedure will guide you through the process.

2 To set up the optical source, select System from the main menu, and then select 
Optical Source. You may also set up the optical source by selecting the λ button 
in the upper-right hand corner of the main window. 

Additional Information 

The Agilent 8509C uses an internal three-state, switchable polarizer to condition the 
light before it is applied to the device under test. Adjustment of external source polariza-
tion via the front panel knobs is done to provide a roughly circular state of polarization 
within the polarizer assembly, so that all three polarizers will pass high levels of optical 
power. This adjustment typically need not be repeated unless the front panel knobs or 
the fiber connecting the tunable optical source and the Agilent 8509C have moved. How-
ever, it is recommended that the adjustment be performed once a week or once at the 
beginning of a long series of tests. 
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Figure 4-4. System menu 

3 Select the external tunable laser source and set the wavelength to the 
approximate center of the widest range you expect to use in your JME PMD 
measurements. Use the default power level or set as desired. If the screen on 
your instrument controller looks similar to Figure 4-5, select Done. 

 

Figure 4-5. Optical Source Setup window

4 Select System from the main menu, and then select Polarizers. 
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Figure 4-6. Polarizer selection menu

5 Set the polarizers to Internal and select No Polarizer. If the screen on your 
instrument controller looks like Figure 4-7, select Done. 

 

Figure 4-7. Polarizer setup window

6 Select 3pt Ref from the Markers Area on the Main Screen, wait 5 seconds, and 
then select Apply 3pt. 
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Figure 4-8. 3pt reference applied window

7 Adjust the External Source Polarization knobs on the front panel of the 
Agilent 8509C until the active point on the Poincare sphere approaches a pole, 
and the absolute value of the s3 marker is greater than 0.90. The active point is 
easier to see by marking the current point (select Display and then Mark Current 
Point). Also notice that the polarization ellipse will become more circular as s3 
approaches 0.90. Un-apply the 3pt reference (reselect Apply 3pt) before going 
on to do the JME PMD measurements. Do not move the cable or the external 
source polarization knobs.

Additional Information 

Creating and applying a 3pt reference frame allows measurement of polarization state 
within a physical frame of reference. In this case, the reference frame is located inside 
the internal polarizer assembly. 
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Figure 4-9. Circular polarization display

Making the measurement 

At this point your measurement system is ready to make your first measure-
ment. For our purposes we are going to measure a 10 kilometer spool of opti-
cal fiber. 

8 Remove the fiber cable connecting the optical output to the optical input on the 
Agilent 8509C. 

9 Connect your test device between the optical output and the optical input.
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C A U T I O N Observe proper connection techniques. Refer to “Cleaning Connections for 
Accurate Measurements” on page 7-14. 

10 Select Measurement from the main menu, and then select PMD:Jones Matrix 
Eigenanalysis... F2. 

 

Figure 4-10. JME measurement selection menu

11 Verify that the source and start and stop wavelengths are correct for your 
measurement, and that the optical power is turned on. If the screen on your 
instrument controller looks like Figure 4-11, select Find Minimum # of Points.

Enhancing Accuracy 

The fiber path leading from the optical output of the Agilent 8509C to the DUT and from 
the DUT to the optical input of the Agilent 8509C must not move during the measure-
ment process. Unsupported fiber, particularly unjacketed fiber, should be taped down or 
placed against stationary objects. Movement of the fiber may jeopardize PMD measure-
ment accuracy. 
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Figure 4-11. JME Source Setup window

12 The window is called Find Minimum # of Points. Sample measurements will be 
performed to identify the maximum DGD of the DUT. The number of points will 
be set to accommodate this value. Sample measurements are evenly spaced 
across the wavelength range. For this measurement, use the default setting by 
selecting OK.

Additional Information 

The Jones matrix eigenanalysis method computes differential group delay (DGD) from 
pairs of optical measurements, so the number of DGD values obtained in a completed 
measurement is actually one less than the number of measurement wavelength points. 

If you wish the source to remain leveled during the measurement, enter into the power 
level display of the optical source setup window, a value no greater than the minimum 
power shown in the lasers display of available laser power. 
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Figure 4-12. Segment selection window

13 When the automatic routine is finished, you will be advised what minimum 
number of measurement points is required for your wavelength range. The 
minimum number of points is automatically entered in the optical source setup 
window when this message box is closed. Select OK to continue with the 
measurement.

For More Information 

More information on selecting the appropriate number of points may be found in the 
"Concepts" section later on in this chapter (Choosing Delta Wavelength and Fiber PMD 
Statistics/Enlarging the Sample Size). 
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Figure 4-13. Find Minimum # of Points window

14 Select Done in the Optical Source Setup window. 

 

Figure 4-14. Optical Source Setup for PMD: JME window

15 Select Start Measurement from the Agilent 8509C Graphs screen. 

Enhancing Accuracy 

When measuring components, polarization maintaining fiber, or short lengths of single 
mode fiber, use the indicated minimum number of points. When measuring long fiber, or 
any device that is expected to exhibit wavelength dependent PMD, increase the number 
of points to measure the wavelength dependent behavior of the device. 
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Figure 4-15. PMD: JME measurement start window

The JME graph is derived from a series of optical measurements performed 
across the selected wavelength range. As the measurement progresses, the 
Measurement Summary display bar directly below the graph lists the PMD 
results obtained, up to the current wavelength. The axes of the PMD graph are 
annotated as differential group delay in picoseconds and wavelength in 
nanometers. 
 

Figure 4-16. Measurement results window
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Your measurement is complete. The screen on your instrument controller 
should look similar to Figure 4-16. 

To manipulate the measurement results 

When your measurement is complete, you may; 

• review the results in the Measurement Summary bar. 

• review the measurement setup conditions in the Measurement Annotation ar-
ea. 

• examine the differential group delay at a particular wavelength, by using the 
cursor bar. 

• display, edit, and print the data in tabular form. 

• print the graph with or without measurement annotation and data listing. 

• save your measurement and annotation information to a database for future 
use, or to reload the measurement back into the Agilent 8509C. 

• save your measurement data as a text file for use with spreadsheets. 

• perform other PMD measurements without leaving the Graphs window. 

• display all of your measurements in one window, using windows tile or cascade 
modes. 

The Measurement summary bar
 

Figure 4-17. The Measurement summary bar window

The Measurement Summary Bar displays the PMD results obtained up to the 
current wavelength. 
4-17



Using the Measurement Menu
Making PMD Measurements

book.book  Page 18  Thursday, March 29, 2001  12:14 PM
All of the displays have the same units, which are user selectable but default 
to picoseconds. The bar displays the average, current, maximum, minimum, 
and standard deviation (σ) of the differential group delay, up to the current 
wavelength. 

The Measurement annotation area 
 

Figure 4-18. The Measurement annotation area window

When the measurement ends, the control panel at the bottom of the Graphs 
window is replaced by Measurement Annotation. This area lists the date and 
time of the start of the measurement, the fiber length in kilometers, the tun-
able laser power and attenuator settings, the start and stop wavelengths and 
the wavelength interval or delta. It also lists the number of points, that is, the 
number of wavelengths at which optical measurements were taken. The mea-
surement annotation area can be toggled on and off by selecting Display from 
the main window menu, and then Annotation.

Additional Information 

The Jones matrix eigenanalysis method computes differential group delay (DGD) from 
adjacent pairs of optical measurements, so the number of DGD values obtained in a 
completed measurement is actually one less than the number of measurement wave-
lengths. 
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The Cursor Bar window
 

Figure 4-19. The Cursor bar window

Maximize the PMD:JME window within the Agilent 8509C graphs window. 
Activate the Cursor Bar by selecting Display and then Cursor from the Graphs 
window menu. The cursor bar appears between the Measurement Summary 
Bar and the Measurement Annotation area. The cursor display shows the DGD 
value for a selected wavelength. The wavelength is selected by the slider con-
trol, arrow keys (the keyboard is activated by pressing Alt and then the arrow 
keys), or by editing the wavelength display. 

To change the measurement format 

 

Figure 4-20. Graphs Format menu

1 Select Format from the Main Graphs window menu to access the measurement 
formatting functions. The measurement graph may be formatted in either 
picoseconds or femtoseconds. It can also be expressed per kilometer or per 
root kilometer of fiber length. 
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2 Choose Fiber Length... from the Format menu to enter the length of the fiber you 
have just measured.

To change the graph’s Y-scale 

 

Figure 4-21. Graphs Y-Scale menu

1 To change the vertical axis on the measurement graph, select Display and then 

Y-Scale from the Graphs main window menu. 

The submenu provides three selections:

Autoscale/Zero Based 

Autoscales the maximum Y-axis value but uses zero as the minimum value. 
This is the default selection.

Autoscale
Optimizes both the minimum and maximum Y-axis values to expand the mea-
surement curve to fill the graph area. 

Fixed Scale... 
Allows specification of the maximum Y-axis value and uses zero as the mini-
mum value. 

Additional Information 

If the fiber is long enough to exhibit strong polarization mode coupling, you may wish to 
express the result in units of time per root length using Format, Delay/sqrt(L). The new 
units are listed, and all values are updated, on the Y-axis and in the measurement sum-
mary bar. 
4-20



Using the Measurement Menu
Making PMD Measurements

book.book  Page 21  Thursday, March 29, 2001  12:14 PM
To display data in tabular format 

 

Figure 4-22. Graphs Tabular Data menu

1 Display the tabular measurement data by selecting Display and then Tabular Data 
from the Graphs main window menu. A text box fills the Graphs window, 
overlaying the measurement graph. The text box lists information from the 
measurement annotation area, the values in the measurement summary, and a 
list of wavelengths at which optical measurements were performed along with 
the DGD values derived from each pair. The Start Measurement button is disabled 
when the text box is open.

To print data in tabular format

All or a portion of the text box information may be printed. Printing uses the 
default printer selected in the Windows control panel.

1 To print all of the text box information just press the Print tabular data button at 
the top of the text box. To print a portion of the text box information, highlight 
the desired text with the mouse before pressing the Print tabular data button. 

Additional Information 

You can add your own notes to the text. All of the standard keyboard and mouse editing 
features are available. Use the mouse to place a text insertion point anywhere in the 
document, and then type the desired text. Text may be selected using the drag features 
of the mouse. Selected text may be deleted or copied to the clipboard for use in a report 
or a spreadsheet by pushing the Copy to clipboard button. The tabular data text box is 
limited to 60,000 characters. 
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2 To return to the graphic display, press the Return to graph button or re-select 
Tabular Data under the Display menu. 

To display data in a statistical format 

Data from PMD:JME measurements can be displayed in statistical format 
using the PMD Statistics feature. See “Fiber PMD statistics” on page 4-35 in 
for a discussion of its application. 

 

Figure 4-23. Graphs PMD Statistics menu

1 After making your PMD:JME measurement, and while still in the PMD:JME 
measurement window, you may display the results in a statistical format by first 
selecting Display and then PMD Statistics. A PMD Statistics window will open. 
4-22



Using the Measurement Menu
Making PMD Measurements

book.book  Page 23  Thursday, March 29, 2001  12:14 PM
 

Figure 4-24. Displaying data in a statistical format window

Figure 4-24 is an example of the PMD statistics window. A Maxwell curve is 
automatically fitted to the histogram. 

2 Single or multiple PMD:JME measurements can be displayed in the PMD 
Statistics window. Use any combination of Add from Selected JME Window F2, Add 
from Database...F3, and Add from Text File...F4 to import data.

Additional Information 

The PMD Statistics function can be selected in two ways; from the PMD:JME measure-
ment window, or by double clicking on the PMD Statistics icon in the Agilent 8509C Pro-
gram Group in the Program Manager. The PMD Statistics function is actually provided by 
a separate software application. 
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Figure 4-25. PMD Statistics File menu 

The File menu Selecting File from the main PMD Statistics window, will drop down a menu 
structure. The following is a brief description of the elements of the File menu. 

Add from Selected JME Window F2 

The data from the current JME window will be shown in the Differential 
Group Delay versus the Wavelength graph. The individual measurement 
points of this graph are used to build the Cumulative Differential Group Delay 
Histogram and to derive the other statistics listed in the PMD Statistics win-
dow. 

Add from Database...F3 

Selecting this menu item will open the PMD Statistics Database Interface win-
dow. You can then load the measurement results from a previously stored 
measurement into the PMD Statistics window. 

Add from Text File...F4 

Selecting this menu item will open the "Load: Text File" window. You can then 
impose a previously stored text file to import into the PMD Statistics window. 

Load Statistics...F5 

Selecting this menu item clears the PMD Statistics displays and opens the 
"Load: Text File" window. You can then load previously stored PMD statistics 
data into the PMD Statistics window. 
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Save Statistics...F6 

Selecting this menu item opens the "Save: Text File" window. You can then 
save the current statistical data in a text file for future retrieval to the PMD 
Statistics window or analysis with a spreadsheet. All measurement points are 
saved, including points beyond the displayed wavelength range. 

Print Bitmap 

Selecting this menu, will give you three choices: print the DGD versus Wave-
length graph, the Histogram or the entire window. 

Print Data 

Selecting this menu will print the data, using the default printer selected in 
the windows control panel. 

Exit 

Selecting this menu will quit the PMD Statistics window. 

The Edit menu Selecting Edit from the main PMD Statistics window, will drop down a menu 
structure. The following is a brief description of the elements of that Edit 
menu. 

Note: The Edit Menu allows you to print the screen in bitmap format, but will 
not print the data.

Undo Last Add Alt+Bksp 

Selecting this menu item removes the most recently added measurement from 
the statistics displays and from the statistical data set. This allows you to 
examine the DGD versus Wavelength data before committing it to the statisti-
cal data set. 

Clear All Data 

Selecting this menu item removes all displayed data and purges the statistical 
data set. 

Copy Bitmap to Clipboard 

This menu item provides three selections: copying to the clipboard your 
choice of DGD versus Wavelength, the Histogram or the entire PMD Statistics 
window. 

The Format menu Selecting Format from the main PMD Statistics window, will drop down a menu 
structure. The following is a brief description of the elements of that Format 
menu. 
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Wavelength Range

This menu item provides two ways to select the wavelength range to be used 
in the DGD vs Wavelength graph. Only data points displayed in this graph are 
included in the histogram. Autorange adjusts the wavelength limits to include 
the lowest and highest wavelengths of the added or loaded JME PMD data. 
The Fixed Range... selection opens a dialog box with which you can set the mini-
mum and maximum displayed wavelengths. 

Histogram X-Axis

This menu item provides two ways to select the range of DGD values to be dis-
played in the histogram. When Autoscale is selected, the X-axis range automat-
ically adjusts to include all DGD values in the statistical data set. When Fixed 
Scale... is selected, a dialog box enables you to set the maximum value of DGD 
to be displayed. The minimum value is always zero. 

The Help menu The Help menu only provides information about the software revision of the 
PMD Statistics software, which is a separate application. 

The annotation 

area 

At the bottom of the PMD Statistics window are a group of numeric displays, 
which are described below. 

Mean

This display shows the mean, or average, value of the data points which are 
displayed in the DGD vs Wavelength graph. The mean is not affected by selec-
tion of the X-axis scale of the histogram. 

Minimum, Maximum

These displays show the minimum and maximum values of DGD of the data 
points which are displayed in the DGD vs Wavelength graph. These values are 
not affected by selection of the X-axis scale of the histogram. 

Last file added

This display shows the number of DGD measurement data points which were 
added with the last add operation. The number indicates the size of the origi-
nal measurement data set, and is not affected by the choice of X-axis limits of 
either of the graphical displays. 

Total size

This display shows the cumulative size of the statistical data set when the 
DGD versus Wavelength graph is in the Wavelength Range/Auto Range mode. 
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Subset size

This display replaces the Total size display when the DGD versus Wavelength 
graph is placed in the Fixed Range mode. This parameter indicates the num-
ber of DGD measurement data points that fall within the displayed wavelength 
range. 

Number of bins

This is an editable display which shows the number of categories or buckets 
into which the DGD range is divided for construction of the DGD Histogram. 

Maxwell alpha parameter

This display shows the value of the single parameter which specifies the Max-
well curve that is automatically fitted to the DGD histogram. 

To print the PMD:JME graph

 

Figure 4-26. Printing the PMD:JME graph menu

1 Select File and then Print from the Graphs main window. 

Graph

Prints only the graph. 

Graph & Annotation

Prints the graph and the annotation information discussed in "The Measure-
ment Annotation Area." 

Graph, Annotation, & Data

Prints the graph, annotation information and list the measurement wave-
lengths and the corresponding data points. 
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To save your measurement as text

 

Figure 4-27. Save as Text menu

1 Select File and then Save JME as Text from the Graphs main window. A standard 
window Save screen will be displayed. 

2 At this point you can select a file name and a directory in which the data will be 
stored. Columns of wavelengths and measurement data points will be saved as 
text for later use in a spreadsheet. Data saved as text cannot be recalled for 
future display by the analyzer. 

To save in database format

 

Figure 4-28. Saving in database format menu

1 Select File and then Save JME to Database... from the Graphs main window to save 
the entire measurement and annotation for future analysis using a database 
program or to reload the measurement and certain setup parameters back into 
the analyzer. A default title for the measurement is provided. The title is made 
up of the measurement type and the date and time. It is a unique name, but you 
may wish to edit it for your own purposes. You may also enter a serial number 
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and date code for the device under test. 

Specialized measurement methods 

To perform a cascade measurement 

Cascading is a measurement procedure that mathematically increases the 
accuracy of polarization mode dispersion (PMD) measurements of devices 
and components that can’t be directly connected to the Agilent 8509C OPTICAL 
OUTPUT without using additional optical interfacing. PMD cascading tech-
niques are used in bulk optical applications to separate the PMD response of 
the test device from the cloaking effects of the combined PMD response of the 
fixtures and adapters between the Agilent 8509C OPTICAL OUTPUT and the input 
to the test device. Fiber optical applications benefit as well because the 
response of optical source interfacing isolators, connectors and cables of the 
test system (represented by DCO in Figure 4-29) can be mathematically 
removed from the total PMD response, leaving behind the response of the tar-
geted test device (DUT in Figure 4-29). This technique is most effective when 
the PMD response of the test device (DUT) and the undesired PMD of the 
optical source interfacing (DCO) are approximately the same and individually 
greater than 100 fs. 

 

Figure 4-29. Targeted test device
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Setting up the system 

1 Attach the device to be calibrated out (DCO), between the OPTICAL OUTPUT and 
the OPTICAL INPUT of the Agilent 8509C, as outlined in Figure 4-30. Tape down 
the pigtails so that only the final portion of the output pigtail of the DCO will be 
allowed to move when the final test device (DUT) is inserted. Movement of the 
DCO, or movement of its input pigtail, between the calibration and 
measurement, causes measurement error. 

 

Figure 4-30. Measurement setup 

Making the measurement 

2 Prepare the external source to provide a circular state of polarization by 
following the procedure described in “External source preparation” on 
page 4-7. 

3 Select Measurement from the main window menu selections, and then PMD: Jones 
Matrix Eigenanalysis... F2. 

4 Set up the optical source for the desired wavelength range and the number of 
points, then select Done. 

5 Select Measurement from the graphs main window menu selections, and then 

Cascaded Device. 
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Figure 4-31. Measurement start window

6 Note that the measurement control area at the bottom of the graphs window, a 
yellow Cascade banner appears. Select Start Calibration or New Thru Cal, whichever 
appears at the bottom right portion of the graph window. 

 

Figure 4-32. Thru calibration window

7 The resulting measurement characterizes PMD effects of the DCO. When the 
thru calibration is complete, select Continue. The calibration may be redone by 
selecting New Thru Cal. Perform this only if the fiber or the DCO has moved 
during the calibration. 

8 Remove the output pigtail of the DCO from the optical input of the 
Agilent 8509C, taking care to move only the output pigtail and not the DCO or 
its input pigtail. Connect the device to be measured (DUT) between the output 
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pigtail of the DCO and the OPTICAL INPUT of the polarization analyzer.

 

Figure 4-33. Connecting the device

9 Select Start Measurement. When the measurement is complete, the PMD effects 
of the first DCO are removed and the displayed DGD represents the newly 
inserted device. Refer to Figure 4-34. 

 

Figure 4-34. The results 
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C A U T I O N In general, the PMD values of cascaded devices do not simply add. Single 
Device measurements of two devices cannot be added to produce the expected 
DGD of the same devices in cascade. 

To use a voltage-tuned source 

The JME PMD measurement may be performed using a voltage-tuned optical 
source. Operation is automatic once the measurement is started. 

1 To perform a measurement with a voltage-tuned source, open a JME PMD 
window and select Optical Source Setup. 

2 Use the Optical Source Selection to choose the voltage-tuned mode. You will 
see a change in the information displayed in the Wavelength area of the 
window. 

3 Enter the wavelength parameters and number of points as you would for an 
HPIB source. 

4 Enter the tuning voltages corresponding to the start and stop wavelengths. 
This "calibrates" your wavelength tuning and requires knowledge of the source 
tuning characteristic. The tuning voltage is programmed in linear fashion 
between the entered limits. 

5 Set the settling times as required for your source, or use the default values. 

6 Connect the tuning voltage from BNC connector "A" on the rear panel of the 
Agilent 8509C to the voltage-tuned laser. 

7 Close the Optical Source Setup window and start the measurement. 

Additional Information 

The effectiveness of this method can be verified in two ways. 

1. Perform a cascade thru calibration on a device and then measure the same device 
without moving any fibers. The result should be a very small value of DGD, typically 
under 0.010ps, indicating that the device itself has been removed from the measurement 
path. The device must be stable in temperature for this verification to be meaningful. 

2. Measure the DGD of a device (DUT) in the Single Device mode (without a cascade thru 
calibration). Then perform a cascaded PMD measurement using this same device (DUT) 
connected to a second device (DOC) that has been cascaded out. The PMD measurement 
result should be very close to the measurement obtained in the Single Device mode. 
Again, temperature stability is important.
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To use a manually-tuned source 

The JME PMD measurement may be performed using a manually-tuned opti-
cal source. This feature enables you to use tunable single line laser sources 
that lack hardware tuning interfaces. 

1 To perform a measurement with a manual source, open a JME PMD window 
and select Optical Source Setup. 

2 Use the Optical Source Selection to choose the manually tuned mode. The 
settling time parameters are no longer relevant and are grayed out. 

3 Enter the wavelength parameters and number of points as you would for an 
HPIB source. 

4 Close the Optical Source Setup window and start the measurement. 

The instruction window will prompt you to adjust the wavelength of the 
source and take the next point. Repeat this until the measurement is com-
plete. 

PMD:JME concepts 

Polarization mode dispersion 

Polarization 

modes 

PMD is a fundamental property of optical fiber and components by which any 
lightwave signal is split into two polarization modes that travel at different 
speeds. In effect, single mode fiber is bimodal with respect to polarization. The 
difference in propagation time between the two polarization modes is called 
differential group delay. 

General effects Because of PMD, lightwave pulses launched partly into each of the polariza-
tion modes broaden as they propagate, degrading the distinction between 
pulses. In addition, light from a spectrally wide source may become partly 
depolarized under the influence of large values of differential group delay. 
Finally, transmitter laser frequency chirp in combination with PMD in a trans-
mission path can cause a transmitted signal to vary in polarization state as a 
function of time and signal intensity. If polarization-dependent loss is present 
in the system, the polarization variation is converted to amplitude variation. 
This effect causes composite second-order distortion in cable-television sys-
tems. 
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Mode coupling Mode-coupling is the term given to the coupling of optical energy between 
polarization modes along the transmission path. Two-port optical devices 
(including optical fiber) fall into two categories according to the degree of 
mode coupling. Non-mode-coupled devices include most components, hi-bi 
(polarization maintaining) fiber and short lengths of ordinary single-mode 
fiber. For these devices, energy launched into each polarization mode remains 
in that mode as it propagates. The differential group delay of non-mode-cou-
pled devices is generally independent of wavelength. The other extreme, 
strong mode coupling, is exhibited by long lengths of single-mode fiber. For 
long fibers, energy couples between modes due to physical variations internal 
to the fiber and optical effects induced by the fiber’s environment. The differ-
ential group delay of highly mode-coupled devices is a strong function of 
wavelength. An intermediate degree of mode coupling, typical of short to 
medium lengths of optical fiber, results in differential group delay which is a 
relatively weak function of wavelength. 

PMD units Differential group delay is expressed in units of time, generally either picosec-
onds (1 ps = 10–12 s) or femtoseconds (1 fs = 10–15 s). Short-fiber PMD may be 
expressed in terms of time per meter or kilometer. Due to the effects of mode-
coupling, long-fiber differential group delay increases as the square root of 
fiber length. Therefore, long-fiber differential group delay is often expressed 
in terms of time per square root of fiber length (in kilometers). 

Fiber PMD statistics 
The "PMD" of a component or fiber is simply the average differential group 
delay. For non-mode-coupled devices, this may be obtained from a single pair 
of Jones matrix measurements separated by a known wavelength interval, 
although in practice an average of several intervals is used. For highly mode-
coupled devices, the measurement is repeated at a many wavelength intervals 
across a large wavelength range. The average differential group delay is simply 
the average of these individual values. 

Fitting the 

Maxwell curve to 

the distribution 

To determine whether the wavelength dependence of a fiber has been suffi-
ciently sampled in a particular measurement, a histogram of the individual dif-
ferential group delay values may be compared to a best-fit Maxwell probability 
distribution function. The Maxwell curve represents the expected shape for 
long fibers. If the data closely resembles the Maxwell curve, the average differ-
ential group delay taken from the measurement can be considered statistically 
accurate. 
4-35



Using the Measurement Menu
Making PMD Measurements

book.book  Page 36  Thursday, March 29, 2001  12:14 PM
The Agilent 8509C software provides a statistical display of Jones matrix 
eigenanalysis measurement results for this purpose. It uses the chi-squared 
method to generate the best-fit Maxwell curve. 

Once the Maxwell curve fit has been performed, the quality of the fit to the 
data must be determined. This may be done qualitatively, by visually assessing 
the fit, or by use of the quality of fit parameter displayed in the statistics win-
dow. 

Enlarging the 

sample size 

If the quality of fit is poor, more data is required to fully represent the fiber. 
This is most easily accomplished by expanding the wavelength range of the 
measurement. Generally, long-fiber PMD measurements should be taken over 
as wide a wavelength range as possible, with wavelength interval small enough 
to capture the features of the curve of differential group delay versus wave-
length. However, for some fibers even the full wavelength range may not be 
sufficient to produce a distribution of Maxwellian shape. In such cases, the 
sample size can be increased by repeating the measurement at different tem-
peratures, based on the fact that the mode-coupling characteristics of the 
fiber are strong functions of temperature. All of the resulting data is combined 
in a single histogram for analysis. If the fiber temperature is changing natu-
rally, due to changes in the ambient temperature, the measurement may be 
repeated versus time to enlarge the sample size. If the fiber is in cable form, 
temperature change may be induced by passing a current through the metal 
members of the cable. The sample size for spooled fiber can also be enlarged 
by rearranging the turns of fiber on the spool. For example, a spool of loosely 
coiled fiber can be turned end over end between measurements. 

Source spectral characteristics 
The Jones matrix eigenanalysis method of PMD measurement involves mea-
suring the output state of polarization of the device under test with various 
linear polarizers inserted in the path between optical source and the device. 
This requires that the output of the test device always be at least partially 
polarized. The output will depolarize if the coherence time of the source 
approaches the differential group delay of the test device. Single-line lasers of 
narrow spectral width, such as the Agilent 8168A Tunable Laser Source, are 
recommended for the Jones matrix eigenanalysis PMD measurement method. 

Should I use the reference frame? 
The reference frame feature removes birefringence (2-point method) or bire-
fringence and polarization dependent loss (3-point method) from the test path 
between the automatic polarizer and the polarization receiver. The reference 
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frame is appropriate only to the wavelength at which it is set up. Since PMD 
measurements are preformed across a wavelength range, the reference frame 
feature should not be used. 

Cascade measurements 

What is a cascade 

measurement? 

A cascade measurement measures the DGD of a single test device while that 
test device is connected in series with other elements that demonstrate DGD. 
The measurement is a two step process involving PMD:JME measurements of 
a through path with and without the test device installed. This allows the 
Agilent 8509C to mathematically remove the differential group delay of the 
path between the polarizer and the test device. 

Typical 

applications 

The cascade method is not used in ordinary PMD measurements in which the 
device under test is connected by pigtails to the front panel of the instrument, 
as it is not capable of removing the very small amount of differential group 
delay of the pigtails. However, it may be used in cases where an optical device 
with significant PMD, such as an isolator, is placed between the instrument 
and the input of the device under test. 

The cascade measurement may also be used to test individual sections of a 
telecommunications system model or test bed. Such systems consist of many 
sections, each of which is made up of one or more amplifier/fiber pairs. Such 
systems may provide measurement taps between sections. The PMD of indi-
vidual sections may be measured using these taps, without disturbing the 
through path connections. The output pigtail of the polarization analyzer is 
connected to the input of the system and left there throughout the measure-
ment. A cascade reference measurement is taken with the optical input of the 
polarization analyzer connected to the tap just prior to the section of interest. 
Then the section of interest is added and the second step of the measurement 
is performed. The resulting measurement characterizes only the selected sec-
tion. If the goal of the PMD measurement is to relate the PMD of individual 
sections to the PMD of the whole system, the cascade measurement may be 
repeated on each of the sections to characterize the sections. At each stage, 
the composite PMD of all preceding sections is given by the cascade reference 
measurement. With individual and composite PMD values, one may compare 
the addition of PMD with the expected root-sum-of-squares expected value. 
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Using the wavelength-scanning method

Polarization mode dispersion (PMD) is a fundamental physical property of 
optical fiber and components in which a lightwave is split into two waves of 
slightly different speed on the basis of polarization state. The two polarization 
modes experience a difference in propagation time known as "differential 
group delay" (DGD). The DGD of long optical fibers varies with wavelength. 
The "PMD" of a test device also refers to the average value of the differential 
group delay. PMD is fundamentally expressed in units of time, typically pico-
seconds (1 ps = 10–12 s), although in the case of long fibers it may be normal-
ized to the square root of fiber length with the units of picoseconds per root 
kilometer. 

This section explains how to measure the PMD of a test device using the wave-
length-scanning (WS) method. A typical measurement result is shown in 
Figure 4-35. 
 

Figure 4-35. Example of data display for a wavelength-scanning PMD measurement 

Typical applications of the wavelength-scanning method include measurement 
of medium to long optical fibers and cables. It can also be applied to the mea-
surement of some components, and may be used to characterize amplified 
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systems in which the level of PMD is large enough to produce a usable number 
of peaks and valleys in the response within the system passband. Consider the 
following aspects of the wavelength-scanning method when deciding which 
PMD measurement method to use: 

• Measurement speed is slightly faster than the JME method. 

• The method can be performed with the Agilent 8509C. 

• The method provides more optical power to the DUT than the JME method 
does. 

• A single PMD value, or average differential group delay, is produced from mea-
surement across a wavelength span. 

• Broad wavelength ranges are required for measurement of low PMD values. 

• The measurement is influenced by pigtail position and polarization launch con-
dition, particularly for low values of PMD. 

To make a PMD:WS measurement

The following measurement procedure illustrates the simplest and most 
straightforward path in using the Agilent 8509C lightwave polarization ana-
lyzer operating system software to make a wavelength-scanning PMD mea-
surement. 

Measurement setup

1 Connect your measurement system as shown in Figure 4-36. 

 

Figure 4-36. Wavelength-scanning system setup 
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External source preparation

If the source signal is applied to the EXTERNAL SOURCE INPUT of the 
Agilent 8509C, external source polarization should be adjusted for circular 
polarization as described in “External source preparation” on page 4-7. 

Connecting the tunable laser directly to the DUT extends the amplitude range 
of the measurement to allow measurement of higher loss devices. If the source 
is not polarized, an external polarizer must be used. 

Making the measurement 

At this point your measurement system is ready to make your first measure-
ment. For our purposes we are going to measure a ten kilometer length of 
fiber. 

2 Connect your test device between the OPTICAL OUTPUT of the laser source and 
the OPTICAL INPUT of the analyzer.

C A U T I O N Observe proper connection techniques. Refer to “Cleaning Connections for 
Accurate Measurements” on page 7-14. 

3 Select Measurement from the main menu, and then select PMD:Wavelength 
Scanning... Shift+F2. 

 

Figure 4-37. Wavelength-scanning measurement menu

Enhancing Accuracy 

The fiber path leading from the tunable laser source to the DUT and from the DUT to the 
Agilent 8509C optical input must not move during the measurement process. Unsup-
ported fiber, particularly unjacketed fiber, should be taped down or placed against sta-
tionary objects. Movement of the fiber may jeopardize PMD measurement accuracy. 
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4 Verify that the source and wavelength are correct for your measurement, and 
that the power is on. If the screen on your instrument controller looks like 
Figure 4-38, select Done.

 

Figure 4-38. Optical source setup for PMD:wavelength scanning window

Additional Information 

A broader measurement wavelength range produces a more accurate measurement. 

If you wish to maintain leveled power during the measurement, enter into the power 
level display of the optical source setup window, a value no greater than the minimum 
power shown in the lasers display of available laser power. 

Single-mode fiber lengths in the range of 10 km or low PMD fibers, generally, may be 
adequately measured by using a wavelength delta of 1 nm. 

Single-mode fibers that are much longer than 10 km or have high PMD fibers, are best 
measured with wavelength deltas of 0.25 nm.
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5 Select Start Measurement from the Agilent 8509C Graphs screen. 

The WS graphs are derived from a series of optical measurements performed 
across the selected wavelength range. As the measurement progresses, the 
Measurement Summary display bar directly below the graph lists the PMD 
results obtained, up to the current wavelength.

 

Figure 4-39. PMD: WS measurement start window

Your measurement is complete. The screen on your instrument controller 
should look similar to Figure 4-40. 

Enhancing Accuracy 

If your wavelength range was not sufficient to provide at least two peaks in one or more 
of the measurement curves, you will get the message "One or more of the wavelength 
scanning traces has an insufficient number of peaks." If you choose OK and continue 
with the measurement, the measurement will ignore these curves and derive PMD from 
the curves which do show at least two peaks. 
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Figure 4-40. Measurement results 

The three graphs have fixed Y-axes of +1 to –1 and show the measured values 
of the normalized Stokes parameters s1, s2, and s3. 

PMD is determined from analysis of these graphs. 

To manipulate the measurement results 

When your measurement is complete, you may: 

• Select one of the measurement curves to enlarge vertically. 

• Review the results in the Measurement Summary bar. 

• Review the measurement setup conditions in the Measurement Annotation 
area. 

• Examine a curve at a particular wavelength, by using the cursor bar. 

• Display, edit, and print the data in tabular form. 

• Print the graph with or without measurement annotation and data listing. 

• Save your measurement and annotation information to a database for future 
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use or to reload the measurement back into the Agilent 8509C. 

• Perform other measurements without leaving the Graphs window. 

• Display all of your measurements in one window, using either tile or cascade 
mode. 

The Measurement summary bar 
 

Figure 4-41. Measurement summary bar window

The Measurement Summary Bar displays the PMD results obtained up to the 
current wavelength. 

All of the displays have the same units, which are user selectable but default 
to picoseconds. The bar displays the PMD derived from each of the measured 
Stokes parameters, as well as their average. 

The Measurement annotation area 
 

Figure 4-42. Measurement annotation area window
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When the measurement ends, the control panel at the bottom of the Graphs 
window is replaced by the Measurement Annotation Area. This area lists the 
date and time of the start of the measurement, the fiber length in kilometers, 
the tunable laser power and attenuator settings, the start and stop wave-
lengths and the step wavelength. It also lists the number of points, that is, the 
number of wavelengths at which optical measurements were taken. A table 
lists the number of peaks identified in each of the curves. At the right hand 
edge of the annotation area is an icon which indicates the type of analysis per-
formed on the traces and the minimum feature size. The value of the mode 
coupling factor k is also shown. These topics are discussed in detail in the 
Concepts section under the titles “Analysis mode” on page 4-52 and “Minimum 
feature size” on page 4-53. The measurement annotation area can be toggled 
on and off by selecting Display from the main window menu, and then Annota-
tion. 

The Cursor bar
 

Figure 4-43. Cursor bar window

Use the arrow button in one of the graphs to expand the graph. Activate the 
Cursor Bar by selecting Display and then Cursor Bar from the Graphs window 
menu. The cursor bar appears between the Measurement Summary Bar and 
the Measurement Annotation area. The cursor display shows the normalized 
stokes parameters for a selected wavelength. The wavelength is selected by 
the slider control, arrow keys, or by editing the wavelength display. 
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To change the measurement format 

 

Figure 4-44. Changing the measurement format menu

1 Select Format from the Graphs window menu to access the measurement 
formatting functions. For a discussion of PMD units, see the section by that title 
in “PMD:WS concepts” on page 4-51. 

Delay 

Causes the PMD values in the Measurement Summary Bar, to be displayed in 
picoseconds. 

Delay/L 

Causes the PMD values in the Measurement Summary Bar, to be displayed in 
picoseconds per kilometer of fiber length. 

Delay/sqrt(L) 

Causes the PMD values in the Measurement Summary Bar, to be displayed in 
picoseconds per root kilometer of fiber length. 

Fiber Length... 

This menu selection lets you enter the length of the fiber you have just mea-
sured. 

Avg/Median/Max Delay 

The PMD value displayed in the left most position of the Measurement Sum-
mary Bar, may be chosen as the average, median, or maximum value of PMD 
derived from the three graphs s1, s2, and s3. 
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Analysis 

This menu item allows selection of the method by which the wavelength-scan-
ning response curves are analyzed. The instrument can be set to count peaks 
or extrema (peaks plus valleys), and to use the endpoints of the wavelength 
range or the wavelengths of the first and last feature (peak or peak/valley as 
appropriate). For a detailed discussion of the Analysis modes, see the section 
with that title in “PMD:WS concepts” on page 4-51. 

Extrema/Full Scan 
Causes the Agilent 8509C to count both peaks and valleys and to use the 
endpoints of the wavelength scan in the wavelength-scanning formula.
Extrema/First to Last 
Causes the Agilent 8509C to count both peaks and valleys and to use the 
wavelengths of the first and last feature (peak or valley) in the wavelength-
scanning formula. 
Peaks/Full Scan 
Causes the Agilent 8509C to count only peaks and to use the endpoints of 
the wavelength scan in the wavelength-scanning formula. 
Peaks/First to Last 
Causes the Agilent 8509C to count only peaks and to use the wavelengths of 
the first and last (peak) in the wavelength-scanning formula. 

Minimum Feature Size.... 

The value entered here is the amplitude change, in linear units, required 
between a feature and both of its nearest neighbors in order to be recognized 
as a feature (peak or valley). For more details, see the section of the same title 
in “PMD:WS concepts” on page 4-51. 

Mode Coupling Factor (k)... 

The mode coupling factor must be set according to the type of test device. See 
the section of the same title in “PMD:WS concepts” on page 4-51.

Polarizer A, Polarizer B, Polarizer C, No Polarizer 

These selections control the use of the internal polarizer and are available only 
in the Agilent 8509C. See the section titled Polarizers in “PMD:WS concepts” 
on page 4-51. 

2 Select the appropriate units for the measurement results. If the fiber is long 
enough to exhibit strong polarization mode coupling, you may wish to express 
the result in units of time per root length (Format, Delay/sqrt(L)). The new units 
are listed, and all values are updated, on the Y-axis of the graph, and in the 
measurement summary bar. 
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To display data in tabular format 

 

Figure 4-45. Displaying data in tabular format menu

1 Display the tabular measurement data by selecting Display and then Tabular Data 
from the Graphs main window menu. A text box fills the Graphs window, 
overlaying the measurement graph. The text box lists information from the 
measurement annotation area, the values in the measurement summary, and a 
list of wavelengths at which optical measurements were performed along with 
the DGD values derived from each pair. 

To print data in tabular format

All or a portion of the text box information may be printed. Printing uses the 
default printer selected in the Windows Control Panel. 

1 To print all of the text box information just press Print tabular data on the Graphs 
window area. 

2 To print a portion of the text box information, select the desired text with the 
mouse before pressing Print tabular data. 

3 To return to the graphic display, select Return to Graph at the top of the window 
or re-select Tabular Data under the Display menu. 

Additional Information 

You can add your own notes to the text. All of the standard keyboard and mouse editing 
features are available. Use the mouse to place a text insertion point anywhere in the 
document, and then type the desired text. Text may be selected using the drag features 
of the mouse. Selected text may be deleted or copied to the clipboard by pushing the 
Copy to clipboard button. The tabular data text box is limited to 60,000 characters. 
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To print the PMD:WS graph 

 

Figure 4-46. Printing your graph menu

1 Select File and then Print PMD from the Graphs main window. 

• Selecting Graphs s1, s2, s3 will print only the graph. 

• Selecting Graph & Annotation will print the graph and the annotation informa-
tion discussed in “The Measurement annotation area” on page 4-18.

• Selecting Graph, Annotation, & Data will print the graph, annotation information 
and list the measurement wavelengths and the corresponding data points. 

To save your measurement as text 

 

Figure 4-47. Saving as text menu

1 Select File and then Save WS as Text from the Graphs main window. A standard 
window Save screen will be displayed. 
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2 At this point you can select a file name and a directory for the data to be stored. 
Columns of wavelengths and measurement data points will be saved as text for 
later use in a spreadsheet. 

The data saved as text cannot be recalled for future display by the instrument. 

To save in database format 

 

Figure 4-48. Saving in database format menu

1 Select File and then Save WS to Database... from the Graphs main window to save 
the entire measurement and annotation for future analysis using a database 
program or to reload the measurement and certain setup parameters into the 
analyzer. A default title for the measurement is provided. The title is made up 
of the measurement type and the date and time. It is a unique name, but you 
may wish to edit it for your own purposes. 
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PMD:WS concepts 

Polarization mode dispersion 

Polarization 

modes 

PMD is a fundamental property of optical fiber and components by which any 
lightwave signal is split into two polarization modes that travel at different 
speeds. In effect, single mode fiber is bimodal with respect to polarization. The 
difference in propagation time between the two polarization modes is called 
differential group delay. 

General effects Because of PMD, lightwave pulses launched partly into each of the polariza-
tion modes broaden as they propagate, degrading the distinction between 
pulses. In addition, light from a spectrally wide source may become partly 
depolarized under the influence of large values of differential group delay. 
Finally, transmitter laser frequency chirp in combination with PMD in a trans-
mission path can cause a transmitted signal to vary in polarization state as a 
function of time and signal intensity. If polarization dependent loss is present 
in the system, the polarization variation is converted to amplitude variation. 
This effect causes composite second-order distortion in cable-television sys-
tems. 

Mode coupling Mode-coupling is the term given to the coupling of optical energy between 
polarization modes along the transmission path. Two-port optical devices 
(including optical fiber) fall into two categories according to the degree of 
mode coupling. Non-mode-coupled devices include most components, hi-bi 
(polarization maintaining) fiber and short lengths of ordinary single-mode 
fiber. For these devices, energy launched into each polarization mode remains 
in that mode as it propagates. The differential group delay of non-mode-cou-
pled devices is generally independent of wavelength. The other extreme, 
strong mode coupling, is exhibited by long lengths of single mode fiber. For 
long fibers, energy couples between modes due to physical variations internal 
to the fiber and optical effects induced by the fiber’s environment. The differ-
ential group delay of highly mode-coupled devices is a strong function of 
wavelength. An intermediate degree of mode coupling, typical of short to 
medium lengths of optical fiber, results in differential group delay which is a 
relatively weak function of wavelength. 

PMD units Differential group delay is expressed in units of time, generally either picosec-
onds (1 ps = 10–12 s) or femtoseconds (1 fs = 10–15 s). Short-fiber PMD may be 
expressed in terms of time per meter or kilometer. Due to the effects of mode-
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coupling, long-fiber differential group delay increases as the square root of 
fiber length. Therefore, long-fiber differential group delay is often expressed 
in terms of time per square root of fiber length (in kilometers). 

Optimizing the setup for fiber or component test 

Wavelength tuning 

range 

The wavelength-scanning PMD measurement is based upon the detection of 
changes in output polarization as a function of wavelength. These changes are 
manifested as peaks and valleys in the normalized Stokes parameter responses 
s1, s2 and s3. Single-mode fiber measurements are more accurate if the num-
ber of peaks is large; wavelength range should be chosen to produce ten or 
more peaks. However, because the Agilent 8509C’s implementation of wave-
length-scanning method analyzes three polarization axes or components, 
accuracy is enhanced and useful measurements may be obtained from wave-
length-scanning responses having fewer peaks. 

When measuring components and polarization maintaining fiber, the wave-
length-scanning responses are sinusoidal. In such cases, a good measurement 
can be derived from a single pair of peaks or extrema, although accuracy is 
somewhat improved for larger numbers of features. 

The wavelength spacing of peaks is predictable for non-mode coupled devices 
(most components). At 1550 nm, the product of the DGD of the test device (in 
ps) and the wavelength interval between adjacent peaks (in nm) is approxi-
mately 7.4 ps nm. A device with DGD of 1.0 ps produces a peak every 7.4 nm. 

Analysis mode The analysis mode is represented at the right hand edge of the annotation 
area of the Graphs window by an icon showing a sine wave with two types of 
marks, or tics. The two bold triangular marks indicate whether the analysis is 
using the full scan or first and last feature wavelengths in the wavelength-
scanning formula. The smaller, vertical marks indicate whether the analysis is 
counting peaks or peaks and valleys. 

Depending upon the analysis mode selected, the wavelength-scanning algo-
rithm counts peaks or extrema (peaks and valleys). When the number of 
peaks occurring in the selected wavelength range is small, accuracy is 
improved by choosing one of the extrema-based analysis modes; extrema full 
scan or extrema first to last. 

When measuring single mode fiber, analysis should be applied to the full wave-
length scan. When measuring components and polarization maintaining fiber, 
cases in which the wavelength-scanning responses are sinusoidal, analysis 
should be started and ended on the first and last peak (or extrema). This 
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avoids error caused by the arbitrary relationship of the endpoints of the wave-
length scan and the first and last peaks (or extrema) of the wavelength-scan-
ning response. 

In summary, use the analysis modes as follows: 

Single-mode fiber  . . . . . . . . . . . . . . . . . . . . . . . . . peaks or extrema/full scan 
Components, PMF  . . . . . . . . . . . . . . . . . . . . . .  peaks or extrema/first to last 

Always analyze extrema if the number of peaks is small. 

Minimum feature 

size 

Once a wavelength-scanning response has been measured, it must be analyzed 
to identify and count the peaks or peaks and valleys (extrema). The "minimum 
feature size" parameter specifies the magnitude change which differentiates a 
peak from an adjacent valley. The default minimum feature size is .05, a 
dimensionless number. The value is user selectable. It may be increased in size 
in situations where fiber movement is causing the detection of false peaks and 
valleys. 

Statistical 

characterization 

of fiber PMD 

The wavelength-scanning method is less commonly used for accumulation of 
fiber PMD statistics than its counterpart, the Jones matrix eigenanalysis 
method. However, statistics may be gathered from a series of wavelength-
scanning measurements performed at different temperatures or other physi-
cal configurations of the fiber. Each wavelength-scanning measurement con-
tributes a single point to the distribution, unlike the Jones matrix 
eigenanalysis method in which each wavelength interval produces a point. 
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Making PDL Measurements

Using the Jones matrix method 

Polarization dependent loss (PDL) describes the insertion loss variation, gain 
variation or coupling variation of an optical component, given all possible 
input signal polarization states. It is found in all lightwave components to some 
degree. PDL can be desirable (in a linear polarizer) or undesirable (in a tele-
communication system or cable TV system) depending on the application. 

This measurement section explains how to measure the polarization depen-
dent loss or gain of a test device using the Jones matrix (PDL:JM) method. 
This method measures the absolute or relative PDL of a lightwave component 
and displays the results as shown in Figure 4-49. 

Function See....

PDL:JME measurements “To make a PDL:JME measurement” on page 4-55
“To save the measurement results” on page 4-63

PDL:PMM measurements “To make a PDL:PMM measurement” on page 4-65
“To save the measurement results” on page 4-69
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Figure 4-49. Example of a Jones matrix PDL measurement data display 

Typical test devices for this method include EDFAs, couplers, isolators, optical 
connectors and long fiber cables. Consider the following aspects of this 
method when deciding whether to use PDL:JM or the PDL: Power Max-Min 
method. 

• Measurements are typically completed in two to three seconds. 
• Measurement uncertainty is typically ±0.1 dB. 
• Measurement range is 3.0 dB. 
• Operation is completely automatic. 

To make a PDL:JME measurement 

The following measurement procedure illustrates the simplest and most 
straightforward path in using the Agilent 8509C lightwave polarization ana-
lyzer operating system software to make a PDL: Jones Matrix measurement. 

Measurement setup

1 Connect your measurement system as outlined in Figure 4-50. Begin by 
connecting the thru cable as shown.
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Figure 4-50. Measurement setup 

External source preparation 

Before performing the measurement, you must select an optical source. The 
following procedure will guide you through the process. 

2 Select System from the main menu, and then select Optical Source. 

Enhancing Accuracy 

The fiber cable leading from the external source to the Agilent 8509C EXTERNAL 
SOURCE INPUT must be taped down to prevent any movement after source polarization 
has been adjusted. Movement of this source cable may jeopardize measurement accu-
racy. 
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Figure 4-51. System menu 

3 Select the external laser source and set the CW wavelength for your 
measurement. Use the default power level or set as desired. If the screen on 
your instrument controller looks similar to Figure 4-52, select Done. 

 

Figure 4-52. Optical Source Setup window

4 Select System from the main menu, and then select Polarizers. 
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Figure 4-53. Polarizer selection menu

5 Set the polarizers to Internal and select No Polarizer. If the screen on your 
instrument controller looks like Figure 4-54, select Done. 

 

Figure 4-54. Polarizer setup window

6 Select 3pt Ref from the Markers Area on the Main Screen, wait 5 seconds, and 
then select Apply 3pt.
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Figure 4-55. 3pt reference applied window

7 Adjust the External Source Polarization knobs on the front panel of the 
Agilent 8509C until the active point on the Poincare sphere approaches a pole, 
and the absolute value of the s3 marker is greater than 0.90. The active point is 
easier to see by marking the current point (select Display and then Mark Current 
Point. Also notice that the polarization ellipse will become more circular as s3 
approaches 0.90. Then un-apply the 3pt reference before going on to do the 
JME PDL measurements. Do not move the cable or the external source 
polarization knobs. 

Additional Information 

Creating and applying a 3pt reference frame allows measurement of polarization state 
within a physical frame of reference. In this case, the reference frame is located inside 
the internal polarizer assembly. 
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Figure 4-56. Circular polarization display

Making the measurement 

At this point your measurement system is ready to make your first measure-
ment. For our purposes we are going to measure a optical isolator. 

8 Remove the fiber thru cable connecting the optical output to the optical input 
on the Agilent 8509C. 

9 Connect your test device between the optical output and the optical input.
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C A U T I O N Observe proper connection techniques. Refer to “Cleaning Connections for 
Accurate Measurements” on page 7-14. 

10 Select Measurement from the main menu, and then select PDL:Jones Matrix... F3.

 

Figure 4-57. Jones matrix measurement menu

11 Select Internal polarizers and Delta transmission measurement from the 
Polarization Dependence setup window. 

Enhancing Accuracy 

Accuracy is affected by the PDL of the optical connectors, the physical stability of the 
fibers during the test procedure, the DOP of the source, and the test signal power level. 
Accuracy is also degraded when the DUT depolarizes the test signal. This can occur 
when the differential group delay (between Ex and Ey), caused by the DUT, is greater 
than the coherence time (=1/(line width of the source in Hz)) of the test signal. 
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Figure 4-58. Jones matrix measurement window 

12 Connect the device you wish to measure. 

13 Press the Measure button with your mouse pointer. The results of the 
measurement will appear in the Polarization Dependence data window. 
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Figure 4-59. Measurement results 

Your measurement is complete. The screen on your instrument controller 
should look similar to Figure 4-59. 

To save the measurement results 

When your measurement is complete, you may save your results for future use 
by selecting File from the main window menu, then Save, and then Jones Matrix 
& PDL: Jones Matrix.... Also see Chapter 3, “Using the File Menu” for further 
information. 
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Using the power max-min method

Polarization dependent loss (PDL) describes the insertion loss variation, gain 
variation or coupling variation of an optical component, given all possible 
input signal polarization states. It is found in all lightwave components to some 
degree. It can be desirable (in a linear polarizer) or undesirable (in a telecom-
munication or cable TV system) depending upon the application. 

This measurement section explains how to measure the polarization depen-
dent loss, or gain, of a test device using the power max-min method 
(PDL:PMM). A data display example is shown in Figure 4-60. 

 

Figure 4-60. Example of a PDL measurement data display 
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Typical test devices for this method include linear polarizers, EDFAs, cou-
plers, isolators, optical connectors and medium to long fiber cables. Consider 
the following aspects of PMM PDL when deciding whether to use this method 
or the Jones matrix PDL method. 

• Measurements are typically completed in 10 seconds to three minutes. 

• Measurement uncertainty is typically ±0.06 dB. 

• Measurement range is 30.0 dB. 

• Operation is completely automatic, when an automatic polarization controller 
is used. 

To make a PDL:PMM measurement

The following measurement procedure illustrates the simplest and most 
straightforward path in using the Agilent 8509C lightwave polarization ana-
lyzer operating system software to make a PDL: Power Max-Min measure-
ment. 

Measurement setup

1 Connect your measurement system as shown in Figure 4-61. The 
Agilent 11896A Polarization Controller is recommended for this application.

Enhancing Accuracy 

Avoid fiber movement to eliminate errors due to bending loss. 
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Figure 4-61. Measurement setup 

External source preparation 

Before performing the measurement, you must select an optical source. The 
following procedure will guide you through the process. 

2 Select System from the main menu, and then select Optical Source. 

 

Figure 4-62. System menu 

3 Select the external laser source and set the wavelength. Use the default power 
level or set as desired. If the screen on your instrument controller looks similar 
to Figure 4-63, select Done. 
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Figure 4-63. Optical Source Setup window

Making the measurement 

At this point your measurement system is ready to make your first measure-
ment. For our purposes we are going to measure an optical isolator. 

4 Connect your test device between the polarization controller and the optical 
input.

C A U T I O N Observe proper connection techniques. Refer to “Cleaning Connections for 
Accurate Measurements” on page 7-14. 

5 Connect the device you wish to measure, then select Measurement from the main 
menu, and then select PDL:Power Max-Min... Shift+F3. 

Enhancing Accuracy 

Accuracy is affected by the PDL of the optical connectors, the physical stability of the 
fibers during the test procedure, the DOP of the source, and the test signal power level. 
Accuracy is also degraded when the DUT depolarizes the test signal. This can occur 
when the differential group delay (between Ex and Ey), caused by the DUT, is greater 
than the coherence time (=1/(line width of the source in Hz)) of the test signal. 
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Figure 4-64. PDL measurement menu 

6 Select the Reset button with your mouse pointer. 

 

Figure 4-65. PDL:Power Max-Min measurement window 

7 Vary the polarization at the input of your device under test, preferably using an 
automatic (like the Agilent 11896A polarization controller, versus a manual 
controller) polarization controller. Continue adjustment until the Poincare 
sphere has been fully explored or the value of Delta has stabilized. 
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Your measurement is complete. The screen on your instrument controller 
should look similar to Figure 4-66. 

 

Figure 4-66. Measurement results window

If an automatic polarization controller is used, the scanning speed of the polar-
ization controller and the display averaging factor of the Agilent 8509C should 
be adjusted so that the Agilent 8509C can follow the polarization state 
changes. 

For the Agilent 11896A polarization controller, automatic polarization scan 
rates of #4 to #5 are recommended, depending on the PDL of the test device. 

To save the measurement results 

Saving data capability is not available for this measurement. 
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Making Jones Matrix Measurements

A Jones matrix is a complex two-by-two matrix that is measured by the ana-
lyzer and mathematically describes the polarization transfer function of an 
optical component at a specific optical wavelength. The Jones matrix of a 
lightwave component or device can be used to predict the SOP of an optical 
output signal given a specific SOP input signal. It is also used by the analyzer 
to calculate PDL and PMD and a polarization reference frame. 

This measurement section explains how to measure the Jones matrix of a test 
device. A sample data display is shown in Figure 4-67. 

Function See....

Jones matrix measurements “To make a Jones matrix measurement” on page 4-71
“To establish the polarization reference frame” on page 4-74
“To measure the Jones matrix of a device” on page 4-74

Concepts “The relative Jones matrix” on page 4-77
“The sign of s3” on page 4-77
“Description of the Jones matrix measurement algorithm” on page 4-77
“Application of the Jones matrix” on page 4-78
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Figure 4-67. Example of data display for a Jones matrix measurement 

To make a Jones matrix measurement 

The following measurement procedure illustrates the simplest and most 
straightforward path in using the Agilent 8509C lightwave polarization ana-
lyzer operating system software to make a Jones matrix measurement. 

Measurement setup

1 Connect your measurement system as shown in Figure 4-68. The 
Agilent 11896A polarization controller is recommended as the polarization 
adjuster for this application. 

Enhancing Accuracy 

All fiber cables must be taped down to prevent any movement. Movement of cables may 
jeopardize measurement accuracy. 
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Figure 4-68. Measurement setup 

External source preparation 

Before performing the measurement, you must select an optical source. The 
following procedure will guide you through the process. 

2 Select System from the main menu, and then select Optical Source. 

 

Figure 4-69. System menu 

3 Select the external laser source and set the CW wavelength for your 
measurement. Use the default power level or set as desired. If the screen on 
your instrument controller looks similar to Figure 4-70, select Done. 
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Figure 4-70. Optical Source Setup window

4 Set the Agilent 8509C to use external polarizers. In the main window, select 
System menu and Polarizers. When the Polarizers controls appear, select External 
with the mouse and select Done. 

5 Adjust the source polarization so that approximately circularly polarized light 
is applied to the polarizers. To do this we create a temporary polarization 
reference frame. 

a Set the external reference polarizer to a starting angle, say 0 degrees, and 
select marker A on the main window. 

b Set the polarizer approximately 60 degrees from the original position and se-
lect marker B. Carefully remove the rotatable reference polarizer. 

c Select 2pt Ref and Apply 2pt with the mouse. Adjust the source assembly po-
larization adjuster until the active point on the Poincare sphere approaches 
a pole and the absolute value of the s3 marker is greater than 0.90. The ac-
tive point is easier to see by marking the current point (select Display and 
then Mark Current Point). 

6 Un-apply the 2-pt reference before proceeding. Replace the reference polarizer 
in the light beam.

Making the measurement

At this point your measurement system is ready to make your first measure-
ment. For our purposes we are going to measure a quarter-wave retarder ori-
ented 45° to horizontal. 

The measurement has two parts: 

• A polarization reference frame is established in the open beam by mathemati-
cally removing the birefringence and residual PDL of the path from the refer-
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ence polarizer to the polarization receiver inside the Agilent 8509C. 

• The test device is inserted in the open beam, Jones Matrix measurement win-
dow is opened and the device is measured at the same three reference polarizer 
angles used to create the reference frame. 

To establish the polarization reference frame 

The Jones matrix of the test device is measured and expressed within the con-
text of the angular relationship of the test device to the first, or horizontal, ref-
erence polarizer position. In some applications, it may be able to align a 
particular axis of the test device with this polarizer orientation. 

1 Place the reference polarizer in the open beam, allowing enough space 
following the polarizer to insert the test device. 

2 Rotate the polarizer to the position you wish to define as horizontal. Select 
marker A.

3 Rotate the reference polarizer by 60 degrees. Select marker B. 

4 Rotate the reference polarizer another 60 degrees, for a total of 120 degrees 
from the initial orientation. Select marker C. 

5 From the Markers area, select 3pt Ref and then Apply 3pt. 

C A U T I O N Observe proper connection techniques. Refer to “Cleaning Connections for 
Accurate Measurements” on page 7-14. 

To measure the Jones matrix of a device

6 Select Measurement from the main menu, and then select Jones Matrix... F4. 

Enhancing Accuracy 

From this point on, the fiber path and optics between the reference polarizer and the 
Agilent 8509C must not move. Movement will degrade measurement accuracy. 
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Figure 4-71. Jones matrix measurement menu 

7 Select External Polarizers and Delta Transmission Measurement. 

 

Figure 4-72. Jones matrix measurement window 

8 Insert the test device into the polarization reference frame location with the 
desired angular orientation relative to the first reference polarizer setting. 

9 Set the external polarizer angle to 0 degrees and then select Meas at 0.0 from 
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the Jones Matrix window. 

10 Set the external polarizer angle to 60 degrees and then select Meas at 60.0 from 
the Jones Matrix window. 

11 Set the external polarizer angle to 120 degrees and then select Meas at 120.0 
from the Jones Matrix window. 

 

Figure 4-73. Measurement results window

Your measurement is complete. The screen on your instrument controller 
should look similar to Figure 4-73. Notice that the Jones matrix measurement 
data can be shown in three formats: x+jy and magnitude and phase in radians 
and degrees. Polarization dependent values can be viewed by selecting Pol Dep 
values from the Jones Matrix window. 
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Concepts 

The relative Jones matrix 
The Agilent 8509C determines the Jones matrix to within a complex constant 
which relates to the absolute delay of the signal through the device under test. 
In other words, the Jones matrix only describes the differences between input 
and output light, not the time delay. 

When the Jones matrix is measured in the fashion described in the basic mea-
surement example above, the results are normalized before they are dis-
played. In general, the four elements of the matrix are normalized to the value 
in the lower right hand corner. Both amplitude and angle are normalized. 
Therefore, the lower right element may be displayed as 1 + j0 in the case of 
real and imaginary format, or 1.0 at an angle of 0.0 in the case of polar format. 
If the amplitude of the lower right element is very small and therefore vulner-
able to noise, the instrument normalizes to one of the other elements of the 
matrix. This will be apparent from inspection of the results. 

Jones matrix measurements should not be performed using the Delta, Max, 
Min mode as selected in the Jones Matrix window. This mode does not use a 
reference frame and the values of the Jones matrix returned from this mea-
surement mode are influenced by birefringence and PDL in the path between 
reference polarizer and the Agilent 8509C. 

The sign of s3 
Different reference texts use different conventions for the sign of normalized 
Stokes parameter s3. The convention used in the Agilent 8509C is shown in 
“Generating of Right-Hand Circularly Polarized Light” on page 7-9. 

Description of the Jones matrix measurement algorithm 
The Agilent 8509C automatically calculates the Jones matrix of a component 
using three different, known, linear states of polarization (typically at 0, 60 
and 120 degrees). These are created using either the internal polarizer plates 
of the Agilent 8509C or an external, rotatable, linear polarizer as shown in 
Figure 4-74. Each state of polarization individually stimulates the DUT while 
the output polarization is measured and recorded. It has been shown by R.C. 
Jones that this polarization information is sufficient for the Agilent 8509C to 
calculate a Jones matrix. The simple case where the known polarized inputs 
are 0, 45, and 90 degrees is shown in Figure 4-74. 
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Figure 4-74. Comparing the output Jones vectors to 3 known input Jones vectors 

Application of the Jones matrix 
A Jones matrix for a specific device can be used to project the output state of 
polarization given that the Jones vector of the input signal is known. For 
example, Jones matrix calculations predict that a quarter- wave retarder, ori-
ented 45 degrees to horizontal, will create a right-hand circular, polarized out-
put when excited by a horizontal-linear, polarized lightwave signal. 

 

Figure 4-75. Jones matrix application 
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Making Polarization Maintaining Fiber Launch 
Alignments

This measurement section explains how to align an input signal relative to a 
principal polarization state of a PMF cable. An Agilent 8509C Poincare sphere 
PMF alignment method is used, and 0 to 60 dB extinction ratios may be 
achieved depending on the polarization maintaining fiber. A sample data dis-
play is shown in Figure 4-76. 
 

Figure 4-76. Example of a polarization maintaining fiber alignment data display 

Function See....

PMF Launch Alignments “To make a PMF alignment” on page 4-80

Concepts “Explanation of polarization maintaining fiber launch mathematics” on page 4-84
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To make a PMF alignment

The following measurement procedure illustrates the simplest and most 
straightforward path in using the Agilent 8509C lightwave polarization ana-
lyzer operating system software to make a PM Fiber Launch measurement. 

Measurement setup

1 Connect your measurement system as shown in Figure 4-77. 

 

Figure 4-77. Measurement setup 

External source preparation 

Before performing the measurement, you must select an optical source. The 
following procedure will guide you through the process. 

2 Select System from the main menu, and then select Optical Source. 

 

Figure 4-78. System menu 
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3 Select the external laser source and set the CW wavelength for your 
measurement. Use the default power level or set as desired. If the screen on 
your instrument controller looks similar to Figure 4-79, select Done. 

 

Figure 4-79. Optical Source Setup window

Making the measurement 

At this point you are ready to make your first PMF alignment. For our pur-
poses we are going to align a short length of fiber optic cable.

C A U T I O N Observe proper connection techniques. Refer to “Cleaning Connections for 
Accurate Measurements” on page 7-14. 

4 Select Measurement from the main menu, and then select PM Fiber Launch. 

Additional Information 

The PMF alignment, or launch, method is based on the fact that if the launch into the 
PMF cable is misaligned then optical power is being sent into the orthogonal fast and 
slow axes of the PMF cable. The relative velocity or phase relationships between these 
two paths can be changed by slightly pulling or heating the fiber. This changes the 
cables output polarization and traces an arc on the Poincare sphere. The analyzer calcu-
lates the PMF cable launch extinction ratio by using a circle that you fit into an arc. The 
location of the arc and circle on the Poincare sphere are not important, since only the 
length of the radius of the circle, is used to calculate the extinction ratio of the launch. 
As the alignment is adjusted, the axis of the PMF cable will approach the linearly polar-
ized input signal. Most of the optical power will be launched into one axis of the fiber 
and the arc on the Poincare sphere will approach a center point. The ideal alignment is 
at the center point of the arc. 
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Figure 4-80. PM fiber launch measurement menu 

5 Slightly stress the PMF cable by pulling or heating it until an arc appears on the 
Poincare sphere. Be sure that the arc is on the front of the sphere, as indicated 
by a red line. If the arc is on the back side of the sphere use the Rotate function 
on the lower right side of the main window. 

 

Figure 4-81. PM fiber launch alignment window 

6 Place three points along this arc by using the mouse pointer and then clicking 
the left mouse button. 
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7 Select the Center button to center the display. 

8 Rotate the fiber chuck until the active point on the Poincare sphere approaches 
the center of the circle. 

9 Use the Poincare display Zoom and PM Fiber Launch Center functions to 
optimize the view of the arc. 

10 Slightly stress the PMF cable by pulling or heating it until an arc appears again. 

11 Select the New Circle button, place three points on the arc using the mouse 
pointer. 

12 Continue the previous steps until the value in the dB extinction ratio window 
is maximized. 

13 Select the Done button to finish this procedure. 

14 To align another PMF cable, connect it to the analyzer and repeat the previous 
procedure. 
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Concepts 

Explanation of polarization maintaining fiber launch 

mathematics 
The dB extinction ratio of the PMF launch is calculated according to the 
radius R drawn on the Poincare sphere as shown in Figure 4-82. 

 

Figure 4-82. How PMF cable launch extension ratio is calculated 
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Making Polarization Reference Frame 
Measurements

A polarization reference frame can increase the accuracy of polarization mea-
surements by isolating the test device response and minimizing the effect of 
the test system, including the optical cables used to connect the test system to 
the test device. This is valuable for measurements where the response of the 
test device would otherwise be hidden by the response of the test system, as 
illustrated in Figure 4-83, which illustrates the response of a linear polarizer 
being rotated from 0 degrees to 90 degrees. The expected response, "Cali-
brated Test," trace along the equator of the Poincare sphere is only achieved 
when the measurement is done in a polarization reference frame. The analyzer 
automatically creates a polarization reference frame using open-beam polar-
ization standards and Jones calculus. You can define the location of a polariza-
tion reference frame by following the instructions discussed in this 
measurement section. 

Function See....

Polarization reference frame 
measurements

“To make a polarization reference frame measurement” on page 4-86
“To choose the polarizers” on page 4-88
“To set the reference frame” on page 4-88
“To check the reference frame quality” on page 4-89
“To set a circular state of polarization” on page 4-89
“To use the reference frame” on page 4-89

Additional measurement applications “2pt and 3pt polarization reference frames” on page 4-90
“Measurement of the retardance of an optical device” on page 4-90
“Measurement of output polarization of an optical integrated circuit” on 
page 4-90
“Measuring polarization state at a connector surface” on page 4-91

Concepts “Explanation of polarization reference frame mathematics” on page 4-91
“Transmission ratio (3pt reference frame)” on page 4-91
4-85



Using the Measurement Menu
Making Polarization Reference Frame Measurements

book.book  Page 86  Thursday, March 29, 2001  12:14 PM
 

Figure 4-83. Example of the results that can be achieved with and without a polar-
ization reference frame 

To make a polarization reference frame measurement

The following measurement procedure illustrates the simplest and most 
straightforward path in using the Agilent 8509C lightwave polarization ana-
lyzer operating system software to create a 3pt polarization reference frame, 
using an external polarizer. 

Measurement setup

1 Connect your measurement system as shown in Figure 4-84.

Enhancing Accuracy 

The fiber leading from the second lens to the Agilent 8509C optical input must be taped 
down to prevent movement during or following the creation of the reference frame. 
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Figure 4-84. Measurement setup 

External source preparation 

Before performing the measurement, you must select an optical source. The 
following procedure will guide you through the process. 

 

Figure 4-85. System menu 

2 Select System from the main menu, and then select Optical Source. 

3 Select the external laser source and set the wavelength to the desired value. 
Use the default power level or set as desired. If the screen on your instrument 
controller looks similar to Figure 4-86, select Done. 
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Figure 4-86. Optical Source Setup window

To choose the polarizers 

To set a reference frame in an open beam environment you must select the 
external polarizers option on the analyzer. 

1 You may choose the external polarizers by first selecting System, with your 
mouse pointer, from the main window menu, and then Polarizers. 

2 When the Polarizers window appears, select External with the mouse pointer, 
then select Done. 

To set the reference frame 

The next step in this procedure is to establish a reference for the analyzer to 
use in computing the reference frame. To do this you will rotate the reference 
polarizer and then set a marker, using the Markers on the Main measurement 
window. Polarizer angles must be set precisely to the angles listed in the Polar-
izer section of the System menu. 

1 Set the external polarizer to horizontal linear polarization, and select the 
A Marker. 

2 Rotate the external polarizer 60 degrees from original position and select the 
B Marker. 

3 Rotate the external polarizer an additional 60 degrees, to a position 120° from 
the original. Select the C Marker. 

4 Select 3pt Ref with your mouse pointer.
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To check the reference frame quality 

1 To check the quality of the reference frame, select System and then Reference 
Frame Info....

2 If the quality is poor then you must repeat the previous steps, starting at “To 
choose the polarizers” on page 4-88. 

3 If the quality is good, select OK to continue, then select Apply 3pt with your 
mouse pointer from the Markers window. 

To set a circular state of polarization 

This procedure works best when the source supplies a circular SOP. With a cir-
cular SOP input signal there is no chance for a low-power (–45 dBm) refer-
ence point caused by the rotatable polarizer being placed orthogonal to a 
linear SOP input signal. 

To set a circular SOP, perform the following steps. 

1 Remove the Rotatable Reference Polarizer. 

2 Use the mouse pointer to select the Clear Trace button. 

3 Adjust the polarization adjuster until the active data point approaches a pole 
on the Poincare sphere and s3 is greater than 0.9. 

4 Reinsert the Rotatable Reference Polarizer into the test setup and repeat the 
Reference frame procedure once more. 

To use the reference frame 

At this point a polarization reference has been established. The reference 
polarizer and any part of the source assembly may be moved or replaced with-
out affecting the Polarization Reference Frame. The Agilent 8509C measures 

Additional Information 

The 3pt Ref Polarization Reference Frame (PRF) minimizes the uncertainty effects of the 
birefringence and PDL of the test system. A 2pt Ref minimizes only the uncertainty 
effects of the test system’s birefringence. 
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within the polarization reference frame. No part of the signal path after the 
reference polarizer can be moved without invalidating the Polarization Refer-
ence Frame.

C A U T I O N Observe proper laser safety; refer to “General Safety Considerations” at the 
front of this manual. Observe proper connection techniques. Refer to “Cleaning 
Connections for Accurate Measurements” on page 7-14. 

Additional measurement applications 

2pt and 3pt polarization reference frames 

The 3pt frame of reference mathematically removes birefringence and polar-
ization dependent loss from the path between the reference polarizer and the 
polarization analyzer receiver. This method requires that the reference polar-
izer be set precisely to the angles listed in the polarizers display, found by 
selecting the Polarizers from the System menu in the main window. 

The 2pt frame of reference mathematically removes only birefringence from 
the path between the reference polarizer and the polarization analyzer 
receiver. This method requires only two orientations of the polarizer. The 
angle between the two reference orientations is not critical, but an angle of 
45-60 degrees is suggested. 

Following creation and application of a reference frame, rotation of the refer-
ence polarizer should cause the point on the Poincare sphere to move along 
the equator. 

Measurement of the retardance of an optical device 

Retardance measurements make use of the polarization reference frame fea-
ture. For details, see “Making Jones Matrix Measurements” on page 4-70. 

Measurement of output polarization of an optical integrated circuit 

Measurement of the output state of polarization of an optical IC may be 
achieved by creating a polarization reference frame at the end of a fiber which 
is in turn butt-coupled to the IC. This removes the effects of birefringence and 
polarization dependent loss in the path between fiber tip and the 
Agilent 8509C. Creation of the reference frame requires a setup procedure in 
which light is coupled through a rotatable reference polarizer into the fiber 

Enhancing Accuracy 

A polarization reference frame can be used with external reference polarizers to improve 
PDL and Jones matrix measurement accuracy. The polarization reference frame, how-
ever, is ignored and has no effect on Agilent 8509C PMD measurements. 
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tip. Alternatively, polarized light at three angles can be provided from a single 
mode of a polarization maintaining fiber, by rotating the fiber to the necessary 
angles with a fiber chuck, or holder. (This PMF can also be used to stimulate 
the input of the optical IC). See “Making Polarization Maintaining Fiber 
Launch Alignments” on page 4-79 for details on launching light into a single 
polarization mode of PMF. 

Measuring polarization state at a connector surface 

A polarization reference frame can be established at a connector interface. 
The required two or three reference polarization states are provided from a 
polarization maintaining fiber in which all of the light is confined to a single 
mode (high extinction ratio). For accurate results, some fixturing is required. 
One of the connectors must be keyless to allow the pair to rotate relative to 
one another. A graduated dial is required to measure rotational angle. The 
scale may be indexed to the excited axis of the PMF. See “Making Polarization 
Maintaining Fiber Launch Alignments” on page 4-79 for details on launching 
light into a single polarization mode of PMF. 

Concepts 

Explanation of polarization reference frame mathematics 
The Agilent 8509C produces a polarization reference frame using Jones Matrix 
calculus. The Agilent 8509C measures the Jones Matrix of the test system. 
The inverse of this Jones Matrix is applied to any incoming SOP data in an 
attempt to remove the birefringence and PDL effects of the test system. 

Refer to “Making Jones Matrix Measurements” on page 4-70 for further infor-
mation. 

Transmission ratio (3pt reference frame) 
The quality of a 2pt or 3pt reference frame is checked by selecting Reference 
Frame Info... from the System menu of the main screen. For the 3pt reference 
frame, the resulting dialog box provides both a qualitative description 
(good....very poor) and a parameter called the transmission ratio. Transmis-
sion ratio is a measure of the equivalent PDL of the path between the refer-
ence polarizer and the Agilent 8509C polarization receiver, expressed in linear 
terms. The equivalent PDL is found by multiplying the log to base ten of the 
displayed number by ten. An excellent reference frame shows a transmission 
ratio of 1.0, equivalent to a PDL of 0 dB. 

The equivalent PDL specified by the transmission ratio does not necessarily 
describe real PDL in the measurement both between reference polarizer and 
Agilent 8509C. The quality of the reference frame can be degraded by not only 
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weak or strong polarizing elements, but also by low signal level, incorrect set-
ting of the reference polarizer angles or movement of fibers between polarizer 
rotations. 
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Making State of Polarization Measurements

The state of polarization of a lightwave signal is described by the parameters 
of total optical power, degree of polarization and a description of the polarized 
portion of the light within a polarization reference frame. All of these parame-
ters are measured by the Agilent 8509C and are discussed in this section. A 
typical measurement window is shown in Figure 4-87. 

Unless a polarization reference frame is specifically created by the user (see 
“Making Polarization Reference Frame Measurements” on page 4-85), the 
Agilent 8509C uses the reference frame of the polarimeter receiver inside the 
instrument. 

Function See....

State of polarization measurements “To make signal polarization parameters measurements” on page 4-94

Concepts “Degree of polarization” on page 4-97
“Electric fields and polarization” on page 4-97
“Elliptical displays of polarization” on page 4-98
“Poincare sphere” on page 4-99
“Stokes parameters” on page 4-100
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Figure 4-87. Example of a SOP measurement data display 

To make signal polarization parameters measurements 

The following measurement procedure illustrates how to use the 
Agilent 8509C lightwave polarization analyzer operating system software to 
measure the polarization parameters of a signal. 

Measurement setup

1 Connect your measurement system as shown in Figure 4-88. 
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Figure 4-88. Measurement setup 

External source preparation 

Before performing the measurement, you must select an optical source. The 
following procedure will guide you through the process. 

2 Select System from the Main menu, and then select Optical Source. 

 

Figure 4-89. System menu 

3 Select the external laser source and set the desired wavelength. 
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Figure 4-90. Optical Source Setup window

Making the measurement 

At this point your measurement system is ready to make your first measure-
ment. For our purposes we are going to measure the 1550 nm signal from a 
tunable laser source.

1 Activate the laser source and ensure that the fiber and the laser are thermally 
and vibrationally stable.

2 The main window should now display the correct input state of polarization, 
DOP, and power level (see Figure 4-91).

C A U T I O N Observe proper connection techniques. Refer to “Cleaning Connections for 
Accurate Measurements” on page 7-14. 

Your measurement is complete. Signal polarization parameters are presented 
on the basic Agilent 8509C measurement screen and should look similar to 
Figure 4-91.
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Figure 4-91. SOP and DOP measurement results screen

Concepts 

Degree of polarization 
The DOP of the lightwave signal used in measuring your fiber optic cable is 
displayed as a percentage in the upper left hand corner of the main window 
display. As a review: the DOP is a measure of what percentage of the total 
average lightwave signal power is polarized. 

Degree of polarization of lightwave signal is related to that signals Stokes 
parameters as shown below: 

DOP = (S
1

2 + S
2

2 + S
3

2)1/2 / S
0
 = (s

1
2 + s

2
2 + s

3
2)1/2 

S
x
 is a standard Stokes parameter while s

x
(=S

x
/S

0
) is a normalized Stokes 

parameter. 

Electric fields and polarization 
The electric field of a lightwave can be resolved into two arbitrary, orthogonal 
vector components, Ex(t) and Ey(t). The relative magnitude and phase of 
these E-field vector components determine the polarization of the signal. 
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Figure 4-92. Polarization changes with Ex(t) and Ey(t) 

Elliptical displays of polarization 

Any state of polarization can be created by adjusting the magnitude and phase 
relationships of the Ex(t) and Ey(t) components of a lightwave signal. All 
polarization states can be shown as unique elliptical displays. Several classical 
examples are shown in Figure 4-93. Notice the E-field magnitude and phase 
relationships for each case. 
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Figure 4-93. Elliptical displays of polarization 

 

Figure 4-94. Mathematical description of an elliptical display of polarization 

Poincare sphere

The Poincare sphere is an excellent display format for monitoring signal polar-
ization changes, because all possible states of polarization presented at the 
same time. This is accomplished by assigning each state of polarization its own 
specific point on the Poincare sphere. Points on the equator represent states 
of linear polarization, the poles represent right-hand and left-hand circular 
polarization, and other points on the sphere represent elliptical polarization. 
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Each point on the Agilent 8509C Poincare sphere has a unique set of coordi-
nates defined by the sphere’s three dimensional axes s1, s2, and s3. These 
coordinates are called normalized Stokes parameters. 

 

Figure 4-95. Polarization states on a poincare sphere 

Stokes parameters 

A Stokes vector is a 4 x 1 real matrix of Stokes parameters (S
0
, S

1
, S

2
, and S

3
) 

that completely describes the SOP of a lightwave. Each element of the matrix 
is based upon measured power levels. S

0
 is the average power of the entire 

light beam. S
1
 is the difference in power between the horizontal and vertical 

linear polarization components of the beam. S
2
 indicates the power difference 

between +45 degree and –45 degree linear polarization. S
3
 is the power differ-

ence between the right-hand and left-hand circular polarization. The Stokes 
vector has a magnitude equal to (S

1
+S

2
+S

3
)1/2 and originates from the center of 

the Poincare sphere. The Agilent 8509C graphically projects the normalized 
Stokes vector termination point onto the surface of a unity radius sphere, even 
when the magnitude of the normalized Stokes vector is not equal to one. 
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Making Marker Angles

The marker angles function allows you to calculate angles between any two 
marked points on the Poincare sphere. When at least two markers have been 
defined, the angle between those markers will be printed in the marker angles 
group.

Function See....

Marker angles “To make a marker angles measurement” on page 4-102

Free Run Mode Measurement “To make a free run mode measurement” on page 4-105

Timed Mode Measurement “To make a timed mode measurement” on page 4-106

Single Mode Measurement “To make a single mode measurement” on page 4-108

Timed Measurement Viewing “To view timed measurements on the Poincare sphere” on page 4-109

Saving Timed Measurement “To save timed measurements” on page 4-110

Recalling (Loading) Timed Measurements “To recall (load) timed measurements” on page 4-111
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To make a marker angles measurement

1 Select Measurement and then Marker Angles. A Marker Angles group will appear in 
the main window. The angle will be measured between two points.

2 Check the On box from the Markers area to set a marker.

3 Click on Clear Markers to clear any previous data.

4 Select A to define your first marker for your first state of polarization 
measurement. Define markers B and C in the same manner.
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5 Read the Marker Angles from the Marker angles group just below the power 
meter and DOP bars.

Once the Markers have been defined, you can view the results in the Marker 
Angles group. Both the angle and its cosine are displayed. Notice that you can 
view the marker values in either radians or degrees.

6 When finished, select Done to close the marker angles group.

Making Timed Measurements

The timed measurement feature provides a means for measuring and saving 
the polarization parameters of an optical signal as a function of time. Saved 
measurements can be recalled for viewing on the Poincare sphere or imported 
to a spreadsheet for analysis. Timed measurement data is preserved when the 
Poincare sphere is rotated or zoomed.

Note: When the Poincare sphere is rotated or zoomed, you will lose your 
sphere traces, but will keep your markers.

From the Measurement menu, select Timed Measurement Refer to “Timed 
Measurement selection” on page 4-104.
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Figure 4-96. Timed Measurement selection

The Timed Measurement controls appear in the area normally occupied by the 
Polarization Ellipse display. Refer to “Timed Measurement” on page 4-104.

Figure 4-97. Timed Measurement

The drop-down list provides three operating modes:

Free Run mode, a user-specified number of measurements, are taken at the 
normal, untimed, open-loop rate of the Agilent 8509C, typically 2000-3500 
samples per second.
Timed mode, a user-specified number of measurements, are taken at specified 
time intervals.
Single mode, measurements are taken one at a time as specified by the user.
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In all three modes, the Agilent 8509C automatically clears the Poincare sphere 
display and puts the instrument in hold when the measurement is started. The 
instrument is left in hold at the end of the measurement to prevent the display 
of unwanted measurements on the Poincare sphere.

To make a free run mode measurement

1 Select Free Run from the drop-down list of the Timed Measurement Mode. 

2 In the Number of Samples box, enter the number of measurement samples you 
want to collect. A maximum of 16,381 is allowed.

3 Check the Large Dot Size to display the Poincare Sphere using 9x9 pixel display 
or clear the check box to display the Poincare Sphere using a single pixel. The 
large dot size makes the display easier to see.

4 Select Start Sample Sequence to begin the measurement.

Measurements are automatically taken at the open-loop measurement rate of 
the Agilent 8509C, typically 2000-3500 samples per second (refer to “Receiver 
characteristics” on page 9-10). The measurement cannot be interrupted or 
cancelled. The screen and mouse are inactive.

The measurement is complete when the mouse pointer returns. The Poincare 
sphere can be rotated or zoomed without loss of data. The Poincare sphere 
display is refreshed after it has been hidden behind another window. The 
amount of time required to reformat or refresh the Poincare sphere display 
increases with the number of samples.
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Measurement samples may be sequentially averaged using the Display Averag-
ing feature found in the main window of the Agilent 8509C under 
System > Averaging. Display averaging produces a moving, unweighted aver-
age from a user-specified number of samples.

To make a timed mode measurement 

1 Select Timed from the drop-down list of the Timed Measurement Mode. 

2 In the Number of Samples box, enter the number of measurement samples you 
want to collect. A maximum of 16,381 is allowed.

Figure 4-98. Timed measurement mode.

3 Enter either the period (0.010 to 7209 seconds) or rate (0.00013 to 100 Hz) of 
the time measurement. 

Period is rounded to the nearest millisecond; the rate is given by 1/period. 

4 Select Start Sample Sequence to start the measurement. The data acquisition 
status box appears, refer to “Status of the time measurement” on page 4-107, 
showing the status of the time measurement.
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Figure 4-99. Status of the time measurement

Period of the time measurement ranges from 0.010 to 7209 seconds.
Start shows the start time in 24-hour format. 
Duration displays the measurement time which is dependent of the number 
of samples taken.
Time Remaining displays the remaining time of the measurement.
Samples Taken displays the number of samples requested. 
Pause stops data collection at the current sample count. Pause is available 
when the measurement requires more than 8 seconds. To select pause, press 
Alt and the underline character. (Tip: the underline character is normally 
selected by pressing shift hyphen.)
Continue restarts the data collection at the current sample count. Continue 
replaces Pause once the measurement has been stopped.
Cancel stops the measurement entirely, but data measured before the button 
is pressed is preserved. The number of measurements taken before cancel was 
pressed appears in the number of samples display. The measurement can be 
restarted by selecting Timed Mode from the drop-down list.
When the measurement is complete, the Poincare sphere can be rotated or 
zoomed without loss of data. The Poincare sphere display is refreshed after it 
has been hidden behind another window. The amount of time required to re-
format or refresh the Poincare sphere display increases with the number of 
samples.

Note: When the Poincare sphere is rotated or zoomed, you will lose your 
sphere traces, but will keep your markers.

Measurement samples may be sequentially averaged using the display averag-
ing feature found in the main window of the Agilent 8509C under
System > Averaging. In the timed mode of operation, two modes of averaging 
are available. The moving average mode forms the unweighted average of 
recent samples as specified by the user and operates the same as averaging in 
free run mode. When the period is large or the rate is small, the refreshed 
average mode is automatically selected. In this mode, each displayed measure-
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ment point is the result of a fresh set of samples taken at the open-loop mea-
surement rate of the Agilent 8509C. Each displayed measurement point is 
totally independent of any other displayed measurement point. Averaging 
automatically switches to the refreshed average mode when the period is 
larger than the time value stored in the parameter MsecToAvgEachPt in the 
WIN.INI file in the Windows Directory. This parameter can be edited by double 
clicking on the WIN.INI file name in the Windows Directory, finding the item in 
the file and editing the value (in milliseconds). The default value is 50 millisec-
onds. The value chosen must be large enough to allow the use-specified num-
ber of display averages to be taken at the open-loop measurement rate of the 
Agilent 8509C. The Agilent 8509C application must be ended and restarted to 
access the changed parameter value. Additional detail is provided in CON-
FIG.WRI.

Note: Timed measurement accuracy is approximately +/–1 millisecond when 
intervals are less than 65.565 seconds, and +2/–12 milliseconds for other 
timed intervals. Actual timed interval accuracy can be determined by observ-
ing the hold output BNC connector on the rear panel of the Agilent 8509C LPA 
instrumentation during a timed measurement. This is an active low TTL signal 
with a 10 microsecond pulse for each stokes measurement. Turn 
Agilent 8509C averaging off to see only a single pulse for each timed interval.

To make a single mode measurement

1 Select Single from the drop-down list of the Timed Measurement Mode. Refer 
to “Single mode measurement” on page 4-108.

Figure 4-100. Single mode measurement
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2 Press Take Sample once for each polarization measurement desired. 

3 From the System > Averaging menus, select Display Averaging On and specify the 
number of samples to be averaged. Each time the Take Sample button is 
pressed, that number of samples is taken at the open-loop measurement rate 
of the instrument and averaged to produce a single measurement value.

Samples taken displays the number of samples taken. The maximum number 
of samples is 16,381.
Take Sample starts the number of samples taken for each desired polarization 
measurement.
Back step button erases the most recent measurement point. It may be 
pressed more than once. 
Reset resets the entire measurement.

When the measurement is complete, the Poincare sphere can be rotated or 
zoomed without loss of data. The Poincare sphere display is refreshed after it 
has been hidden behind another window. The amount of time required to re-
format or refresh the Poincare sphere display increases with the number of 
samples.

Note: When the Poincare sphere is rotated or zoomed, you will lose your 
sphere traces, but will keep your markers.

To view timed measurements on the Poincare sphere

Polarization data taken in any of the Timed Measurement modes is preserved 
when the Poincare sphere is rotated or zoomed. The controls to rotate and 
zoom are located below the Poincare sphere display. Refer to “Rotate and 
zoom controls” on page 4-110.

Note: When the Poincare sphere is rotated or zoomed, you will lose your 
sphere traces, but will keep your markers.
4-109



Using the Measurement Menu
Making Marker Angles

book.book  Page 110  Thursday, March 29, 2001  12:14 PM
Figure 4-101. Rotate and zoom controls

To save timed measurements

1 Select File > Save > Timed Measurement to Database to save a time measurement to 
the database. Refer to “Save a timed measurement” on page 4-110.

or

2 Select File > Save > Timed Measurement As Text to save a timed measurements to a 
text file.

Figure 4-102. Save a timed measurement
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When a timed measurement is saved as text, the Stokes parameters (optical 
power S

0
 and S

1
, S

2
, S

3
) are expressed in milliwatts and the Degree of Polariza-

tion (DOP) in percent.

To recall (load) timed measurements

1 Select File > Save > Timed Measurement to Database As Text to load a timed 
measurement from the database. Refer to “Load a timed measurement from 
text file” on page 4-111.

or

2 Select File > Load > Timed Measurement As Text to load a timed measurement from a 
text file.

Figure 4-103. Load a timed measurement from text file
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5

The PRESET Configuration 5-2
Using the Show functions 5-4
Using the Power Display functions 5-10
Using the Mark Current Point functions 5-12
Using the Display Update functions 5-14
Using the Hold functions 5-16
Using the Clearing Trace functions 5-18
Using the Auto Refresh functions 5-19

Other display functions, such as zoom, rotate, and marker functions, are discussed in 
Chapter 2, “A Quick Tour”. 
Using the Display Menu
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The PRESET Configuration 

Figure 5-1 shows the PRESET configuration of the Agilent 8509C display. You 
can change the display to meet your needs. For example, the Poincare sphere 
and the polarization ellipse can be exchanged, the power mode can be 
changed from dBm to Watts, and the marker window can be removed. 
 

Figure 5-1. PRESET configuration window
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The Display Menu

This chapter contains information about the Display menu (in the main win-
dow).

Figure 5-2. Display menu

The following functions are available:

Function See....

Show

Markers “To display the marker table” on page 5-4

Sphere “To display the Poincare sphere” on page 5-6

Ellipse “To display the polarization ellipse” on page 5-7

Sphere < - > Ellipse “To exchange the Poincare sphere and the polarization ellipse” on page 5-8

Power Display “To change the power display units” on page 5-10

Mark Current Point “To mark the current point” on page 5-12

Display Update “To change the display update frequency” on page 5-14

Hold “To hold the data display” on page 5-16

Clear Trace “To clear the trace from the sphere” on page 5-18

Auto Refresh “To set the display to refresh automatically” on page 5-19
5-3



Using the Display Menu
The Display Menu

book.book  Page 4  Thursday, March 29, 2001  12:14 PM
Using the Show functions

To display the marker table 

Figure 5-3. The Show Markers menu

The marker table is displayed in the PRESET configuration, but it may be 
turned off or "hidden" by selecting Display, Show, √Markers. This menu selection 
toggles the marker table on and off. When the marker table is displayed, a 
check mark appears next to the menu selection. 

Figure 5-4 on page 5-5 shows what the display looks like with the marker win-
dow hidden. 
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Figure 5-4. Marker window hidden display

The marker window, in the lower-left corner of the Agilent 8509C display, 
always displays the Stokes parameters, comprised of the average optical 
power (S0), in dBm, and the normalized Stokes parameters (s1, s2 and s3). 
Stokes parameters for the current data point are on the top line (s) of the 
marker table. 

When marker A, B, or C is set, the respective parameters will also be displayed 
adjacent to the respective marker button (A, B, or C). (For information on 
Stokes parameters, refer to “Stokes parameters” on page 4-100.) 
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To display the Poincare sphere 

 

Figure 5-5. Show Sphere menu 

The Poincare sphere is displayed in the PRESET configuration, but it may be 
turned off or "hidden" by selecting Display, Show, √Sphere. This menu selection 
toggles the Poincare sphere on and off. When the sphere is displayed, a check 
mark appears next to the menu selection. 

Figure 5-6 on page 5-7 shows what the Agilent 8509C display looks like with 
the sphere turned off. 
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Figure 5-6. Poincare sphere display turned off window

To display the polarization ellipse 

 

Figure 5-7. Show Ellipse menu 

The polarization ellipse is displayed in the PRESET configuration, but it may 
be turned off or "hidden" by selecting Display, Show, √Ellipse. This menu selec-
tion toggles the polarization ellipse on and off. When the ellipse is displayed, a 
check mark appears next to the menu selection. 
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Figure 5-8 on page 5-8 shows what the Agilent 8509C display looks like with 
the ellipse turned off. 

 

Figure 5-8. Polarization ellipse display turned off window

To exchange the Poincare sphere and the polarization ellipse 

 

Figure 5-9. Show Sphere <-> Ellipse menu 

The default configuration has the Poincare sphere and the polarization ellipse 
displayed as shown in Figure 5-1 on page 5-2. You may exchange the two so 
that the ellipse has the more prominent position by selecting Display, Show, 
Sphere <-> Ellipse. 
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Figure 5-10 on page 5-9 shows what the display looks like with the Poincare 
sphere and the polarization ellipse exchanged. 

 

Figure 5-10. Sphere and ellipse exchanged display window
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Using the Power Display functions

 

Figure 5-11. Power Display menu 

To change the power display units

The default state for the power mode is dBm. See Figure 5-1 on page 5-2. 
Change the power mode to Watts by selecting Display, Power Display, Watts. This 
menu selection allows you to toggle between Watts and dBm. A check mark 
appears next to the menu selection that is currently activated. 

Figure 5-12 on page 5-11 shows the power mode changed from dBm to Watts. 
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Figure 5-12. Power display in watts mode window
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Using the Mark Current Point functions

 

Figure 5-13. The Mark Current Point menu 

To mark the current point

Often when data is being displayed on the Poincare sphere, it is desirable to 
know where the current data point is. You can turn on a feature that puts a 
flashing dot at the current data point by selecting Display, and Mark Current Point. 
When this feature is activated, a check mark appears next to the menu selec-
tion. 

The dot will be red if the data is on the front of the sphere, and blue if it is on 
the back side of the sphere. 

Figure 5-14 on page 5-13 shows what the display looks like with the mark cur-
rent point feature turned on. 
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Figure 5-14. Mark current point activated display window
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Using the Display Update functions

 

Figure 5-15. Display Update menu 

To change the display update frequency

The power measurement, DOP measurement, polarization ellipse, and Stokes 
displays are updated after the display of a user-selected number of points on 
the Poincare sphere. The default display update rate is once every 400 sphere 
points. The acceptable range of values for the display update number is 1 to 
2000. 

Figure 5-16 shows the Display Update window that appears when you select 
Display, Display Update. 

To change the display update number, select the existing number and enter 
your new value. 

 

Figure 5-16. Display Update window 
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To maximize the update rate of the Poincare sphere display, set the Display 
Update value at the maximum (2000). 

C A U T I O N The display update frequency cannot be smaller than the display averaging 
factor. Display averaging factor is automatically reduced to avoid this 
condition. 
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Using the Hold functions

 

Figure 5-17. Hold menu 

To hold the data display

If you wish to hold the current data display and not see new data put up on the 
Poincare sphere, you can activate the Hold function by selecting Display, Hold. 
This menu selection toggles the hold function on and off. When the Hold func-
tion is activated, a check mark appears next to the menu selection. Also, there 
will be an "X" in the Hold box on the Agilent 8509C basic measurement screen. 
See Figure 5-18 on page 5-17. 

The Hold function can also be toggled on and off with the F6 key on your key-
board, or by selecting the Hold window on the basic measurement screen. 

Putting the instrument in hold allows windows operations such as screen 
repaints, and other software applications to run faster.
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Figure 5-18. Hold function display window
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Using the Clearing Trace functions

 

Figure 5-19. Clear Trace menu 

To clear the trace from the sphere

To clear data from the Poincare sphere via the Display menu, select Display, 
Clear Trace. After the sphere is cleared data taking will continue. 

You can also activate the Clear Trace function by pressing F7 on your key-
board, or by selecting Clear Trace on the basic measurement screen. 
5-18



Using the Display Menu
The Display Menu

book.book  Page 19  Thursday, March 29, 2001  12:14 PM
Using the Auto Refresh functions

 

Figure 5-20. Auto Refresh menu 

To set the display to refresh automatically

Usually, Auto Refresh should not be selected. Use it only if there are many tasks 
running in windows and the screen is not being repainted properly. If this fea-
ture is needed, select Display, and then Auto Refresh. 
5-19



Using the Display Menu
The Display Menu

book.book  Page 20  Thursday, March 29, 2001  12:14 PM
5-20



book.book  Page 1  Thursday, March 29, 2001  12:14 PM
6

Using the Optical Source functions 6-4
Using the Zero functions 6-5
Using the Calibration functions 6-6
Using the Polarizers function 6-17
Using the Shutter functions 6-19
Using the Averaging functions 6-20
Using the Range functions 6-22
Using the Analog Outputs functions 6-24
Using the Reference Frame Info functions 6-26
Using the Operation Verification functions 6-28
Using the System Menu



Using the System Menu
The System Menu

book.book  Page 2  Thursday, March 29, 2001  12:14 PM
The System Menu

The System menu on the Agilent 8509C allows you to make changes to the 
system that are necessary to perform measurements. The receiver can be 
zeroed and calibrated for specific wavelengths, the optical source can be 
selected, the polarizers can be selected, and so on. 

Figure 6-1. System menu
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The following functions are available:

Function See....

Optical Source “To open the Optical Source Setup window” on page 6-4

Zero “To initiate the receiver zeroing routine” on page 6-5

Calibrations “To calibrate for use with a fixed wavelength source” on page 6-7
“To select the source to be calibrated” on page 6-7
“To calibrate at the selected wavelength” on page 6-8
“To save and/or apply the calibration” on page 6-9
“To calibrate for use with a tunable wavelength source” on page 6-10
“To select an external source and input wavelength” on page 6-10
“To calibrate at the selected wavelength” on page 6-11
“To save wavelength calibrations” on page 6-13
“To apply a calibration” on page 6-13
“To delete a calibration” on page 6-15

Polarizers “To open the Polarizers window” on page 6-17
“To select an internal polarizer” on page 6-17
“To select an external polarizer” on page 6-18

Shutter “To put the shutter into the signal path manually” on page 6-19

Averaging “To open the Averaging window” on page 6-20
“To select Display Averaging” on page 6-20
“To select Measurement Averaging” on page 6-21

Range “To open the Range window” on page 6-22
“To select Autorange” on page 6-22
“To select a specific gain state” on page 6-22

Analog Outputs “To open the Analog Outputs window” on page 6-24
“To use the DOP and normalized Stokes parameters mode” on page 6-24
“To use the raw photodiode currents” on page 6-25

Reference Frame Info.... “To open the Reference Frame Info window” on page 6-26

Operation Verification.... “To verify that your system is working properly” on page 6-28

DDE Server “To establish a Dynamic Data Exchange (DDE) link between the 8509 and another 
application” on page 6-29
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Using the Optical Source functions

To open the Optical Source Setup window 

 

Figure 6-2. Optical Source Setup window 

You can open the Optical Source Setup window in one of three ways: 

• Select System, Optical Source, or

• Select λ (located in the upper right corner of the basic measurement screen), 
or 

• Press F8 on your keyboard. 

If the source you select within the Optical Source Setup window is an 
8164/8167/8168 tunable laser source connected to the Agilent 8509C system 
via HPIB, source wavelength, power and attenuation control can be done 
through this Optical Source Setup window. After selecting the Agilent 8164, 
Agilent 8167, or Agilent 8168, you will be able to enter the HPIB address of 
the laser. 

Agilent 8164, Agilent 8167, and Agilent 8168 sources, if connected via HPIB, 
are automatically turned on and off as you select the sources. Other types of 
external sources must be turned on and off manually. 
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Using the Zero functions

The zeroing routine is performed automatically at instrument start-up. How-
ever it should be performed again after the instrument has warmed up for 
approximately one hour or after large ambient temperature changes. 

To initiate the receiver zeroing routine 

The zeroing routine can be initiated in one of two ways: 

• Select System, Zero. 

• Press F9 on your keyboard. 

Making Accurate Measurements

For accurate measurements, it is important that the receiver is not detecting any power 
while the zeroing routine is being performed. 

You will not be prompted to block the external laser, but you must either cover the OPTI-
CAL INPUT connector with a connector cap or a piece of dark paper, or turn off your exter-
nal source. If the external source is connected to the Agilent 8509C EXTERNAL SOURCE 
INPUT, its power will be blocked automatically so that no power will emerge from the 
OPTICAL OUTPUT connector during the zeroing operation. 

While the zeroing routine is running, a green "zero" message will appear inside the 
power display in the upper left corner of the basic measurement screen, and the mouse 
pointer appears as an hourglass. When the "zero" message disappears, and the 
mouse pointer changes back to an arrow, the zeroing routine is finished. 
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Using the Calibration functions

The Agilent 8509C lightwave polarization analyzer has a built-in calibration 
feature that allows you to calibrate your instrument for specific wavelengths. 

Use the calibration functions to: 

• Optimize performance when using a source whose wavelength is uncertain to 
greater than ±1 nm. 

• Optimize performance when using a source with broad optical spectrum, such 
as a Fabry-Perot laser or an LED. 

• Minimize any uncertainty caused by ambient temperature change or instru-
ment aging. 

Follow the instructions for “To calibrate for use with a fixed wavelength 
source” on page 6-7 when calibrating with sources which will not be tuned. 

Follow the instructions for “To calibrate for use with a tunable wavelength 
source” on page 6-10 when you expect to use a single tunable source at a 
number of different wavelengths. This avoids confusion with calibrations 
taken at the same wavelength(s) using sources that have other spectral char-
acteristics. 

The following information is provided in this section. 

• Fixed wavelength source calibration 

• Tunable wavelength source calibration 

• Applying and deleting calibrations 

Additional Information 

The calibration must be performed with the source that will be used to make measure-
ments. 
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Figure 6-3. Calibration window 

To calibrate for use with a fixed wavelength source 

Make sure the instrument has warmed up for at least one hour and then zero 
the instrument. Refer to “Using the Zero functions” on page 6-5 for informa-
tion on how to zero the instrument. 

To select the source to be calibrated 

1 Open the Optical Source Setup window by selecting λ. 

2 Select an external source. 

Be sure to input the wavelength. Refer to “Using the Optical Source functions” 
on page 6-4 for more information on selecting a source. 

Enhancing Accuracy 

Calibration is optional. Calibration is not required for Agilent 8509C operation. 
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Figure 6-4. Optical Source Setup window 

To calibrate at the selected wavelength 

1 Open the Calibration window by using the mouse to select System, Calibration, or 
by pressing F11 on your keyboard.

 

Figure 6-5. Calibration window

2 Select the "Fixed λ" source type. 
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3 Be sure that your source is turned on and tuned to the desired wavelength (if 
it is an external source). 

4 The calibration works best if the optical signal is polarized before it is applied 
to the Agilent 8509C OPTICAL INPUT. Insert an external polarizer or pass the 
signal through one of the internal polarizers. Select the polarizer using System, 
Polarizers. Select any of the three polarizers. Remember to remove the polarizer 
when the calibration is complete. 

5 Move the fiber ahead of the polarizer, or adjust the front panel knobs (if 
necessary) to assure a good signal level through the polarizer. 

6 Select Calibrate. 

7 You will hear some clicking from inside the Agilent 8509C as the calibration is 
being performed. The calibration takes about 60 seconds. The Agilent 8509C 
automatically averages 250 measurements at each state. 

8 Calibrate at other wavelengths by repeating the above procedure. 

To save and/or apply the calibration 

1 The calibration list for fixed wavelengths provides the following information: 

• The wavelength(s) that have been calibrated. 

• Whether the calibration has been saved or not. 

Enhancing Accuracy 

Signal power and DOP must be constant during the calibration process.
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Figure 6-6. Calibration list window

2 To save all calibrations in the list with the "New" designation, select Save new 
calibrations. 

3 To apply a calibration, select Apply Calibration On in the Calibration window. (See 
“To apply a calibration” on page 6-13.)

To calibrate for use with a tunable wavelength source 

Make sure the instrument has warmed up for at least one hour and then zero 
the instrument. Refer to “Using the Zero functions” on page 6-5 for informa-
tion on how to zero the instrument. 

To select an external source and input wavelength 

1 Open the Optical Source Setup window by selecting λ. 

Additional Information 

A calibration does not have to be saved in order to be applied. However, unsaved cali-
brations will be lost when the Agilent 8509C software is closed. 
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Figure 6-7. Optical Source Setup window 

2 Select an external source, such as the Agilent 8168A. 

3 Select Manually tuned for other, non-automatic tunable sources. 

4 Input the first wavelength you want to calibrate. 

To calibrate at the selected wavelength 

1 Open the Calibration window by using the mouse to select System, Calibration, or 
by pressing F11 on your keyboard. 
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Figure 6-8. Calibration window 

2 Select a tunable wavelength source. 

3 Be sure your source is turned on and tuned to the desired wavelength. 

4 The calibration works best if the optical signal is polarized before it is applied 
to the Agilent 8509C OPTICAL INPUT. Insert an external polarizer or pass the 
signal through one of the internal polarizers. Select the polarizer using System, 
Polarizers. Select any of the three polarizers. Remember to remove the polarizer 
when the calibration is complete. 

5 Move the fiber ahead of the polarizer, or adjust the front panel knobs (if 
necessary) to assure a good signal level through the polarizer. 

6 Select Calibrate. 

7 You will hear clicking from inside the Agilent 8509C as the calibration is being 
performed. The calibration takes about 60 seconds. The Agilent 8509C 
automatically averages 250 measurements at each state. 

8 To calibrating subsequent wavelengths, enter the new wavelength in the 
wavelength box in the Calibration window by selecting the existing entry, then 
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writing over it. You may also input the new wavelength using the Optical Source 
Setup window. 

9 Select Calibrate. 

To save wavelength calibrations 

When all desired wavelengths have been calibrated, save the calibrations 
according to the following procedure. 

To save all the calibrations in the list with the "New" designation, select Save 
new calibrations as shown in Figure 6-9. 

 

Figure 6-9. Calibration list window

To apply a calibration 

In the Calibration "Off" condition, the analyzer uses the factory calibration 
constants. In the Calibration "On" condition, the analyzer uses the calibration 
you have performed to modify the internal cal constants for the current wave-
length. 

Applying a calibration 

• If you are still working within the Calibration window and wish to apply your 
calibration, use the mouse to select Apply Calibration On. 

• To apply another calibration, select the item in the calibration list. Select Apply 
Calibration On if necessary. 
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How to tell if a calibration is applied 

When a user-performed calibration is applied, the word Cal in the box in the 
upper-right corner of the measurement screen will be bold (black letters) on a 
white background. 
 

Figure 6-10. Calibration applied window

When a user-performed calibration is not applied, the word Cal in the box in 
the upper-right corner of the measurement screen will be gray (inactive). 

Additional Information 

If you have calibration turned on, and enter a wavelength for which there is no calibra-
tion, the calibration is automatically turned off. The Agilent 8509C warns you that no 
calibration exists. The Agilent 8509C does not interpolate between calibrations. 
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To delete a calibration 

1 A calibration can be deleted by selecting an entry in the Calibration List, and 
then selecting Delete selection. 

 

Figure 6-11. Deleting a selection in the Calibration window

2 A window appears to confirm that you want to delete the calibration or cancel 
the delete calibration. Select OK to proceed with the deletion, or Cancel to abort 
the delete calibration process. 

 

Figure 6-12. Confirm or abort the deletion process window
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3 When calibration data is deleted, it is deleted from memory and from the disk 
file. 
6-16



Using the System Menu
The System Menu

book.book  Page 17  Thursday, March 29, 2001  12:14 PM
Using the Polarizers function

 

Figure 6-13. Polarizers window 

To open the Polarizers window 

To open the Polarizers window, select System, Polarizers or press F12 on your 
keyboard.

To select an internal polarizer

The internal polarizer angles are fixed, and their angles are measured at the 
factory. The nominal relative angles for internal polarizers A, B, and C are 0, 
60, and 120 degrees, respectively. The values shown on your screen for these 
polarizers will be the measured angle values unique to your instrument. 

1 To select an internal polarizer, select Internal in the Polarizers window. 

2 Select polarizer A, B, or C. 

3 Select No Polarizer to remove an internal polarizer from the signal path. 

About internal polarizers 

Internal polarizers are effective only when using an external source that is 
routed through the Agilent 8509C via the EXTERNAL SOURCE INPUT. 

Internal polarizers are inserted automatically during several types of measure-
ments, and may be inserted manually to polarize light from an external source. 
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To select an external polarizer 

When using external polarizers to make certain measurements, you must 
input the angles of your polarizers into the Agilent 8509C. 

1 Select External from the Polarizers window. 

2 Input your angle values, in degrees, for external polarizers A, B, and C: select 
the numbers in the appropriate polarizer angle box and then input the value for 
your external polarizer angle.

Note 

The angles displayed are the default values for use with a rotatable external polarizer. 
The buttons for polarizer selection are gray (inactive) and no longer apply, however they 
continue to show the status (inserted or not) of the internal polarizers.

Polarizer angles and the Poincare display 

There is a 1:2 relationship between rotation of a linear polarizer and the resultant angle 
swept out on the Poincare sphere. For example, a 180° rotation of a linear polarizer pro-
duces a 360° "great circle" on the Poincare sphere display. 
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Using the Shutter functions

 

Figure 6-14. Shutter window

To put the shutter into the signal path manually

A shutter can be engaged to block light routed through the Agilent 8509C via 
the EXTERNAL SOURCE INPUT. This shutter can be put into the signal path manu-
ally by selecting System, Shutter. 
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Using the Averaging functions

 

Figure 6-15. Averaging window 

To open the Averaging window 

Open the Averaging window by selecting System, Averaging. 

To select Display Averaging 

The default number (N) of display samples is 25 while the range is 0 to 1000. 
To enter a different number of samples, select the existing number in the dis-
play samples box, then enter your new selection for Display Averaging. 

Turn Display Averaging Off or On from the Averaging window. 

About display averaging 

When display averaging is on, every point on the sphere is a running average 
of the preceding N measurements of the incoming lightwave signal. Displays of 
average power, DOP, Stokes parameters and the elliptical display are also sub-
ject to Display Averaging. 

Additional Information 

The Display Averaging entry must be less than the Display Update entry (see “Using the 
Display Update functions” on page 5-14) and less than 1000. The lightwave polarization 
analyzer will only accept numbers that meet these criteria. 
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To select Measurement Averaging 

The range of numbers that Measurement Averaging will accept is 0 to 100,000. 

The default number (N) of measurement samples is 250. To enter a different 
number of samples, select and edit the displayed value. 

About measurement averaging 

Measurement averaging is a straight average of N measurement samples and is 
used when: 

• a polarizer is used in a measurement and 

• when markers are set, as in the setting of an external reference frame. 

The lower the measurement averaging value the faster measurements can be 
made. There will be an increase in measurement uncertainty if measurement 
averaging is set too low for the application. 
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Using the Range functions

 

Figure 6-16. Range window 

To open the Range window 

Open the Range window by selecting System, Range. 

To select Autorange 

The default condition for Range is Autorange. Note that when autorange is 
selected there is an "X" or check in the box next to it. 

To select a specific gain state 

1 Deselect Autorange. 

2 To accommodate high signal levels, select ↑ . For operation with low level 
signals, select ↓ . 

3 Continue pressing ↑ or ↓ until the power display (in the upper-left corner of 
the lightwave polarization analyzer measurement screen) reads Overrange or 
Underrange.

4 Once you have reached the Overrange or Underrange condition, press ↑ or ↓ 
once to remove the Overrange or Underrange indication on the power 
display. 

5 The gain will stay in this state until a different range is selected or until 
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Autorange is selected. 

About range 

To provide the large input dynamic range, the lightwave polarization analyzer 
operates over seven possible gain states or input power ranges. In some mea-
surements it is helpful to put the instrument in a specific gain state. This elim-
inates interruption of data taking by the gain switching process, and allows 
operation at levels below –55 dBm. 
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Using the Analog Outputs functions

Analog outputs are disabled when using a Vtune source. 

 

Figure 6-17. Analog Outputs window 

The analog outputs for the lightwave polarization analyzer are four BNC con-
nectors located on the rear panel of the lightwave polarization analyzer. They 
are labeled A, B, C, and D. 

To open the Analog Outputs window 

Open the Analog Outputs window by selecting System, Analog Outputs. 

To use the DOP and normalized Stokes parameters mode 

In this mode the BNC outputs provide the modes listed in Table 6-1. 

Table 6-1. Analog Outputs for DOP and Normalized Stokes Parameters Mode

Parameter Connector Output Voltage 

DOP, 0 to 100% A (%DOP – 100)/10 

S1, –1 to +1 B –10 to +10 

S2, –1 to +1 C –10 to +10 

S3, –1 to +1 D –10 to +10 
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To use the raw photodiode currents 

In this mode the BNC connectors provide signals proportional to the channel 
levels in the polarization receiver. These signals are corrected for front-end 
analog offset, but are not processed by the receiver calibration or ranging 
algorithms. These signals are developed from the output of the system ADC, 
which means that their values are linearly related to channel levels within any 
particular range (see “Using the Range functions” on page 6-22). In other 
words, as the input power is increased from very low levels to high levels, the 
rear panel outputs will rise in each range, and then drop and again start to rise 
as the next range is switched in. 

The output voltage covers the range of –10 volts to +10 volts as the ADC goes 
from zero to full counts. The connector assignments are listed in Table 6-2. 

Table 6-2. Analog Outputs for Raw Diode Currents Mode

Stokes Channel Connector 

0 A 

1 B 

2 C 

3 D 
6-25



Using the System Menu
The System Menu

book.book  Page 26  Thursday, March 29, 2001  12:14 PM
Using the Reference Frame Info functions

To open the Reference Frame Info window 

Open the Reference Frame Info window by selecting System, Reference Frame 
Info. 

If a reference frame has not been defined, the window shown in Figure 6-18 
appears. 

 

Figure 6-18. No Defined Reference Frame Info window 

If a reference frame has been defined, a window will appear with the following 
information: 

• The type of reference frame (two- or three-point), and whether or not it has 
been applied. 

• The polarization angle (two-point reference only) or the transmission ratio 
(three-point only). 

• The quality of the reference frame (one of the following): 

good 
fair 
poor 
very poor 

Figure 6-19 and Figure 6-20 are examples of the information given when a 
two- or three-point reference frame has been defined. 
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Figure 6-19. Two-Point Reference Frame Info window 

 

Figure 6-20. Three-Point Reference Frame Info window 
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Using the Operation Verification functions

This operation verification procedure is a fully automatic pass/fail indicator of 
your system’s performance. Perform this procedure after you install your sys-
tem to verify that your system is working properly. 

Note: Operation verification requires a 100% polarized external source for 
proper operation.

To verify that your system is working properly

1 Allow the instrument to warm up for at least 1 hour and then zero the 
instrument. 

2 Make sure the optical cable connecting the polarizer to the lightwave 
polarization analyzer’s OPTICAL INPUT is stable. This can be accomplished by 
taping the cable to the work surface. 

3 Select System, Operation Verification from the main window display. 

Figure 6-21. Operation Verification window

4 Select Start. When the verification procedure is finished, the message 
Operation Verification passed is displayed in the message window, 
and the Max, Min, and Mean DOP values are displayed. 

The relative angles between internal polarizers is also displayed. If the verifi-
cation fails, refer to the Degree of Polarization topic in Figure 7-1, “Measure-
ment troubleshooting matrix,” on page 7-3. 

5 The operation verification is complete. Select Done to clear the window and 
begin your measurement. 
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To establish a Dynamic Data Exchange (DDE) link 
between the 8509 and another application

DDE enables the Agilent 8509 to directly and continuously exchange data 
with other Windows based applications that support DDE. DDE data 
exchanges are called “conversations”. DDE conversations are started by 
establishing DDE links. Applications using DDE to converse with the Agilent 
8509 for automatic control can be custom programs using a computer lan-
guage such as ‘C’ or Visual BASIC for Windows to create a custom application 
for programmed control of the Agilent 8509 using DDE. Refer to “HPIB for the 
Agilent 8509” on page 8-5 for programming examples.

Establishing DDE links

The Agilent 8509 allows other applications to establish DDE links to test based 
controls called ‘labels’ in the Agilent 8509 firmware. To establish a DDE link an 
application must know three things about the item it wants to link to:

• The name of the application it wants to talk to
• The subject of the conversation, called a topic
• The name of the item with which the DDE conversation should take place

Since the name of the Agilent 8509 application may change with future 
updates of the firmware, the programmer of a DDE application should provide 
a mechanism for the Agilent 8509 application to change without requiring the 
program to be re-compiled. What follows is a VB code fragment that allows the 
user to specify the Agilent 8509 application name as a command line parame-
ter to his program. The command line parameter may be specified in the Win-
dows Program Manager properties dialog, accessed in the menu File > 
Properties. Place the parameter after the name of the program in the Com-
mand entry.

Note: The DDE and HPIB commands follow the same HPIB/SICL format.
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To execute a DDE command manually

1 Select System and then DDE Server from the drop-down list.

2 Click on the Execute Command to send the command to the 8509.

When the command is finished, the application will return a status and data.

In the example above, the 8509 returns a status, pass, for the *IDN query 
along with information about the current 8509 instrument.

To update the list of DDE commands available from the DDE server window

Click the Update Command List button. This is primarily for Agilent internal 
debugging purposes.

When an external application commands the 8509, the box beneath the drop-
down command list will print the last executed command.
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Accuracy Enhancement and Troubleshooting

This section contains reference information regarding measurement accuracy 
and measurement troubleshooting. Verify the following conditions.

• Connect the electrical power and turn the instrument on. 

• Connect the interface cable between the instrument controller and the 
Agilent 8509C. 

• Connect the HPIB cable to the external optical source, if necessary. 

• Allow the instrument to warm up for at least one hour and zero the instrument 
following warm-up. 

• Allow the tunable laser source to warm up completely, if used. 

• Clean all connector surfaces. 

• Stabilize the optical fiber during some types of measurements. 

For help with operating the keyboard or the mouse, or with Windows conven-
tions, use the Windows Help menu in the Windows Program Manager. Select 
the background of the screen and select Program Manager from the dialog 
box.

Note 

Operating the Agilent 8509C requires instrument controller system resources. When you 
run multiple software applications, or have several Agilent 8509C windows open, sys-
tem resources can be exhausted, severely slowing operations such as moving from win-
dow to window. Check system resources by going to the Program Manager, selecting the 
Help menu and About Program Manager. At least 25% of the system resources should 
be free. Close applications or Agilent 8509C windows as needed to free up system 
resources and increase operating speed and responsiveness. In addition, it is a good 
idea to re-start your instrument controller every day. 
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Figure 7-1. Measurement troubleshooting matrix 
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Symptoms 
The measurement symptoms listed in Figure 7-1 describe conditions that can 
often be corrected or improved by addressing the appropriate areas described 
in the Solutions section of the measurement troubleshooting matrix. Appear-
ance of these conditions does not necessarily indicate a need for service nor 
does it confirm a system failure to perform within specified performance spec-
ifications. If a system failure is suspected, refer to “Step 4. Operation Verifica-
tion” on page 1-12. 

Solutions 
The following is a list of various ways to address the symptoms listed in the 
measurement troubleshooting matrix. In all cases, it is assumed that the 
Agilent 8509C system has passed the Operation Verification procedure (dis-
cussed in Chapter 1, “Setting Up the Lightwave Polarization Analyzer”) and is 
operating properly. 

1.Connector Care/
Reflections

Connector insertion loss and return loss of the test system and the test device can affect 
polarization measurements in a number of ways. Refer to “Cleaning Connections for Accurate 
Measurements” on page 7-14 for further information about procedures for avoiding connector 
related problems. 

The following information explains why reflections from dirty or damaged connectors may cause 
measurement uncertainty. 

If a set of large optical reflections are present in the test system or the test device, some optical 
energy will re-reflect, travel three times the length between the two reflection points (triple-travel 
signal), finally emerge and combine with that portion of the signal that traveled straight through 
(straight-through signal). 

This triple-travel signal has a different amount of phase shift because it has passed through a 
different birefringence path than the path used by the straight-through signal. The polarization state 
of the combined output signal can be modeled as two polarization components. One component 
represents the straight-through signal. The second component represents the energy from the 
triple-travel signal that is orthogonal to the straight through signal. As the wavelength changes, the 
phase relationships change and an arc is drawn on the Poincare sphere. The radius of the arc 
increases with the magnitude of the reflections. The radius of the arc represents measurement 
uncertainty and should be at least 30 to 40 dB for normal measurements. Check this value using the 
PMF Launch tool provided under the Measurement menu of the Agilent 8509C main window. The 
arc required for this PMF Launch tool can be created by manually changing the input wavelength. 
The dB ratio related to the radius of the arc will be automatically calculated and displayed. 
Connectors should be properly mating, physical contacting types with a reflection level better than 
40 dB. 
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2.Fiber Cable Layout/
Movement 

Fiber cables, used in the instrument setup of an Agilent 8509C polarization measurement, should be 
laid-out and secured in a relaxed and flowing manner, free from sharp kinks and tight radius curves 
(<2 inch). Secure the fiber using tape or some other technique to prevent the fiber from moving and 
to reduce the waiting time for fiber relaxation. A few minute relaxation time is recommended in any 
case to allow the stress pattern within the fiber to stabilize. Changing stress patterns alter the 
birefringence within a fiber, changing the polarization of a signal being transmitted through the 
fiber. Unstable polarization from an improperly deployed fiber cable increases measurement 
uncertainty.

After caring for the fiber layout, random vibration may still cause unstable polarization. Display 
averaging may be used to minimize the effect of these vibrations on the Poincare sphere display. 
Measurement averaging will reduce the effect of vibration on PMD and PDL measurements, and any 
measurements using the markers.

3.Zeroing

As in all measurements with the polarization analyzer, effective zeroing of analog circuit offsets is 
required for measurement accuracy. Refer to the Zeroing section of this manual for information 
about this procedure and feature. Although zeroing is automatically performed at power-on, zero the 
instrument again after a one hour warm-up period.

Zeroing with optical power applied to the optical input creates offsets in the instrument which 
seriously degrade accuracy and can result in power overrange or underrange warnings.

4.Wavelength & 
Wavelength 
Calibration

The Agilent 8509C contains (in memory) a set of factory calibration coefficients that optimize the 
accuracy of the polarimeter at a series of discrete wavelengths. For accurate operation of the 
instrument, enter the operating wavelength to at least 1 nm accuracy. Wavelength errors affect all 
measurements. The effect is apparent in the DOP measurement. When measuring fully polarized 
light from a fiber, the DOP fluctuates about 100% as the fiber is moved. Larger wavelength error 
produces a greater DOP fluctuation.

The Agilent 8509C provides a wavelength calibration process that allows the operator to augment 
the built-in calibration for a particular source, even if you don’t know the wavelength of the source. 
See the Calibration procedure in Chapter 6, “Using the System Menu”.
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5.Polarizer

Polarizers may include the polarizers internal to the Agilent 8509C, an external reference polarizer 
used for an Agilent 8509C application, a polarizer in the signal path, or the test device itself. In 
general, the last polarizer in the test signal path determines the polarization of the signal.

The Agilent 8509C contains an internal polarizer unit with three insertable linear polarizers. These 
may be enabled or disabled using the Polarizer controls accessed under the System menu of the 
main software window. Various measurement applications use different cases; you must select the 
appropriate condition.

Signal level can drop if the polarization of the input signal to a polarizer is crossed with, or blocked 
by, the polarizer. This can be an issue in any of the Agilent 8509C applications in which the Jones 
matrix is measured with internal or external reference polarizers, and in measurements of PMD and 
PDL by the Jones matrix method. It can also affect power level in the wavelength scanning PMD 
measurement if the source light is passed through an internal or external polarizer prior to the DUT. 
Adjust the source polarization for a circular state at the reference polarizer. The process for doing 
this is discussed under the measurement types in Chapter 4, “Using the Measurement Menu”.

Setting the input polarization relative to the test device can affect wavelength-scanning PMD 
measurements by changing the relative illumination of the polarization modes of the device. This 
can introduce measurement variability versus the position of the polarizer or the position of the 
input fiber to the DUT. If variability is severe, average the results of several measurements with the 
input fiber in different positions.

6.Lightwave Source 
Performance

Optical source wavelength and output power level should be stable and within the operating range 
of each element of the test system.

For all measurements involving a Jones matrix, the spectral line width (∆λ) of the optical test signal 
should be narrow enough to guarantee that the coherence time (approximately equal to λ2/c∆λ) of 
the test signal is less than 1/3 of the differential group delay (DGD) of the test device. This will 
reduce any measurement uncertainty that may be introduced by depolarization of the test signal. 
Best performance is achieved when the lightwave test signal DOP is near 100%.

Wavelength accuracy and stability are important because the calibration factors in the 
Agilent 8509C are based upon accurately knowing the wavelength of the test signal. If the test 
signal’s true wavelength differs from the wavelength expected by the Agilent 8509C then 
measurement uncertainties will result. See item 4, Wavelength & Wavelength Calibration for more 
detail, or refer to the Calibration section of Chapter 6, “Using the System Menu”.

7.Temperature Stability 
of DUT and 
Environment

Accurate polarization measurements must be performed in a thermally stable environment. Changes 
in room temperature during a measurement will cause the ambient temperature of the instrument 
and the test device to drift. This will adversely affect measurement accuracy and repeatability until 
all temperature transients have stabilized once again. Conditions are stable if the output 
polarization drifts less than one degree per minute on the Poincare sphere. Test devices should be 
allowed to settle in temperature before measurements are started. Re-zero the Agilent 8509C if the 
temperature has changed.

8.Instrumentation 
Temperature Stability

Typically, one hour of test system warm-up time within a thermally stable environment is required. 
Re-zero the Agilent 8509C if the temperature changes.
7-6



Reference
Accuracy Enhancement and Troubleshooting

book.book  Page 7  Thursday, March 29, 2001  12:14 PM
9.Wavelength Step-
Size (Delta)

Wavelength step size, or Delta, or wavelength interval, is important to the two PMD measurement 
methods. In each case, error can result from a step size that is very large or very small. In the JME 
method, large step size can cause the measurement to produce alias results, and can limit the 
ability to resolve, or identify, the wavelength dependence of the DUT. In the WS method, large step 
size can result in missing certain peaks or valleys in the counting process. For both JME and WS 
methods, very small steps may be unnecessary and can introduce error (JME) and increase 
measurement time. See the JME and WS measurement application sections for more information.

10.Wavelength Span 
(Start, Stop)

Wavelength span affects both of the PMD measurement methods, particularly in the measurement 
of fiber PMD. For fiber PMD measurements, use the full wavelength range of the optical source. 
This will give the broadest possible exposure to the random polarization behavior of fiber PMD and 
provide the most statistically meaningful measurement.

In wavelength scanning measurements, choice of Analysis mode, under the Format menu, 
determines how the start and stop wavelengths for the wavelength scanning formula will be 
derived. This can dramatically influence accuracy in measurements of components and short fibers. 
See the discussion in “Using the wavelength-scanning method” on page 4-38.

11.Feature Size

Feature Size, located in the Format menu, affects the peak and valley count during an Agilent 8509C 
wavelength-scanning measurement. The value of the feature size determines whether a variation in 
a trace is ignored or counted as a peak or valley. This value can affect PMD results so much that it 
should be stated with measurement results in order to compare and repeat measurement data. 
Increase feature size if vibration or movement are causing false peaks in the wavelength-scanning 
response. Refer to “Using the wavelength-scanning method” on page 4-38.

12.Analysis Mode

Wavelength-scanning PMD measurement accuracy can be improved by using the analysis mode 
appropriate to the test device. This is why the Agilent 8509C offers four analysis modes. Refer to 
“Using the wavelength-scanning method” on page 4-38 for further information about Analysis 
Mode.

13.Mechanical 
Vibration

Mechanical vibration picked up by the measurement instrument or the DUT can degrade 
measurement accuracy. Differential motion between the instrument and DUT can also affect 
accuracy. Isolate the DUT as much as possible from fan vibrations, bumps and shocks. Use 
averaging to reduce the effects of unavoidable vibrations.

14.Polarization 
Reference Frame

The Agilent 8509C is equipped with the ability to mathematically remove the birefringence and PDL 
of the path between a reference polarizer and the Agilent 8509C polarization receiver using a 2pt 
(birefringence compensation only) or 3pt (birefringence and PDL compensation) polarization 
reference frame (PRF). Reference frames become invalid if this path moves during creation of the 
reference frame or during subsequent measurements. A polarization reference frame should not be 
applied for PMD measurements. Refer to “Making Polarization Reference Frame Measurements” on 
page 4-85 for further information about creating a PRF and deciding between a 2pt or 3pt PRF.

15.Mode Coupling 
Factor

The wavelength-scanning (WS) PMD measurement method uses the mode coupling factor in 
determining PMD from the measured curves. The value used relates to the degree of mode coupling 
in the DUT. For long fibers that are highly mode-coupled, use 0.82. For most components and non-
mode coupled devices, use 1.0. Refer to the discussions on mode coupling in Chapter 4, “Using the 
Measurement Menu” for more detail.
7-7



Reference
Accuracy Enhancement and Troubleshooting

book.book  Page 8  Thursday, March 29, 2001  12:14 PM
16.Fiber & Connector 
Type

Multimode fibers (MMF) and damaged single-mode fibers and connectors (SMF) cause a number of 
polarization measurement problems and should be replaced with high quality single-mode fibers 
and connectors.

MMF should not be used for polarization measurements because it supports a variety of spacial 
modes, each of which experiences a different delay and birefringence as it passes along the fiber. 
These multiple paths can depolarize the test signal is some cases. In MMF, the output polarization 
is not well defined nor uniquely related to fiber birefringence. This makes all polarization 
measurements extremely difficult in MMF.

Connectors may exhibit small values of PDL.

Damaged SMF and connectors attenuate optical power and may cause triple-travel reflections. See 
item 1, Connector Care/Reflections for details. Connectors should be properly-mating, physical 
contacting types with reflection level better than 40 dB.

17.Circular State of 
Polarization

For measurements involving the Jones matrix, it is recommended that the reference polarizers be 
supplied with circular states of polarization. This is in order to avoid low power points during linear 
polarizer adjustments. Information about confirming a circular state of polarization can be found in 
the measurement application sections.
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Generating of Right-Hand Circularly Polarized 
Light

An explicit coordinate system must be specified in order to unambiguously 
describe a state of polarization. For description of polarization, a conventional 
coordinate system is oriented so that the z axis is horizontally oriented in the 
direction of propagation of the light. The y axis is vertically oriented pointing 
up, and the x axis is horizontally oriented to form a right-handed rectangular 
coordinate system. Angles are measured referenced to the x axis, a positive 
angle indicating the sense of rotation from x toward y. 

The electric field vector of elliptically polarized light is said to rotate in either 
a right-hand sense or a left-hand sense, corresponding to either a positive or 
negative third normalized Stokes parameter, respectively. In the case of right-
hand circularly polarized light, at any instant in time the electric field of the 
wave is a function of z, and is described by a right-handed helix (like a screw 
thread). As this helix propagates through a fixed xy plane, the electric field 
vector in that plane rotates in a clockwise sense when viewed looking in the 
direction of propagation. 

Right-handed circularly polarized light can be generated by passing horizontal, 
linearly polarized light through a quarter-wave plate whose fast axis is ori-
ented at 45 degrees in the coordinate system described below. 
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Options and Accessories

Option Description

1CM Rack Mount Kit

1CN Front Handles

1CP Rack Mount Kit with Handles

Interface Connectors
The Agilent 8509C is shipped with FC/PC connectors (Option 012). To designate a different connector 
interface, order one of the following options.

011 Diamond HMS-10

012 FC/PC (shipped with instrument)

013 DIN 

014 ST

015 Biconic

017 SC
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Power Cords

Plug Type
Cable Part 
No.

Plug Description
Length
 (in/cm)

Color Country

250V 8120-1351

8120-1703

Straight *BS1363A

90°

90/228

90/228

Gray

Mint Gray

United Kingdom, 
Cyprus, Nigeria, 
Zimbabwe, 
Singapore

250V 8120-1369

8120-0696

Straight *NZSS198/
ASC

90°

79/200

87/221

Gray

Mint Gray

Australia, New 
Zealand

250V 8120-1689

8120-1692

Straight *CEE7-Y11

90°

79/200

79/200

Mint Gray

Mint Gray

East and West 
Europe, Saudi 
Arabia, So. Africa, I

125V 8120-1378

8120-1521

Straight *NEMA5-15P

90°

90/228

90/228

Jade Gray

Jade Gray

United States, 
Canada, Mexico, 
Philippines, Taiwan

250V 8120-2104

8120-2296

Straight *SEV1011

1959-24507

Type 12 90°

79/200

79/200

Mint Gray

Mint Gray

Switzerland

220V 8120-2956

8120-2957

Straight *DHCK107

90°

79/200

79/200

Mint Gray

Mint Gray

Denmark

250V 8120-4211

8120-4600

Straight SABS164

90°

79/200

79/200

Jade Gray Republic of South 
Africa

India

* Part number shown for plug is the industry identifier for the plug only. Number shown for 
cable is the Agilent part number for the complete cable including the plug.
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100V 8120-4753

8120-4754

Straight MITI

90°

90/230

90/230

Dark Gray Japan

Plug Type
Cable Part 
No.

Plug Description
Length
 (in/cm)

Color Country

* Part number shown for plug is the industry identifier for the plug only. Number shown for 
cable is the Agilent part number for the complete cable including the plug.
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Cleaning Connections for Accurate 
Measurements 

Today, advances in measurement capabilities make connectors and connec-
tion techniques more important than ever. Damage to the connectors on cali-
bration and verification devices, test ports, cables, and other devices can 
degrade measurement accuracy and damage instruments. Replacing a dam-
aged connector can cost thousands of dollars, not to mention lost time! This 
expense can be avoided by observing the simple precautions presented in this 
book. This book also contains a brief list of tips for caring for electrical connec-
tors.

Choosing the right connector

A critical but often overlooked factor in making a good lightwave measure-
ment is the selection of the fiber-optic connector. The differences in connec-
tor types are mainly in the mechanical assembly that holds the ferrule in 
position against another identical ferrule. Connectors also vary in the polish, 
curve, and concentricity of the core within the cladding. Mating one style of 
cable to another requires an adapter. Agilent Technologies offers adapters for 
most instruments to allow testing with many different cables. Figure 7-2 on 
page 7-15 shows the basic components of a typical connectors.

The system tolerance for reflection and insertion loss must be known when 
selecting a connector from the wide variety of currently available connectors. 
Some items to consider when selecting a connector are: 

• How much insertion loss can be allowed? 

• Will the connector need to make multiple connections? Some connectors are 
better than others, and some are very poor for making repeated connections. 

• What is the reflection tolerance? Can the system take reflection degradation? 

• Is an instrument-grade connector with a precision core alignment required? 

• Is repeatability tolerance for reflection and loss important? Do your specifica-
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tions take repeatability uncertainty into account? 

• Will a connector degrade the return loss too much, or will a fusion splice be re-
quired? For example, many DFB lasers cannot operate with reflections from 
connectors. Often as much as 90 dB isolation is needed.

Figure 7-2. Basic components of a connector

Over the last few years, the FC/PC style connector has emerged as the most 
popular connector for fiber-optic applications. While not the highest perform-
ing connector, it represents a good compromise between performance, reli-
ability, and cost. If properly maintained and cleaned, this connector can 
withstand many repeated connections.

However, many instrument specifications require tighter tolerances than most 
connectors, including the FC/PC style, can deliver. These instruments cannot 
tolerate connectors with the large non-concentricities of the fiber common 
with ceramic style ferrules. When tighter alignment is required, Agilent 
Technologies instruments typically use a connector such as the Diamond 
HMS-10, which has concentric tolerances within a few tenths of a micron. Agi-
lent Technologies then uses a special universal adapter, which allows other 
cable types to mate with this precision connector. See Figure 7-3.
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Figure 7-3. Universal adapters to Diamond HMS-10

The HMS-10 encases the fiber within a soft nickel silver (Cu/Ni/Zn) center 
which is surrounded by a tough tungsten carbide casing, as shown in 
Figure 7-4.

Figure 7-4. Cross-section of the Diamond HMS-10 connector

The nickel silver allows an active centering process that permits the glass fiber 
to be moved to the desired position. This process first stakes the soft nickel 
silver to fix the fiber in a near-center location, then uses a post-active staking 
to shift the fiber into the desired position within 0.2 µm. This process, plus the 
keyed axis, allows very precise core-to-core alignments. This connector is 
found on most Agilent Technologies lightwave instruments.

The soft core, while allowing precise centering, is also the chief liability of the 
connector. The soft material is easily damaged. Care must be taken to mini-
mize excessive scratching and wear. While minor wear is not a problem if the 
glass face is not affected, scratches or grit can cause the glass fiber to move 
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out of alignment. Also, if unkeyed connectors are used, the nickel silver can be 
pushed onto the glass surface. Scratches, fiber movement, or glass contamina-
tion will cause loss of signal and increased reflections, resulting in poor return 
loss.

Inspecting connectors

Because fiber-optic connectors are susceptible to damage that is not immedi-
ately obvious to the naked eye, poor measurements result without the user 
being aware. Microscopic examination and return loss measurements are the 
best way to ensure good measurements. Good cleaning practices can help 
ensure that optimum connector performance is maintained. With glass-to-
glass interfaces, any degradation of a ferrule or the end of the fiber, any stray 
particles, or finger oil can have a significant effect on connector performance. 
Where many repeat connections are required, use of a connector saver or 
patch cable is recommended.

Figure 7-5 shows the end of a clean fiber-optic cable. The dark circle in the 
center of the micrograph is the fiber’s 125 µm core and cladding which carries 
the light. The surrounding area is the soft nickel-silver ferrule. Figure 7-6 
shows a dirty fiber end from neglect or perhaps improper cleaning. Material is 
smeared and ground into the end of the fiber causing light scattering and poor 
reflection. Not only is the precision polish lost, but this action can grind off the 
glass face and destroy the connector.

Figure 7-7 shows physical damage to the glass fiber end caused by either 
repeated connections made without removing loose particles or using 
improper cleaning tools. When severe, the damage of one connector end can 
be transferred to another good connector endface that comes in contact with 
the damaged one. Periodic checks of fiber ends, and replacing connecting 
cables after many connections is a wise practice.

The cure for these problems is disciplined connector care as described in the 
following list and in “Cleaning connectors” on page 7-20. 

Use the following guidelines to achieve the best possible performance when 
making measurements on a fiber-optic system: 

• Never use metal or sharp objects to clean a connector and never scrape the 
connector.

• Avoid matching gel and oils. 
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Figure 7-5. Clean, problem-free fiber end and ferrule

Figure 7-6. Dirty fiber end and ferrule from poor cleaning

Figure 7-7. Damage from improper cleaning

While these often work well on first insertion, they are great dirt magnets. The 
oil or gel grabs and holds grit that is then ground into the end of the fiber. 
Also, some early gels were designed for use with the FC, non-contacting con-
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nectors, using small glass spheres. When used with contacting connectors, 
these glass balls can scratch and pit the fiber. If an index matching gel or oil 
must be used, apply it to a freshly cleaned connector, make the measurement, 
and then immediately clean it off. Never use a gel for longer-term connections 
and never use it to improve a damaged connector. The gel can mask the extent 
of damage and continued use of a damaged fiber can transfer damage to the 
instrument.

• When inserting a fiber-optic cable into a connector, gently insert it in as 
straight a line as possible. Tipping and inserting at an angle can scrape material 
off the inside of the connector or even break the inside sleeve of connectors 
made with ceramic material.

• When inserting a fiber-optic connector into a connector, make sure that the fi-
ber end does not touch the outside of the mating connector or adapter. 

• Avoid over tightening connections. 

Unlike common electrical connections, tighter is not better. The purpose of 
the connector is to bring two fiber ends together. Once they touch, tightening 
only causes a greater force to be applied to the delicate fibers. With connec-
tors that have a convex fiber end, the end can be pushed off-axis resulting in 
misalignment and excessive return loss. Many measurements are actually 
improved by backing off the connector pressure. Also, if a piece of grit does 
happen to get by the cleaning procedure, the tighter connection is more likely 
to damage the glass. Tighten the connectors just until the two fibers touch.

• Keep connectors covered when not in use. 

• Use fusion splices on the more permanent critical nodes. Choose the best con-
nector possible. Replace connecting cables regularly. Frequently measure the 
return loss of the connector to check for degradation, and clean every connec-
tor, every time.

All connectors should be treated like the high-quality lens of a good camera. 
The weak link in instrument and system reliability is often the inappropriate 
use and care of the connector. Because current connectors are so easy to use, 
there tends to be reduced vigilance in connector care and cleaning. It takes 
only one missed cleaning for a piece of grit to permanently damage the glass 
and ruin the connector.

Measuring insertion loss and return loss

Consistent measurements with your lightwave equipment are a good indica-
tion that you have good connections. Since return loss and insertion loss are 
key factors in determining optical connector performance they can be used to 
determine connector degradation. A smooth, polished fiber end should pro-
7-19



Reference
Cleaning Connections for Accurate Measurements

book.book  Page 20  Thursday, March 29, 2001  12:14 PM
duce a good return-loss measurement. The quality of the polish establishes 
the difference between the “PC” (physical contact) and the “Super PC” con-
nectors. Most connectors today are physical contact which make glass-to-glass 
connections, therefore it is critical that the area around the glass core be clean 
and free of scratches. Although the major area of a connector, excluding the 
glass, may show scratches and wear, if the glass has maintained its polished 
smoothness, the connector can still provide a good low level return loss con-
nection.

If you test your cables and accessories for insertion loss and return loss upon 
receipt, and retain the measured data for comparison, you will be able to tell in 
the future if any degradation has occurred. Typical values are less than 0.5 dB 
of loss, and sometimes as little as 0.1 dB of loss with high performance con-
nectors. Return loss is a measure of reflection: the less reflection the better 
(the larger the return loss, the smaller the reflection). The best physically 
contacting connectors have return losses better than 50 dB, although 30 to 
40 dB is more common.

Visual inspection of fiber ends

Visual inspection of fiber ends can be helpful. Contamination or imperfections 
on the cable end face can be detected as well as cracks or chips in the fiber 
itself. Use a microscope (100X to 200X magnification) to inspect the entire 
end face for contamination, raised metal, or dents in the metal as well as any 
other imperfections. Inspect the fiber for cracks and chips. Visible imperfec-
tions not touching the fiber core may not affect performance (unless the 
imperfections keep the fibers from contacting).

W A R N I N G Always remove both ends of fiber-optic cables from any instrument, 

system, or device before visually inspecting the fiber ends. Disable all 

optical sources before disconnecting fiber-optic cables. Failure to do 

so may result in permanent injury to your eyes.

Cleaning connectors

The procedures in this section provide the proper steps for cleaning fiber-
optic cables and Agilent Technologies universal adapters. The initial cleaning, 
using the alcohol as a solvent, gently removes any grit and oil. If a caked-on 
layer of material is still present, (this can happen if the beryllium-copper sides 
of the ferrule retainer get scraped and deposited on the end of the fiber during 
insertion of the cable), a second cleaning should be performed. It is not 
uncommon for a cable or connector to require more than one cleaning.
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C A U T I O N Agilent Technologies strongly recommends that index matching compounds 
not be applied to their instruments and accessories. Some compounds, such as 
gels, may be difficult to remove and can contain damaging particulates. If you 
think the use of such compounds is necessary, refer to the compound 
manufacturer for information on application and cleaning procedures.

To clean a non-lensed connector 

C A U T I O N Do not use any type of foam swab to clean optical fiber ends. Foam swabs can 
leave filmy deposits on fiber ends that can degrade performance. 

1 Apply pure isopropyl alcohol to a clean lint-free cotton swab or lens paper. 

Cotton swabs can be used as long as no cotton fibers remain on the fiber end 
after cleaning. 

2 Clean the ferrules and other parts of the connector while avoiding the end of 
the fiber.

3 Apply isopropyl alcohol to a new clean lint-free cotton swab or lens paper. 

4 Clean the fiber end with the swab or lens paper. 

Do not scrub during this initial cleaning because grit can be caught in the 
swab and become a gouging element. 

Table 7-1. Cleaning Accessories 

Item  Agilent Part Number

Cotton swabs 8520-0023

Small foam swabs 9300-1223

Table 7-2. Dust Caps Provided with Lightwave Instruments 

Item  Agilent Part Number

Laser shutter cap 08145-64521

FC/PC dust cap 08154-44102

Biconic dust cap 08154-44105
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5 Immediately dry the fiber end with a clean, dry, lint-free cotton swab or lens 
paper. 

6 Blow across the connector end face from a distance of 6 to 8 inches using 
filtered, dry, compressed air. Aim the compressed air at a shallow angle to the 
fiber end face. 

Nitrogen gas or compressed dust remover can also be used. 

C A U T I O N Do not shake, tip, or invert compressed air canisters, because this releases 
particles in the can into the air. Refer to instructions provided on the 
compressed air canister. 

7 As soon as the connector is dry, connect or cover it for later use. 

If the performance, after the initial cleaning, seems poor try cleaning the con-
nector again. Often a second cleaning will restore proper performance. The 
second cleaning should be more arduous with a scrubbing action.

To clean an adapter 

The fiber-optic input and output connectors on many Agilent Technologies 
instruments employ a universal adapter such as those shown in the following 
picture. These adapters allow you to connect the instrument to different types 
of fiber-optic cables.

Figure 7-8. Universal adapters

1 Apply isopropyl alcohol to a clean foam swab. 

Cotton swabs can be used as long as no cotton fibers remain after cleaning. The 
foam swabs listed in this section’s introduction are small enough to fit into 
adapters. 

Although foam swabs can leave filmy deposits, these deposits are very thin, and 
the risk of other contamination buildup on the inside of adapters greatly out-
weighs the risk of contamination by foam swabs. 

2 Clean the adapter with the foam swab. 

3 Dry the inside of the adapter with a clean, dry, foam swab. 
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4 Blow through the adapter using filtered, dry, compressed air. 

Nitrogen gas or compressed dust remover can also be used. Do not shake, tip, 
or invert compressed air canisters, because this releases particles in the can 
into the air. Refer to instructions provided on the compressed air canister.
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If You Have a Problem

This section will help correct problems that may be encountered while per-
forming the installation and operation verification. The problem or symptom is 
listed at the top of each page. Most problems have a brief description or expla-
nation to provide additional information regarding the problem. Following is a 
checklist of items that could cause the problems. Using the checklist of possi-
ble solutions will help to correct the problem. 

Problems requiring additional resources 

Problems that are internal to the lightwave polarization analyzer will require 
additional technical information. Contact an Agilent Technologies sales or ser-
vice office if you cannot solve your problem with the information in this chap-
ter. Refer to “Agilent Technologies Service Offices” on page 7-30. For 
instructions for returning your instrument to Agilent Technologies, refer to 
“Returning the Instrument for Service” on page 7-27. 

The system appears to be dead 

When the instrument controller, monitor and lightwave polarization analyzer 
are initially turned on, the following observations can be made: 

• The instrument controller’s fan and disk drive will make a certain amount of 
noise when the instrument controller is turned on. 

• The monitor has an indicator light on the power button that should light up 
when the monitor is turned on. 

If these things do not occur, check the following conditions: 

� That the instrument controller, monitor and analyzer are all connected to the 
ac power source. 

� Check the line voltage selector switch on the rear of the Agilent 8509C to en-
sure that it is set to the correct voltage for the power source. Refer to 
Figure 1-1 on page 1-5 for instructions on setting the switch. 

� Check the line fuse on the lightwave polarization analyzer to ensure that it is 
not damaged. The fuse is located inside the power-cord receptacle housing on 
the rear panel of the analyzer. Refer to “Fuses” on page 1-4 for replacement 
part numbers. Refer to Figure 1-1 on page 1-5 for exact location of fuse. 
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If the instrument controller does not respond 

The mouse and keyboard cable connectors look the same and therefore may 
accidentally be interchanged on the back of the instrument controller. If this 
happens, the instrument controller will not respond to the mouse or the key-
board, and you may hear lots of beeping when trying to use one or the other. 

If you have any of these problems check the following: 

� Make sure that the mouse and keyboard are plugged into the correct sockets 
on the back of the instrument controller. There are icons on the instrument 
controller rear panel and on the mouse and keyboard connectors to help you 
determine the correct socket. (Refer to Figure 1-4 on page 1-9 for the exact lo-
cation of mouse and keyboard ports.) 

� Make sure that the mouse and keyboard cables are plugged in all the way and 
that a good connection is being made. 

If you get the “EEprom not formatted or Box on?” error message 

When you start up the software, the program expects the lightwave polariza-
tion analyzer to be turned on and connected to the instrument controller via 
the dedicated interface cable. This error message occurs when it appears to 
the instrument controller that the lightwave polarization analyzer is not con-
nected or turned on. 

If you see the error message, check the following conditions: 

� Ensure that the lightwave polarization analyzer voltage selector switch is prop-
erly set, that it is connected to the ac power source, and that line switch has 
been turned on. (Refer to Figure 1-1 on page 1-5 for instructions on setting the 
voltage selector switch.) 

� Ensure that the dedicated interface cable is properly connected to both the 
lightwave polarization analyzer and the instrument controller. Be sure to finger 
tighten the screws on the connectors. 

If operation verification fails 

DOP measurement is out of specification 

If you are able to detect power after connecting an optical source to the light-
wave polarization analyzer’s OPTICAL INPUT (look at the power display in the 
upper-left corner of the measurement screen), but the DOP measurement is 
out of specification, there is a good chance that dirty or improperly seated 
connectors are at fault. 

If you are detecting power but your measurements are out of specification, 
check the following: 

� Ensure the connectors are clean. Use isopropyl alcohol and cotton swabs to 
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clean optical connectors. For detailed instructions, and cleaning supply part 
numbers, refer to refer to “Cleaning Connections for Accurate Measurements” 
on page 7-14. 

� Ensure that the optical connections are properly seated and finger tightened. 

� If the operation verification still fails, perform and apply a calibration for the 
particular source and wavelength you are using to make the measurements. Re-
fer to “Using the Calibration functions” on page 6-6. 

� If the operation verification still fails, contact Agilent Technologies. Refer to 
“Agilent Technologies Service Offices” on page 7-30. 

Power display reads underrange 

If, after connecting power to the OPTICAL INPUT the power display reads under-
range, the problem may be more severe. 

Check the following: 

� If you are using an external source, ensure that the source is turned on.

� If the source is turned on and the power display still reads underrange, contact 
Agilent Technologies. Refer to “Agilent Technologies Service Offices” on 
page 7-30.
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Returning the Instrument for Service 

The instructions in this section show you how to properly return the instru-
ment for repair or calibration. Always call the Agilent Technologies Instrument 
Support Center first to initiate service before returning your instrument to a 
service office. This ensures that the repair (or calibration) can be properly 
tracked and that your instrument will be returned to you as quickly as possi-
ble. Call this number regardless of where you are located. Refer to “Agilent 
Technologies Service Offices” on page 7-30 for a list of service offices. 

Agilent Technologies Instrument Support Center. . . . . . . . . . . (800) 403-0801

If the instrument is still under warranty or is covered by an Agilent Technolo-
gies maintenance contract, it will be repaired under the terms of the warranty 
or contract (the warranty is at the front of this manual). If the instrument is 
no longer under warranty or is not covered by an Agilent Technologies mainte-
nance plan, Agilent Technologies will notify you of the cost of the repair after 
examining the unit.

When an instrument is returned to a Agilent Technologies service office for 
servicing, it must be adequately packaged and have a complete description of 
the failure symptoms attached. When describing the failure, please be as spe-
cific as possible about the nature of the problem. Include copies of additional 
failure information (such as the instrument failure settings, data related to 
instrument failure, and error messages) along with the instrument being 
returned. 
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Preparing the instrument for shipping 

1 Write a complete description of the failure and attach it to the instrument. 
Include any specific performance details related to the problem. The following 
information should be returned with the instrument. 

• Type of service required. 
• Date instrument was returned for repair. 
• Description of the problem: 

• Whether problem is constant or intermittent. 
• Whether instrument is temperature-sensitive. 
• Whether instrument is vibration-sensitive. 
• Instrument settings required to reproduce the problem. 
• Performance data. 

• Company name and return address. 
• Name and phone number of technical contact person. 
• Model number of returned instrument. 
• Full serial number of returned instrument. 
• List of any accessories returned with instrument. 

2 Cover all front or rear-panel connectors that were originally covered when you 
first received the instrument.

C A U T I O N Cover electrical connectors to protect sensitive components from electrostatic 
damage. Cover optical connectors to protect them from damage due to physical 
contact or dust.

C A U T I O N Instrument damage can result from using packaging materials other than the 
original materials. Never use styrene pellets as packaging material. They do not 
adequately cushion the instrument or prevent it from shifting in the carton. 
They may also cause instrument damage by generating static electricity. 

3 Pack the instrument in the original shipping containers. Original materials are 
available through any Agilent Technologies office. Or, use the following 
guidelines:

• Wrap the instrument in antistatic plastic to reduce the possibility of damage 
caused by electrostatic discharge. 

• For instruments weighing less than 54 kg (120 lb), use a double-walled, cor-
rugated cardboard carton of 159 kg (350 lb) test strength. 

• The carton must be large enough to allow approximately 7 cm (3 inches) on 
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all sides of the instrument for packing material, and strong enough to accom-
modate the weight of the instrument. 

• Surround the equipment with approximately 7 cm (3 inches) of packing ma-
terial, to protect the instrument and prevent it from moving in the carton. If 
packing foam is not available, the best alternative is S.D-240 Air Cap™ from 
Sealed Air Corporation (Commerce, California 90001). Air Cap looks like a 
plastic sheet filled with air bubbles. Use the pink (antistatic) Air Cap™ to 
reduce static electricity. Wrapping the instrument several times in this ma-
terial will protect the instrument and prevent it from moving in the carton. 

4 Seal the carton with strong nylon adhesive tape. 

5 Mark the carton “FRAGILE, HANDLE WITH CARE”. 

6 Retain copies of all shipping papers. 
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Agilent Technologies Service Offices
Before returning an instrument for service, call the Agilent Technologies 
Instrument Support Center at (800) 403-0801, visit the Test and Measurement 
Web Sites by Country page at http://www.tm.agilent.com/tmo/country/English/
index.html, or call one of the numbers listed below.

Agilent Technologies Service Numbers

Austria 01/25125-7171

Belgium 32-2-778.37.71

Brazil (11) 7297-8600

China 86 10 6261 3819

Denmark 45 99 12 88

Finland 358-10-855-2360

France 01.69.82.66.66

Germany 0180/524-6330

India 080-34 35788

Italy +39 02 9212 2701

Ireland 01 615 8222

Japan (81)-426-56-7832

Korea 82/2-3770-0419

Mexico (5) 258-4826

Netherlands 020-547 6463

Norway 22 73 57 59

Russia +7-095-797-3930

Spain (34/91) 631 1213

Sweden 08-5064 8700

Switzerland (01) 735 7200

United Kingdom 01 344 366666

United States and Canada (800) 403-0801
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HPIB Overview

HPIB (the Hewlett-Packard Interface Bus) is a high-performance bus that 
allows individual instruments and computers to be combined into integrated 
test systems. The bus and its associated interface operations are defined by 
the IEEE 488.1 standard. The IEEE 488.1 standard defines the interface capa-
bilities of the instruments and controllers in a measurement system, including 
some frequently used commands.

HPIB cables provide the physical ink between devices on the bus. There are 
eight data lines on each cable that are used to send data from one device to 
another. Devices that send data over these lines are called Talkers. Listeners 
are devices that receive data over the same lines. There are also five control 
lines on each cable that are used to manage traffic on the data lines and con-
trol other interface operations. Controllers are devices that use these control 
lines to specify the talker and listener in a data exchange.

When an HPIB system contains more than one device with controller capabili-
ties, only one of the devices is allowed to control data exchanges is called the 
Active Controller. Also, only one of the controller-capable devices can be des-
ignated as the system controller. The Agilent 8509 can function as a talker, a 
listener, or a controller at different times.

Bus Structure

HPIB addresses provide a way to identify devices on the bus. The active con-
troller uses HPIB addresses to specify which device talks and which device lis-
tens during a data exchange. This means that each device’s address must be 
unique. A device’s address is set on the device itself, using either a front-panel 
key sequence or a rear-panel switch. The factory default address for the 
Agilent 8509 is 29.
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Data Bus

The data bus consists of eight lines that are used to transfer data from one 
device to another. Programming commands and data sent on these lines is typ-
ically encoded in the ASCII format, although binary encoding is often used to 
speed up the transfer of large arrays. Only ASCII format is available to the 
Agilent 8509. In addition, every byte transferred over HPIB undergoes a hand-
shake to ensure valid data.

Handshake Lines

A three-line handshake scheme coordinates the transfer of data between 
talker and listeners. This technique forces data transfers to occur at the speed 
of the slowest device, and ensures data integrity in multiple listener transfers. 
With most computing controllers and instruments, the handshake is per-
formed automatically, which makes it transparent to the programmer.

Control Lines

The data bus also has five control lines that the controller uses both to send 
bus commands and to address devices. The Agilent 8509 makes explicit use of 
the EOI line through the HPIB END statement used to terminate all command 
transmissions. A brief description of the five HPIB control lines is provided 
below.

• IFC (Interface Clear). Only the system controller uses this line. When 
this line is true (low) all devices (addressed or not) not addressed and go to 
an idle state.

• ATN (Attention). This active controller uses this line to define whether 
the information on the data bus is a command or is data. When this line is 
true (low) the bus is in the command mode and the data lines carry bus com-
mands. When this line is false (high) the bus is in the data mode and the data 
lines carry device-dependent instructions or data.

• SRQ (Service Request). This line is set true (low) when a device requests 
service; the active controller services the requesting device.

• REN (Remote enable). Only the system controller used this line. When 
this line is set true (low) the bus is in the remote mode and devices are ad-
dressed either to listen or talk. When the bus is in remote and a device is ad-
dressed, it receives instructions from HPIB rather than from its front panel. 
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When this line is set false (high) the bus and all devices return to local op-
eration.

• EOI (End or Identify). This line is used by a talker to indicate the last data 
byte in a multiple byte transmission, or by an active controller to initiate a 
parallel poll sequence. The analyzer recognizes the EOI line as a terminator 
and it pulls the EOI line with the last byte of a message output (data, mark-
ers, plots, prints, error messages).

Sending Commands

Commands are sent over the HPIB via a controller’s language system, such as 
IBASIC, QuickBasic, or C. The keywords used by a controller to send HPIB 
commands vary among systems. When determining the correct keywords to 
use, keep in mind that there are two different kinds of HPIB commands:

• Bus management commands, which control the HPIB interface

• Device commands, which control analyzer functions.

Language systems usually deal differently with these two kinds of HPIB com-
mands. For example, for most HP instrumentation, HP BASIC can use a 
unique keyword to send each bus management command, but always uses the 
keyword OUTPUT to send device commands. It must be noted, however, that 
for the Agilent 8509, all commands must be sent using the OUTPUT state-
ment.

The following example shows how to send a typical device command in 
IBASIC:

OUTPUT 729; “POINCARE:CLEAR” END

This sends the command within the quotes (POINCARE:CLEAR) to the HPIB 
device at address 729. If the device is an Agilent 8509, the command instructs 
the analyzer to clear all measured traces from the Poincare sphere.

Note: The HPIB care select code is 7 and the HPIB address is 29. The select 
code is set by adjusting switches on the HPIB card inside the computer.
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HPIB for the Agilent 8509

The Agilent 8509 system can be described as a Windows application, running 
on an instrument controller, which controls an external instrument containing 
the system hardware. The system hardware consists of all devices required by 
the Agilent 8509 software to conduct polarization measurements. Remote 
control of the Agilent 8509 system is achieved through direct communication 
with the system’s Windows application software. Use an external controller for 
remote control of the Agilent 8509.

Given that the Agilent 8509 software is a Windows application, Dynamic Data 
Exchange (DDE) can be used to communicate with and control the Agilent 
8509 system. DDE is a “standard” communication technique which is provided 
by a majority of Windows applications. In effect, in order to remotely commu-
nicate via HPIB with the Agilent 8509 system, HPIB messages must be trans-
lated to DDE messages. Under these conditions, the HPIB interface is seen as 
a Windows application directly communicating with the Agilent 8509 system 
software.

A second Windows application called HPIB2DDE provides the translation 
between HPIB commands and the DDE message for the Agilent 8509 soft-
ware. The HPIB2DDE program is accessible within the Agilent 8509 system 
window. In order to run HPIB2DDE, an HPIB interface board must be installed 
on the Agilent 8509 system instrument controller and configured for running 
under Microsoft Windows. The external PC controller running IBASIC must 
also have an HPIB interface board configured for running under Microsoft 
Windows. The instrument controller can send HPIB messages directly to the 
Agilent 8509 system and to other HPIB controllable instruments. The current 
version of HPIB2DDE assumes, as a default, that the HPIB select code of the 
Agilent 8509 system is 7 and that the HPIB board address is set to 29.

Note: When receiving HPIB commands, the Agilent 8509 does not lock out 
manual operation. Take care not to disrupt remote control through manual 
command execution. Furthermore, HPIB commands which lock out manual 
operations are not currently available for remote control of the Agilent 8509. 
When beginning remote operation of the Agilent 8509, be sure to quit, then 
restart the application if there has been any manual operation of the Agilent 
8509 during the current session of the Agilent 8509 application.
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HPIB to DDE Interface

The Agilent 8509C Lightwave Polarization Analyzer uses Dynamic Data 
Exchange (DDE) for remote operation. The HPIB2DDE.EXE application con-
nects the DDE system to the HPIB bus. Therefore, it is required to run this 
application before attempting remote operation of the Agilent 8509 using 
HPIB. To start the HPIB2DDE.EXE application, select the HPIB to DDE Gate-
way icon in the Agilent 8509 Group.

There are three basic parts to this window, the Agilent 8509 Control frame, 
the ‘HPIB’ frame, and the Dynamic Data Exchange (DDE) frame. The 
HPIB2DDE.EXE application window appears when the application starts. The 
HPIB to DDE Gateway is a floating window when the program starts. This 
means that the window will always appear on top of any other window. To 
defeat this feature, minimize the window by clicking once on the down arrow 
in the top right corner. When the application is restored by double clicking on 
its icon, the window will no longer float.
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‘Command Line’ Setup Options

The HIPB gateway program may be configured using command line parame-
ters at run time. Two command line parameters are available and may be 
added to the HPIB gateway icon’s properties. This selection can be found by 
highlighting the icon by clicking once on it, then selecting File > Properties in 
the Windows Program Manager. Add the command line parameter after the 
name of the program in the Command Line text box.

/Errors Only

Add this command line parameter to configure the HPIB gateway to record 
only HPIB bus errors, DDE link errors, Windows critical errors, and Agilent 
8509 commands which did not return a status of PASS, when Log On is 
checked. If this parameter is not specified, all bus transactions, including 
errors, are recorded in the log file. During program execution this feature may 
be turned on and off by clicking the right mouse button on the Log On check 
box.

/HP8509=<Name>

The Windows DDE system uses the name of the executable file to establish a 
DDE link to the Agilent 8509 program. Future versions of the Agilent 8509 
may use a different name to establish this link. This command line parameter 
is useful only if your Agilent 8509 software is updated to a version greater than 
version 2.0. If this parameter is not used, the <Name> used is HP8509_2.

Note: Agilent 8509C command is A8509.

/HP8509TimeOut=<Number of Minutes>

This parameter specifies the number of minutes the HPIB to DDE Gateway 
program should wait for data from the Agilent 8509 when the HPIB controller 
requests data (sends a query). If this parameter is not specified, the default 
value used is 1 minute. If the Agilent 8509 takes longer than the specified time 
to return data to the HPIB controller, the HPIB to DDE Gateway will reset the 
DDE channel in an attempt clear the problem, and record the attempt in the 
log file (if open) as a DDE time-out error. The HPIB to DDE Gateway will reset 
itself in this manner ten times. After ten attempts, the HPIB to DDE Gateway 
program will issue a critical error and HPIB operation will stop until the user 
acknowledges the critical error issued by the HPIB to DDE Gateway.
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Note: This time-out occurs only when the HPIB controller requests data. The 
HPIB to DDE Gateway queues all commands from the HPIB bus a synchro-
nous to Agilent 8509 operation. The programmer should hard code appropri-
ate delays in the controlling program after sending Agilent 8509 commands 
that take more than 30 seconds (or 1/2 the time-out limit) to complete. 
Remember - commands may still be in the HPIB to DDE Gateway command 
queue when the controlling program requests data. The execution time to 
complete the commands still in the queue may exceed the time-out limit.

Agilent 8509 Control Frame

The elements in this frame provide a path for the development of HPIB 
remote programs. With the HPIB to DDE Gateway, you can send HPIB com-
mands, retrieve data, and save bus traffic to a file for later analysis. The ele-
ments of the Agilent 8509 Control Window are described below.

Agilent 8509 Status shows the status of the current DDE operation. Valid 
choices are:

• PASS: the remote command successfully completed.

• FAIL: the remote command failed and did not complete.

• PROBLEMS: the remote command experienced a problem during execus-
tion.

• UNKNOWN: the remote command was not recognized.

• BUSY: the remote command is in the process of execution.

• NO DDE LINK: the DDE link is not established.

List is a list of all the DDE commands. This list drops down to select a com-
mand for the Command test box. This list box is loaded by reading in the file 
DDE_CMD.TXT located in the application directory.

Command text box is used to specify a command to send via DDE to the Agi-
lent 8509 application. During normal operation of the HPIB to DDE Gateway, 
the individual commands that are being transmitted to the Agilent 8509 also 
appear in this text box.

Log On when checked, HPIB bus transactions are recorded to the file 
selected with Pick File, and the Pick File button is disabled. The /ErrorsOnly 
feature may be turned on and off by clicking the right mouse button on the 
Log On check box.
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Pick File selects a file for logging HPIB bus transactions. this button is dis-
abled when Log On is selected. This filename is saved in the file C:\Win-
dows\WIN.INI under the heading HPIB2DDE and is restored the next time the 
HPIB2DDE application is started.

Execute Cmd sends the command in the Command text box via DDE to the 
Agilent 8509 application.

Get Data retrieves data via DDE from the Agilent 8509 application. The data 
is linked to the text boxes found in the Dynamic Data Exchange (DDE) win-
dow.

Exit closes the HPIB2DDE gateway application.

HPIB Frame

This frame provides you with an interface to the HPIB bus parameters. The 
elements of the HPIB window are described below.

To LPA shows the user the command being sent to the Agilent 8509 that was 
received on the HPIB bus.

To HPIB shows the user the data being sent to the HPIB bus that was read 
from the Agilent 8509.

Status shows the HPIB card status and the time and date of any error. HPIB 
bus errors, DDE errors, and Windows system errors are also logged to file 
when Log On is selected.

EOL is selected is every HPIB bus action is to end with a line feed. This set-
ting is saved in the file C:\WINDOW\WIN.INI under the heading HPIB2DDE 
and is restored to this setting the next time the HPIB2DDE application is 
started.

Address puts the address of the Agilent 8509 here. To change the address, 
select Terminate DDE Link to enable Address. Change the Agilent 8509 device 
address then select Initiate DDE Link to re-enable the HPIB bus and the DDE 
link. Terminate DDE Link and Initiate DDE Link are toggle selections.

This setting is saved in the file C:\WINDOWS\WIN.INI under the heading 
HPIB2DDE and is restored to this setting the next time the HPIB2DDE appli-
cation is started.

Timeout allows you to set the HPIB time-out. This setting is saved in the file 
C:\WINDOW\WIN.INI under the heading HPIB2DDE and is restored to this 
setting the next time the HPIB2DDE application is started.
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Data Separator is saved in the file C:\WINDOW\WIN.INI under the heading 
HPIB2DDE and is restored to this setting the next time the HPIB2DDE appli-
cation is started.

Cr/Lf sets the data separator to carriage return/line feed delimited.

Comma sets the data separator to comma delimited.

HPIB Exit State allows you to set the HPIB card to Controller or Non-Con-
troller when the program exits. This setting is saved in the file C:\WIN-
DOW\WIN.INI under the heading HPIB2DDE and is restored to this setting the 
next time the HPIB2DDE application is started.

Controller (HPIB card) is the setting used when the Agilent 8509 is not 
being controlled by the HPIB bus. Other systems may require that the HPIB 
card never becomes a controller while on the HPIB bus.

Non-Controller (HPIB card) is while the HPIB to DDE gateway application 
is running.

Dynamic Data Exchange (DDE) Frame

This frame is used to display data that is being transmitted via DDE to the 
HPIB to DDE Gateway application. The elements of this frame are described 
below.

• Pyrex) from Agilent 8509 is used to establish a DDE link for data from 
the Agilent 8509 and the HPIB2DDE.EXE application.

• Terminate DDE Link/Initiate DDE Link is used to connect or discon-
nect the HIPB to the DDE. When the DDE link is established (selection 
shows Terminate DDE Link, the HPIB card is opened and the DDE transac-
tions can take place. When there is no DDE link (selection shows Initiate 
DDE Link, the Agilent 8509 Status selection show NO DDE LINK in yellow 
and the HPIB card is closed and the device address may be changed. Click-
ing the right mouse button on this command button while in Terminate Link 
mode will cause only the HPIB bus to close, and allow the HIPB gateway to 
be used for a DDE client, without interference from the HIPB bus.
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Given the translation mode under which HPIB control is achieved for the Agi-
lent 8509 system, certain constraints exist dictated by the HIPB2DDE applica-
tion. The constraints are relative to the full set of capabilities provided by the 
HPIB interface. The constraints are listed below.

• Data is transmitted and received as ASCII strings. In other words, only for-
matted data transfers are possible.

• EOI is used to indicate the completion of data transmission. The EOI can be 
set by using an HIPB END statement to terminate the sending of a com-
mand.

• EOL (default <cr><lf>) is NOT used by default. This can be toggled from the 
HPIB2DDE application window and will stay at the last setting. EOL should 
be toggled on for HPIB control through an external PC controller running 
IBASIC for Windows. EOL stands for End of Line and refers to a string which 
defines the end of a command line when an OUTPUT statement is sent. The 
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HPIB END statement serves as the line terminator.

• Use only ENTER/OUTPUT (formatted data transfers).

• Set the time-out to a least five seconds to give the instrument controller time 
to recognize and respond to HPIB activity. The HPIB2DDE is polling the 
HPIB card and needs time to see the request.

It is important to note that the Agilent 8509 utilizes only a subset of the HPIB 
bus capabilities. Only two HPIB bus management commands are supported by 
the current Agilent 8509 system. These are *OPC? and *IDN?. Other bus man-
agement commands, commonly supported by Agilent instrumentation, are not 
available for the remote control of the Agilent 8509.

When receiving HPIB commands, the Agilent 8509 does not lock out manual 
operation. The user must take care not to disrupt remote control through 
manual command execution. Furthermore, HPIB commands which lock out 
manual operations are not currently available for remote control of the Agilent 
8509. When beginning remote operation of the Agilent 8509, quit, then restart 
the application if there has been any manual operation of the Agilent 8509 
during the current session of the Agilent 8509 application.

A second alternative for remote control of the Agilent 8509, other than using 
an external PC controller, is to use an Agilent 9000 series 200/300 controller 
running HP BASIC Version 5.0 or later. The platform is the same as that shown 
in Figure 4-2, except that the PC controller is replaced by an Agilent 9000 
series 200/300 controller. The Agilent 8509 system can be thought of as just 
another instrument on the HPIB bus.

IBASIC syntax is fully compatible with HP BASIC syntax. In effect, the same 
syntax can be used to create both IBASIC and HP BASIC programs. However, 
the user should be aware that IBASIC and HP BASIC file formats differ. IBA-
SIC files are usually created in DOS text format, while HP BASIC files are cre-
ated in LIF format. In effect, a program created in IBASIC will not directly run 
under HP BASIC though the same syntax can be utilized under HP BASIC to 
create a program with identical functionalit7y. Utilities exist under the UNIX 
operating system to translate DOS formatted files to LIF format and vice 
versa.

Basic Instrument Control

A computer controls the Agilent 8509 by sending it commands over HPIB. The 
command sent are specific to the Agilent 8509. Each command is executed 
automatically upon receipt. During remote control, the analyzer is receptive to 
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manual control. The user must take care not to disrupt remote operations. 
Most commands are equivalent to front panel functions. For example, after 
preparing the system for HPIB control, type:

OUTPUT 729; “POINCARE: CLEAR” END

on the alpha command line and execute by clicking the Run button on the 
IBASIC control pad.

The Poincare sphere on the Agilent 8509 display is now cleared from all mea-
surement traces and measurement continues at the current state of polariza-
tion. The construction of the command is:

The POINCARE:CLEAR command performs the same function as selecting 
the DISPLAY menu and within that menu selecting the CLEAR SPHERE 
option. As can be noted, the command mnemonic CLEAR is derived from the 
menu option for equivalent manual control. Most of the Agilent 8509 HPIB 
commands, where possible, are derived from the equivalent menu option 
label. Otherwise, they are derived from the common name for the function.

As can be noted from the example above, the Agilent 8509 command syntax is 
in the form of COMMAND:P1:P2:P3...where P1:P2:P3... are the parameters 
pertaining to the command and the number of parameters depends on the 
function performed by the command. If, for example, the function of the com-
mand is to perform a type of measurement, the number of required parame-
ters will vary with measurement process complexity. Please refer to the 
Agilent 8509 Command Reference section of this document or to the Remote 
Access files in the Agilent 8509 instrument window for specific command 
information.

The END following the CLEAR terminates the command inside the Agilent 
8509 (EOI set true) and prepares the Agilent 8509 for the next command. If 
there is a syntax error in the command, the Agilent 8509 will ignore the com-
mand nd look for the next terminator. When it is found, incoming commands 
process normally. Characters between the syntax error and the next termina-
tor are lost.

OUTPUT 729; The BASIC data output statement. The data is directed to interface 
7 (HPIB), and on out to the device address 29 (the Agilent 8509).

“POINCARE:
CLEAR” END

The Agilent 8509 mnemonic for clearing the Poincare sphere. The 
mnemonic, less the quotation marks, is sent literally by the OUTPUT 
statement, followed by the terminating END statement.
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The OUTPUT 729; statement will transmit one item at a time when a terminat-
ing END is used. It will transmit literal information enclosed in quotes, 
numeric variables, and string variables. Without the END, a carriage return, 
line feed is transmitted after each item. This is suppressed by terminating the 
command with an END statement.

Setting a display state is just one form of command the Agilent 8509 will 
accept. It will also accept commands that require specific, user defined oper-
ands. For example, execute:

OUTPUT 729; “SETMAKER:1:0:1:0:A” END
In response, the Agilent 8509 will place a marker A at the Poincare sphere 
location corresponding to the Stokes parameters S

0
=1, S

1
=0, S

2
=1, and S

3
=0. 

This corresponds to full 45 degree linear polarization. The Agilent 8509 will 
also accept commands that turn various functions on or off. Execute:

OUTPUT 729; “POINCARE:HOLD:ON” END
This causes the Agilent 8509 to freeze the Poincare sphere display at the cur-
rent measurement trace. To initiate continuous measurement, execute:

OUTPUT 729; “POINCARE:HOLD:OFF” END
As can be noted, the command is POINCARE. The accompanying parameters 
are the HOLD function and the function indicator of on or off.

The Agilent 8509 does not distinguish between upper and lower case letters. 
For example, execute:

OUTPUT 729; “Poincare:Hold:{Off” END
Some of the Agilent 8509 HPIB commands deal with data storage and retrieval 
using the Agilent 8509 system instrument controller memory. For example, 
execute:

OUTPUT 729; “DRIVE:C” END
This sets drive C in the Agilent 8509 system instrument controller as the loca-
tion for all data storage. Some commands directly store information into the 
designated drive. For example, execute:

OUTPUT 729; “SAVE: CONFIG:SYSTEM.CFG” END
This causes the current system state or configuration to be saved into the file 
SYSTEM.CFG. The file is created in the Agilent 8509 directory of the drive, 
usually drive C, known as the working directory. this directory is specified by 
the program manager in the File > Properties menu. The default working 
directory is the directory where Agilent 8509 software is installed. The file can 
be saved in another directory if an appropriate DOS format directory path is 
specified. A saved system state can later be recalled by executing:

OUTPUT; “LOAD:CONFIG:\HP8509\SYSTEM.CFG” END
Through this command, a suer determined instrument state can be achieved. 
Note that the appropriate path to the configuration file must be specified.
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Data Requesting Commands

Some of the HPIB commands request data from the Agilent 8509. This data is 
returned as an ASCII string or as a series of ASCII strings separated by com-
mas. It can be accessed by following the data-request command with an 
ENTER remote command. An example is given below:

OUTPUT 729; “JONES:MEASURE” END
OUTPUT 729; “JONES?” END
ENTER 729; String$

The device command JONES:MEASURE directs the Agilent 8509 to conduct a 
Jones matrix measurement of an inserted DUT. The results are requested 
through the JONES? command. The data is transferred through the ENTER 
remote command and placed in a string variable named String$.

There are two types of HPIB commands which request data from the Agilent 
8509 system. Some commands, such as JONES:MEASURE, cause a measure-
ment to be conducted by the Agilent 8509 while others request information 
regarding a particular instrument state. As an example of the second type exe-
cute:

OUTPUT 729; “DRIVE?” END
ENTER 729; String$

The command DRIVE? causes the Agilent 8509 system to return the letter of 
the drive which is currently set up for data transfers. This letter is read from 
the Agilent 8509 into the string variable named String$.

The IBASIC statement ENTER addresses the Agilent 8509 to talk. This allows 
the Agilent 8509 to transmit information to the controller PC. Specifically, the 
ENTER statement takes the stream of binary data output by the Agilent 8509 
and reformats it back into an ASCII string through the HPIB2DDE application. 
The controller PC places the data transmitted by the Agilent 8509 into the 
string variable listed in the ENTER statement. The string variable dimensions 
must match the data the Agilent 8509 has to transmit. If the variable is not suf-
ficiently large, data is lost.

Operation Complete

Occasionally there is a need to find out when certain operations have com-
pleted inside the Agilent 8509. For instance, a program should not have the 
operator connect the DUT while the Agilent 8509 is still measuring the mea-
surement through path.
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To provide such information, the Agilent 8509 has an Operation Complete 
reporting mechanism that will indicate when certain key commands have com-
pleted operation. The mechanism is activated by sending *OPC? immediately 
after an OPC’able command. the Agilent 8509 will output a 1 when the com-
mand completes execution. The *OPC? command should occur in the same 
output statement as the command being OPC’d.

As an example, when ready for remote control, type in the following program:

This program causes the controller PC to display the Measuring message for 
about 3 seconds while the instrument executes a through path calibration in 
preparation for an absolute Jones matrix measurement. The controller PC will 
display DONE just as the instrument completes the measurement procedure. 
When the DONE message appears, the program could then continue on, being 
assured that there is a valid through path calibration in memory.

Some operations on the Agilent 8509 may take more time than the HPIB bus 
provides for a time-out. Therefore, when you send *OPC?, either execute a 
delay before ENTER, or trap the HPIB time-out error using ON TIMEOUT... in 
the IBASIC program to allow for this delay.

Preparing for HPIB Control

At the beginning of a program, the Agilent 8509 has to be taken from an 
unknown state and brought under computer control. One way to do this is 
with an abort/clear sequence. ABORT 7 is used to halt bus activity and return 
control to the computer. CLEAR 729 will then prepare the Agilent 8509 to 
receive commands by clearing syntax errors, the input command buffer, and 
any messages waiting to be output.

10 OUTPUT 729; “JONES:ABSOLUTE” END Set up for an absolute measurement
20 OUTPUT 729; “JONES:CALIBRATE;*OPC?” 

END
Conduct the through path calibration and 
OPC the through path calibration 
measurement

40 DISP “MEASURING”
50 ENTER 729; String$ The program will halt at this point until 

the Agilent 8509 completes the 
measurement and issues a 1.

60 DISP “DONE”
70 END
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The abort/clear sequence makes the Agilent 8509 ready to receive HPIB com-
mands. The next step is to put the Agilent 8509 into a known state. The easi-
est way to do this is to send LOAD:CONFIG:PRESET, which returns the 
instrument to the preset state.

The user can specify different configuration parameters and then save them 
by sending SEND:CONFIG:<"filename”>.

To load the user specified configuration parameters send LOAD:CON-
FIG:<“filename”>. 

Running the following program brings the Agilent 8509 to a known state, 
ready to respond to HPIB control.

10 ABORT 7 This halts all bus action and gives active 
control to the computer.

20 CLEAR 729 This clears all HPIB errors, resets the 
HPIB interface, and clears syntax errors.

30 OUTPUT 729; “LOAD;CONFIG:PRESET” END Presets the instrument. This resets all 
instrument window menu settings.

40 END
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Interacting with the Agilent 8509C Through the 
DDE

This chapter focuses on using Microsoft Visual BASIC for Windows (VB) to 
create a custom application for programmed control of the Agilent 8509 to 
directly and continuously exchange data with other Windows-based applica-
tions that support the Dynamic Data Exchange (DDE). DDE data exchanges 
are called “conversations”. DDE conversations are started by establishing 
DDE links. Applications using DDE to converse with the Agilent 8509 for auto-
matic control can be custom programs using a computer language such as C or 
Visual BASIC for Windows. They can also be applications such as Microsoft 
Excel, that allow users to interface to the DDE system.

Establishing DDE links

The Agilent 8509 allows other applications to establish DDE links to test based 
controls called ‘labels’ in the Agilent 8509 firmware. To establish a DDE link an 
application must know three things about the item it wants to link to:

• The name of the application it wants to talk to
• The subject of the conversation, called a topic
• The name of the item with which the DDE conversation should take place

Since the name of the Agilent 8509 application may change with future 
updates of the firmware, the programmer of a DDE application should provide 
a mechanism for the Agilent 8509 application to change without requiring the 
program to be re-compiled. What follows is a VB code fragment that allows the 
user to specify the Agilent 8509 application name as a command line parame-
ter to his program. The command line parameter may be specified in the Win-
dows Program Manager properties dialog, accessed in the menu File > 
Properties. Place the parameter after the name of the program in the Com-
mand entry.

‘ Use this code fragment to get the name of the Agilent 8509

‘ application at run time. The command line parameter

‘ that this code fragment looks for is:

‘ /HP8509=<Name of Agilent 8509 Program>
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‘If parameter not present, use the default name.

‘ Use the variable Agilent8509DdeName# when establishing DDE links.

Const Agilent8509_DDE_DEFNAME$=”AGILENT8509_2” ‘ Get the name of the Agilent8509 Application
UCaseCmd# = Trim$(UCase(Command$))
i% = InStr (UCaseCmd$, “/HP8509=”)
If i% = 0 Then
Agilent8509DdeName$ = Agilent8509_DDE_DEFNAME$
Else
i% - i% + 8
j% = Instr (i%,UCaseCmd$,””)
If j% = 0 Then j% = Len (UCaseCmd$) +1
Agilent8509DdeName$ = MID$ (UCaseCmd$, i%, j% - i%)
End If

The Agilent 8509 uses in link items. One item is used to convey DDE status 
information. The name of this DDE link item is: Status. Eight items are used to 
send data to the application via DDE. The name of these DDE link items are:

• Param (0)
• Param (1)
• Param (2)
• Param (3)
• Param (4)
• Param (5)
• Param (6)
• Param (7)
The DDE link items ar specified in VB with the LinkItem property. The DDE 
application and the DDE topic are combined in VB, separated by the pipe 
character (|), and is called the LinkTopic property. The DDE link topic of the 
Agilent 8509 is “lpadde”, so combined with the application name, the VB Link-
Topic property is “Agilent 8509_2| lpadde”

Microsoft Windows uses 3 types of DDE links for DDE conversations.

Automatic: The source supplies data to the application every time the data 
defined by the LinkItem changes. This link is also commonly called a HOT 
Link.

Manual: The source supplies data only when the destination requires it. This 
link is also commonly called a COLD Link.

Notify: the source notifies the destination when the data changes, but sup-
plies data only when the destination requests it.

For the Agilent 8509, use Automatic links for the DDE link item Status and 
Manual links for the DDE link items Param(x). A VB Code fragment that 
establishes a DDE link to the Agilent 8509 from a users application follows.

‘ This code fragment establishes a DDE link to the
‘Agilent 8509 application from the labels

‘ lblParam(0) to lblParam(7), and lblStatus
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‘ in the user’s application.

On Error GoTo Err_cmdLink_click

‘Establish a new link with the Agilent 8509
For i% =0 To 7

‘Remove any existing link first
lblParam(i%).LinkMode = LINK_NONE
DoEvents ‘ Free windows to allow it to do the Link
lblParam(I%) .LinkTopic = Agilent8509DdeName$ & “| lpadde”
lblParam(i%) .LinkItem = “Param(“ & Format (i%) & “)”
lblParam(i%) .LinkMode = LINK_MANUAL
DoEvents ‘ Free Windows to allow it to do the Link

Next i%

lblStatus .LinkMode = LINK_NONE
DoEvents ‘ Free Windows to allow it to do the Link
lblStatus .LinkTopic = Agilent8509DdeName# & “| lpadde
lblStatus .LinkItem = “Status”
lblStatus .LinkMode = LINK_AUTOMATIC
DoEvents ‘ Free Windows to allow it to do the Link

‘ Use to be sure that Agilent 8509 data buffers are clear
lblStatus .LinkExecute “ClearParams”
DoEvents ‘ Free Windows to allow it to do the Link
Exit Sub

Err_cmdLink_click:
Select Case Err
Case 200 to 299
MsgBox “Failed to Link to HP8509”, 0, “DDE Link Error”
Case Else
‘ Other error handler here
End Select
Exit Sub

Sending Agilent 8509 Commands via DDE

To send command to the Agilent 8509 using DDE, use the LinkExecute 
method in VB. Be sure that a previous DDE conversation is complete before 
sending the DDE command. The following VB code fragment illustrates how 
to send the DDE command “Poincare:Center:A” once the DDE links have been 
established. The “ClearParams” command is sent as a precaution to clear out 
the Agilent 8509 data buffers (Param(x) labels). It is required that these buff-
ers are empty before any commands are sent to the Agilent 8509. Generally 
the data buffer is empty unless a previous command prepared a response by 
the Agilent 8509. If you are not sure if the buffers were previously cleared, 
clear them before sending a command.

Do While lblStatus .Caption = “BUSY”
DoEvents
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Loop

‘ User to be sure that Agilent 8509 data buffers are clear
lblStatus .LinkExecute”ClearParams”

lblStatus .LinkExecute “Poincare:Center:A”
DoEvents ‘ Free Windows to allow it to do the LinkExecute

Retrieving Agilent 8509 Data via DDE

To retrieve Agilent 8509 data, use the VB LinkRequest method. The Agilent 
8509 places data in the Param(x) labels. Use LinkRequest with the controls 
which are linked to the Param(x) labels in the Agilent 8509. Be sure that there 
are no pending DDE conversations before attempting to get the data, other-
wise all the data may not be present. Also, clear the data buffers (param(x) 
labels) in the Agilent 8509 after getting the data. The following VB code frag-
ment illustrates how to get data from the Agilent 8509 via DDE.

Do While lblStatus .Caption = “BUSY”
DoEvents

Loop

For i% = 0 To 7
lblParm(i%) . LinkRequest
DoEvents ‘ Free Windows to allow it to do the Link
‘ Since data is sequential, once there is an
‘empty label we’re done.
If lblParam(i%) .Caption = ““ Then Exit For

Next i%

‘ Required to do after getting the Agilent 8509 data
frmHpib .lblStatus .LinkExecute “ClearParams”

Measurement Sequence

To organize the commands into a measurement sequence requires the follow-
ing steps: 

1 Zero the instrument. 

2 Calibrate the instrument. 

3 Set up the instrument. 

4 Connect the device. 

5 Take data. 

6 Transfer data. 
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The actions within each step in the measurement sequence depend upon the 
type of measurement conducted. The instrument should be zeroed prior to 
starting a measurement sequence. Zeroing can be done remotely by sending 
the ZERO command. 

For accurate measurements, it is important that the receiver is not detecting 
any power while the zeroing routine is being performed. 

7 You will not be prompted to "Block the external laser", but you must either 
cover the OPTICAL INPUT connector with a connector cap or a piece of dark paper 
or turn off your external source. If the external source is connected to the 
Agilent 8509C EXTERNAL SOURCE INPUT, its power will be blocked automatically 
so that no power will emerge from the OPTICAL OUTPUT connector during the 
zeroing operation. 

While the zeroing routine is running, a green zero message will appear inside 
the power display in the upper-left corner of the basic measurement screen, 
and the mouse pointer appears as an hourglass. When the zero message dis-
appears, and the mouse pointer changes back to an arrow, the zeroing routine 
is finished. 

Calibrate the instrument 

A wavelength calibration can be automatically performed on the 
Agilent 8509C, if desired. This can be done remotely by sending the CAL:CAL-
IBRATE and CAL:ON commands. It should not be necessary to perform more 
than one instrument calibration per day or even one per week, depending on 
room temperature changes and the accuracy required. If in doubt, a calibra-
tion should be performed.

Set up the instrument 

All pertinent measurement parameters must be set. Set the type of source and 
set for internal or external polarizers. The number of steps in the set up proce-
dure depends on the type of measurement to be conducted. Some of the mea-
surements require a thrupath measurement calibration and/or application of a 
two-point or three-point reference frame prior to the execution of the device 
under test (DUT) measurement. One of the measurements, polarization mode 
dispersion, requires setting parameters such as the start and stop wave-
lengths, the number of steps, and the step wavelength separation. 
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Connect the device 

Have the operator connect and adjust the device under test (DUT). All adjust-
ments take place at this stage so that there is no danger of taking data from 
the device while it is being adjusted. 
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Take data 

With the device connected and adjusted, conduct the desired measurement. 
The process of taking data is different depending upon the type of measure-
ment that is conducted. For the majority of measurements, the taking of data 
is automatically performed. Certain measurements, however, such as PMD 
under manual mode, require a high degree of operator interaction. 

When taking data, the operator must ensure proper synchronization. This can 
be done by using the *OPC? command. 

Transfer data 

Lastly, read the results out of the instrument. The data output command is 
designed to ensure that the data transmitted reflects the current state of the 
instrument. The data can be read from the instrument using the ENTER 
remote command. All measured data is returned by the Agilent 8509C system 
as a sequence of comma-separated strings. The operator must take care to 
reformat or parse this data if so desired. 

HPIB Programming Examples

The following examples show how to initiate measurements and retrieve data 
via the HPIB interface to the Agilent 8509. These examples will also work 
using the DDE; see Chapter 6, “To establish a Dynamic Data Exchange (DDE) 
link between the 8509 and another application” on page 6-29 for more details.

Example 1. This example retrieves the state of polarization, the degree-of-
polarization, and the measured power. A 1550 nm source is connected to the 
8509 optical input.

OUTPUT 729; “SOURCE:EXTERNAL:1550NM” END Set 8509 wavelength to 1550 nm
OUTPUT 729; “SOURCE:EXTERNAL?” END
ENTER 729; String$
DISP String$

Query current 8509 wavelength setting

Print out the wavelength
OUTPUT 729; “STOKES?:500” END
ENTER 729; String$
DISP String$

Take measurement using 500-point averaging

Print out the test results
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This printout tells you that the 8509 is currently set to give correct readings at 
1550 nm, the measured power is 0.0001 milliwatts, the normalized Stokes 
parameters are (.15, -0.75324,.23434), and that the degree-of-polarization 
(DOP) is 98.9%.

Example 2. This example performs a manually-tuned PMD:JME measure-
ment using an 81640A Tunable Laser Source (TLS). The TLS is connected to 
the HPIB bus at address 724. Its optical output is connected to the 8509 exter-
nal source input. A DUT is connected between the 8509 optical output and the 
8509 optical input.

This printed result tells you that the average measured differential group 
delay (DGD) was 0.218 picoseconds at an average wavelength of 1550.5 nm.

Resulting printout (an example only):
1550
0.0001,.15,-0.75324,.23434,.989

OUTPUT 729; “ZERO” END Zero the 8509
OUTPUT 729; “DISPER” END Open the PMD:JME Measurement Window
OUTPUT 729; “DISPER:MANUAL” END Send the 8509 into manually-tuned PMD mode so 

that you control the TLS from this program
OUTPUT 729; “DISPER:WLEN:START:1550NM” Set the start wavelength to 1550 nm
OUTPUT 729; “DISPER:WLEN:STOP:1551NM” Set the stop wavelength to 1551 nm
OUTPUT 729; “DISPER:WLEN:DELTA:1NM Set the wavelength step size to 1 nm
OUTPUT 724; “SOUR0:CHAN1:POW:STATE ON” Turn the TLS output on
OUTPUT 724; “SOUR0:CHAN1:WAVE 1550NM: Set the TLS to 1550 nm
OUTPUT 729; “DISPER;MEASURE” Measure start wavelength (1550 nm)
OUTPUT 724; “SOUR0:CHAN1:WAVE 1551NM: Set TLS to 1551 nm
OUTPUT 729: “DISPER:MEASURE” Measure start wavelength (1550 nm)
OUTPUT 729; “DISPER?” Get the PMD measurement
ENTER 729; String$
DISP String$ Print it out
OUTPUT 724; “SOUR0:CHAN1:POW:STATE OFF” Turn the TLS output off
OUTPUT 729; “DISPER:CLOSE” END Close the PMD:JME Measurement Window
Resulting printout (an example only):
1550.5,.218,.218
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Example 3. This example performs a Jones Matrix Method PDL measure-
ment. It is assumed that a 1550 nm source is connected to the 8509 external 
source input and the DUT is connected between the 8509 optical output and 
optical input.

This printed result tells you that the PDL was 0.23 dB at 1550 nm.

OUTPUT 729; “SOURCE:EXTERNAL:1550NM” END Set 8509 wavelength to 1550 nm
OUTPUT 729: “SOURCE:EXTERNAL?” END Query current 8509 wavelength setting
ENTER 729; String$
DISP String$ Print out the wavelength
OUTPUT 729; “POLDEP:INTERNAL” END Select PDL measurement with internal polarizers
OUTPUT 729; “POLDEP:EXTERNAL?” END Select the relative measurement mode
OUTPUT 729; “POLDEP:MEASURE” END Make relative PDL measurement
OUTPUT 729; “POLDEP:POLDEPDATA?” END Retrieve the PDL measurement
ENTER 729; String$
DISP String$ Print out the test results
OUTPUT 729; “POLDEP:DONE” END Close the PDL window
Resulting printout (an example only):
1550
.23
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Command Syntax 

None of the commands are case dependent. Commands may be sent in upper 
case, lower case, or mixed case. Any item not enclosed in angle brackets 
(< , >) must be considered a literal command.

Most of the commands in this chapter are available using Microsoft Windows 
DDE, as well as HPIB. Any restrictions to the use of a command are noted in 
the command description. 

When receiving HPIB commands, the Agilent 8509C does not lock out manual 
operation. Do not disrupt remote control through manual command execu-
tion. Furthermore, HPIB commands which lock out manual operations are not 
currently available for remote control of the Agilent 8509C. When you begin 
remote operation of the Agilent 8509C, quit, then restart the application if 
there has been any manual operation during the current session of the 
Agilent 8509C application.
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Table 8-1. Conventions

: colon Command Separator Separates parameters. A parameter must be supplied to the right of every 
colon. 

? question Query The command causes the instrument to prepare a response. No further 
commands may be sent until the response is retrieved. 

{ } braces Mandatory Selection Select one of the options in the braces as a parameter. If braces indicate 
option is part of a parameter, select option and append it to the parameter. 

[ ] brackets Optional Selection Similar to Mandatory Selection except that selecting a parameter is optional. 
| pipe Selection Separator Separates mandatory selection and optional selection parameters. Spaces 

may be added in this document for clarity. 
< > angle brackets Described parameter A description of the parameter. Supply a parameter corresponding to the 

description in the brackets. 
<“filename”> The filename of the file to save or load. The path, if specified, should exist, or 

an error will occur. If the path is not specified the default path will be used. 
The default path for any filename is the windows working directory. This is 
usually the same as the Agilent 8509C application directory, but can be 
changed in the Windows Program Manager by highlighting the Agilent 8509C 
icon and selecting File, Properties. If the current drive is changed using the 
Drive:<Drive Spec> command, then the default directory is the default 
directory of the current drive. The filename must be enclosed in double quotes 
(") if it includes any colons (:), otherwise the double quotes are optional. 

<“title”> The title to use for a Save/Load operation with the Agilent 8509C database. A 
maximum of 80 characters can be used for the <“title”>. Use only printable 
characters in the range of ASCII 32 (space) and ASCII 126 (~ tilde) for titles. 
Trailing spaces are ignored, leading spaces are not ignored. The title must be 
enclosed in double quotes (") if it includes any colons (:), otherwise the double 
quotes are optional. 

<“serial number”> The serial number of the device under test for the measurement being saved. 
Used for a Save operation with the Agilent 8509C database. This field is 
optional. If it is not provided, this entry in the database is left blank. A 
maximum of 25 characters can be used for the serial number. Use only 
printable characters in the range of ASCII 32 (space) and ASCII 126 (~ tilde). 
Trailing spaces are ignored, leading spaces are not ignored. The serial number 
must be enclosed in double quotes (") if it includes any colons (:), otherwise 
the double quotes are optional. 

<“date code”> The date code of the device under test for this measurement being saved. 
used for a Save operation with the Agilent 8509C database. This field is 
optional. If it is not provided, this entry in the database is left blank. A 
maximum of 16 characters can be used for the date code. use only printable 
characters in the range of ASCII 32 (space) and ASCII 126 (~ tilde). Trailing 
spaces are ignored, leading spaces are not ignored. The date code must be 
enclosed in double quotes (") if it includes any colons (:), otherwise the double 
quotes are optional. 
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Abbreviations/Definitions

analyzer window The first window to open when the Agilent 8509C lightwave polarization analyzer software starts. 

DDE Dynamic Data Exchange. A mechanism Microsoft Windows uses for applications to communicate 
with each other. Agilent 8509C supports DDE links. 

DGD Differential Group Delay. Differential propagation time of polarization modes. Usually expressed 
in units of time. 

frame A boxed-in region within a window, usually with a title, that contains user interface elements 
such as option buttons, command buttons, text boxes, etc. 

JME Jones Matrix Eigenanalysis. Mathematical technique used to calculate optical parameters such 
as DGD. 

LPA Lightwave Polarization Analyzer. The Agilent 8509C is an LPA. 

Not Recommended The particular command is supported in this version. However, it may not be supported in future 
versions of the Agilent 8509C. 

OSS Optical Source Setup. The window used to adjust the optical source (laser) parameters. 

PDL Polarization Dependent Loss. The loss (or gain) variation of an optical signal due to polarization. 

PMD Polarization Mode Dispersion. Average DGD over wavelength range. 

string A series of characters. The codes for string characters range from 0 to 128 and are the same as 
those defined by the ASCII character set. Only the printable characters, codes 32 to 126, are used 
in HPIB bus communications for messages. Codes 13, 10 (<CR><LF>) are often used for EOL (end of 
line) (see HPIB configuration and setup information). 

TLS Tunable Laser Source. Agilent 8164, Agilent 8167, and Agilent 8168 are tunable laser sources. 

VTUNE Tunable Laser Source controlled by analog voltage output VOUT A of the Agilent 8509C. Using a 
VTUNE source prevents the use of the analog outputs for any other purpose. 

WS Wavelength-Scanning. A method used to determine the polarization mode dispersion of an optical 
system by examining cyclical characteristics of the output polarization (using the normalized 
Stokes parameters) over a wavelength range. 
8-29



Measurement Programming and Examples
Changes from Version 1.2 Software

book.book  Page 30  Thursday, March 29, 2001  12:14 PM
Changes from Version 1.2 Software 

Every effort has been made to assure the compatibility of version 3.0 remote 
commands with version 1.2 remote commands. In some instances this has not 
been possible due to fundamental changes in the design of the Agilent 8509C 
software. Please note the changes below and change your existing programs 
to accommodate the changes, if necessary. 

*OPC[?]

On some fast controllers, the windows operating system may not release sys-
tem resources fast enough to acknowledge an *OPC? that is sent in a separate 
bus transaction. In general, it is a good idea to limit the number of HPIB bus 
transactions by grouping the commands together, separated by a semicolon. 
Four thousand (4,000) characters may be sent in one HPIB bus transaction to 
the Agilent 8509C. It is recommended to send *OPC? to the Agilent 8509C as 
part of the same HPIB bus transaction as the command that is being *OPC’d. 

Cal:Calibrate

This command will always return "PASS" when used with DDE. After this com-
mand is issued, either from HPIB or DDE, the Agilent 8509C system will be 
occupied performing the calibration. No other activity on the Agilent 8509C 
instrument controller will take place until the calibration completes. The com-
mand *OPC[?] has no effect, since the Agilent 8509C system will not respond 
to any commands while a calibration is in progress. The Cal:Calibrate com-
mand takes about 25 seconds on a instrument controller. The programmer 
should hard code a delay in the program which controls the Agilent 8509C, 
after issuing this command. After the delay, issue the Status? command to 
determine if the Cal:Calibrate command was successful. 

Disper:Close

In version 1.2 this command caused the PMD window to close. In version 3.0 
there can be many PMD child windows open, all within a main "Multiple Docu-
ment Interface" (MDI) parent window. This command will close only the first 
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PMD:JME child window which was opened. The MDI parent window, which 
holds all of the PMD child windows, will close automatically after the last PMD 
child window is closed. 

Source? Source:External? Source:Internal?

Version 1.2 of the Agilent 8509C had only one set of settings to control a TLS, 
so when querying the TLS, the returned value was the setting of the TLS for 
the Agilent 8509C instrument. This is not true for version 3.0 of the 
Agilent 8509C software. In version 3.0 each PMD window and the analyzer 
window each have their own set of TLS settings. When using the above 
Source:.... commands, be aware that the TLS settings returned are for the 
Analyzer Window only. Version 3.0 provides other commands to query the 
TLS settings for the PMD windows.

Note

When setting the TLS parameters using the Source:External:<Wavelength nm>, 
Source:External:{Off|On}, and Source:Internal:{Off|1310|1550} commands, all windows’ 
TLS settings are changed. This conforms to version 1.2 operation. 
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Common Commands 

*IDN?

Returns a string that uniquely identifies the analyzer. The string is in the form:

<Manufacturer>,<Model Number>,<Serial Number>,<Firmware Version>

For example: "AGILENT TECHNOLOGIES,Agilent 8509C,3206A00156,2.10" 

HPIB operation only.

*OPC[?]

Operation complete. The query will return an ASCII "1" when all pending over-
lapped operations have been completed. The command is used to ensure the 
completion of a particular function as requested by a prior command. Append 
this command to the command being OPC’d, separated with a semicolon. 
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Device Specific Commands 

Analog?

Returns Off, Raw, or Stokes, depending on the setting of the analog outputs 
(see “Analog:{Off | Raw | Stokes} [?]” on page 8-33). 

Analog:Done

Closes the Analog frame in the analyzer window. 

Analog:{Off | Raw | Stokes} [?]

Selects and turns on or off the output of the four BNC connectors on the rear 
panel of the Agilent 8509C. If "stokes" is sent, the output of the four BNC con-
nectors will be four voltages proportional to the Stokes parameters S

0
, s

1
, s

2
 

and s
3
. When raw is sent, the four voltages will be proportional to the currents 

induced on the four photodiodes of the Agilent 8509C receiver. The voltages 
are always in the range of –10 to 10 volts. When "off" is sent, the four BNC out-
puts will be turned off. The query returns "1" if the particular control is 
selected in the Analog frame of the analyzer window, and "0" if not selected. 

Angles:{AB? | AC? | BC?}

Returns the angle between the specified markers, its cosine, and the cosine 
squared of half the angle. The largest angle measurable is 180 degrees or PI 
radians. The angles and appropriate markers must be turned on in order to 
obtain the desired angle. (See “Angles:{Off | On}” on page 8-34.) 

Angles:{Degrees | Radians}[?]

Sets the units of the displayed angles to either radians or degrees. The query 
returns "1" if the condition is true, "0" otherwise. (See “Angles:{Off | On}” on 
page 8-34.) 
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Angles:Done

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: Angles:Off.

Closes the Marker Angles frame in the analyzer window. 

Angles:{Off | On}

Displays the angles between markers A and B, markers A and C, and markers 
B and C. The measured angles are displayed in the Marker Angles frame in the 
analyzer window. The angles are measured from the Poincare sphere coordi-
nate location of the markers. The markers must be turned on in order to 
obtain the measured angles. 

Average:Display:{Off | On}

Turns on or off the moving average of a measurement trace on the Poincare 
sphere display. 

Average:Display{? | :<NumPoints>}

Specifies the number of points <NumPoints> to be used in the moving average 
of the Poincare sphere display. The query returns the number of points set in 
the Averaging frame of the analyzer window and the state of the display aver-
aging; "0" if off, "1" if on. 

Average:Done

Closes the Averaging frame in the analyzer window. 

Average:Measure{? | :<NumPoints>}

The number of points (NumPoints) to be averaged, at each measurement 
point, when conducting any measurement. This number may be set using 
<NumPoints>, or queried using?. 

Cal?

Returns the status of the Calibration apply option buttons; "0" means Calibra-
tion is Off, "1" means Calibration is On. 
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Cal:Calibrate

Performs an instrument calibration which optimizes the measurement perfor-
mance of the analyzer. The calibration is performed at the current user-
defined source wavelength.

Cal:{Done | Save}

The Done parameter terminates the instrument calibration sequence. The cal-
ibration window is removed from the screen. The Save parameter saves in 
memory, an instrument calibration performed at a given source wavelength. 
The source wavelength is specified through the source command. All saved 
calibrations can be accessed when the Cal:On command is sent. 

Cal:Delete:<Wavelength nm>

Deletes from memory the instrument calibration performed at the specified 
source wavelength. 

Cal:List?

Returns a list, in the form of a comma-separated string, of the wavelengths for 
which calibrations have been performed. The wavelengths are given in nanom-
eters. 

Cal:{Off | On}

The Off and On parameters enable or disable the instrument calibration cor-
rections. When enabling a calibration, the instrument will search for a saved 
instrument calibration performed at the current source wavelength. If a cali-
bration is not present, then calibration corrections cannot be enabled. 

ClearParams

Used to clear the DDE parameters in the LPA after data is retrieved. A DDE 
LinkPoke can also be used to clear the parameter boxes. DDE Parameters 
should always be cleared after data is retrieved so that another query isn’t 
confused by residual data that was previously left behind. The HPIB gateway 
automatically sends this DDE command after retrieving data. 

DDE only. 
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DBase:Close

Closes the currently opened database file. 

DBase:Compact

Compacts the currently opened database file. 

DBase:Filename?

Returns the name of the currently opened database file. 

DBase:Open:<“filename”>

Opens the database file specified in <“filename”>. 

DBase:Repair

Repairs the currently opened database file. 

Disper

Displays the PMD:JME window on the Agilent 8509C instrument display. Be 
sure to send ‘Disper’ before sending any other ‘Disper:....’ commands. 

Disper?

Upon command execution, the analyzer returns the current wavelength, the 
measured dispersion at the current wavelength, and the average of the mea-
sured dispersion up to and including the current wavelength. The command 
can be used under manual mode to check the status of a running measure-
ment process. The data is returned as a comma separated ASCII string in the 
following format: 

<Wavelength(nm)>, <Current Dispersion>, <Average Dispersion>

The units for the returned dispersion data are selected with Disper:Units:. The 
default units are ps. 
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Disper:ActiveWindow?

Upon command execution, the analyzer returns the comma separated data 
from the currently active PMD:JME window. The number of data points is 
returned in Param(0). The wavelengths are returned in Param(1). The polar-
ization mode dispersion delay is returned in Param(2). The units for the 
returned dispersion data are selected with Disper:Units:. The default units are 
ps. 

Disper:Atten{? | :<dBm value>}

The attenuation for the HPIB tunable laser source. The query returns the 
attenuation in dBm. Using <dBm value> sets the attenuation for an HPIB tun-
able laser source. 

DDE only. 

Disper:Calibrate

Clears any current thrupath calibration and begins a new PMD:JME calibra-
tion sequence at the current wavelength setting. This command is used when 
the command Disper:Cascade has been sent to specify that a thrupath calibra-
tion is required prior to the PMD:JME measurement of a given device under 
test. Once the PMD:JME controls have been accessed, the Disper:Calibrate 
command must be sent before any Disper:Measure commands can be sent. 

Disper:{Cascade | Single}[?]

Sets the polarization mode dispersion measurement (PMD) process for mea-
suring a single device under test or for the measuring of a device under test 
included in a chain of devices under test. The Cascade parameter is used to 
de-embed the effects of components inserted along the measurement path of 
the desired device under test. If Cascade is set, a thrupath calibration must 
first be conducted at each measurement wavelength. Once the thru calibra-
tion process is completed, the PMD measurement process can be executed. 
The query returns an ASCII 1 if the specified setting (single or cascade) is 
being used in the PMD measurement and a 0 if it is not. 
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Disper:Chain[?]

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Disper:{Cascade | Single}[?]” on page 8-37. 

Disper:Clear

Aborts a PMD:JME measurement process. This command is valid only if the 
optical source is set to manual. The command does not erase the current thru-
path calibration corrections. 

Disper:Close

Closes the PMD:JME measurement window. The PMD:JME measurement pro-
cess is ended. The original version 1.0 command closed the PMD:JME window. 
In version 3.0 the PMD:JME window is a child of the Agilent 8509C Graphs 
window. The Graphs window closes when the last graph is closed. 

Disper:DBase:Load:<“title”>

Loads a measurement from the current database using the specified title. 

Disper:DBase:Save:<“title”> [ :<“date code”> [ :<“serial number”>]]

Saves a measurement to the current database using the specified title. 

Disper:Done

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Disper:Close” on page 8-38.

Disper:FiberLen{? | :<km>}

The length of optical fiber used to normalize PMD:JME measurements. The 
query returns the length of the fiber. Using the parameter <km> sets the 
length of optical fiber. 
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Disper:FindMinPoints[:<Num Samples>]

Activates the PMD:JME feature that automatically determines the minimum 
number of points required to prevent aliasing in the specified wavelength 
range. PMD:JME measurements are activated with this feature. The only tun-
able laser sources supported with this feature are HPIB Agilent 8164, Agilent 
8167, and Agilent 8168 and VTune tunable laser sources. Agilent 8509C con-
trol of the HPIB bus is available only using DDE. Therefore, this feature will 
not work for the Agilent 8164, Agilent 8167, and Agilent 8168 tunable laser 
sources when using the HPIB bus for remote operation of the Agilent 8509C. 
Only the VTune tunable laser source can be used with HPIB. The <Num Sam-
ples> value specifies the number of sections of the Poincare sphere the test 
for aliasing. The default value for <Num Samples> is 4 if no value is specified. 

Disper:HPIB[?]

Sets the tunable laser source for a PMD:JME measurement to an HPIB tunable 
laser source. The Agilent 8509C looks for a tunable laser source at the address 
specified with TLS:Address and uses it if it is an Agilent 8164, Agilent 8167, or 
Agilent 8168 tunable laser source. Be sure that the wavelength range is set 
correctly for the connected HPIB tunable laser source before issuing this com-
mand. To change the tunable laser source selection, Agilent 8164, Agilent 
8167, or Agilent 8168: 

1 Issue the command Disper:Manual 

2 Change the wavelength range using Disper:WLen: 

3 Change the HPIB address using TLS:Address:<HPIB Address>

4 Issue the command Disper:HPIB 

The query returns an ASCII "1" if the PMD:JME next measurement process 
will be in HPIB mode and a "0" if it will not be in this mode. Also returns the 
name of the current laser source. 

DDE only. 

Disper:Manual

Places the polarization mode dispersion measurement in manual control 
mode. When the instrument is under manual control, the user must set the 
external source to the appropriate wavelength for each wavelength step 
between the start and stop wavelengths. In manual control mode, you must 
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send the command ’Disper:Measure’ once to begin the measurement process 
and once for each wavelength point as returned by the command ’Dis-
per:WLen:Points?’. 

Disper:Manual?

Returns an ASCII "1" if the PMD:JME next measurement process will be in 
manual mode and a "0" if it will not be in this mode. Also returns the name of 
the current laser source. 

Disper:Measure

Triggers a PMD:JME measurement at the current source wavelength setting. 

Disper:NewThruCal

Not Recommended 

This command is ignored. It is provided for compatibility with old code. Com-
mand will not be available in future versions. Plan your programming to use 
the alternate commands: “Disper:Calibrate” on page 8-37. 

Disper:Power?

Returns the power and the power units for the tunable laser source. 

DDE only. 

Disper:Power:{dBm | uWatt}[:<value>]

Sets the units for the tunable laser source. If the <value> parameter is speci-
fied, the power setting can also be changed. If the power setting is not valid for 
the TLS, the command fails.

DDE Only. 

Note

When changing only the units, the numerical value of the power does not change. Be 
sure to change the value of the power to correspond to the new units. 
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Disper:Restart

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Disper:Clear” on page 8-38.

Disper:Save:<“filename”>

Saves a polarization mode dispersion measurement trace into the file <“file-
name”>. The trace is saved as a series of ASCII strings separated by commas. 
The saved trace information is in the form of: 

wavelength_1 (nm), wavelength_2 (nm), dispersion 
wavelength_2 (nm), wavelength_3 (nm), dispersion 
....
....
....
wavelength_n-1 (nm), wavelength_n (nm), dispersion 

The above is for the dispersion measurement at "n" user defined wavelengths. 
The units for the dispersion measurement are selected using the Disper:Units: 
command. The default units are ps. For path information on "filename", see 
“Command Syntax” on page 8-27. 

Disper:Settle:{Point | Start}{? | :<Delay msec>}

The settling time to wait, either initially (Start) or per point (Point), after set-
ting a tunable laser source to the desired wavelength in the sweep range dur-
ing a PMD:JME measurement. The query returns the current value. 

See also: “WaveScan:Settle:{Point | Start}{? | :<Delay msec>}” on page 8-66. 

Disper:Start

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Disper:Measure” on page 8-40. 
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Disper:Trace:<“filename”>

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Disper:Save:<“filename”>” on page 8-41. 

Disper:Units{? | :ps | :ps/L | :ps/sqrtL | :fs | :fs/L | :fs/sqrtL}

Sets the units to use in PMD:JME measurements. The query returns the units 
of measure for PMD:JME. 

Disper:VTune[?]

Sets the Optical Source Setup source selection to VTune in order to control a 
VTUNE tunable laser source. 

The query returns an ASCII "1" if the PMD:JME next measurement process 
will be in VTUNE mode and a "0" if it will not be in this mode. Also returns the 
name of the current laser source. 

Disper:VTune:{Start | Stop}{? | :<Voltage>}

The VTUNE start or stop voltage. The query returns the voltage value, the 
parameter <Voltage> sets the value. 

Disper:WLen?

Returns the next wavelength (in nm) at which the PMD:JME measurement 
will be conducted. This command is typically used only when the tunable laser 
source is "Manually Tuned." 

Disper:WLen:Points{? | :<NumPoints>}

Sets the number of points between the start and stop wavelengths for the 
polarization mode dispersion (PMD) measurement. Each point corresponds to 
a wavelength for PMD measurement. If the number of points does not corre-
late with the delta value and the start and stop wavelengths, the delta value is 
reset to accommodate the number of points according to: 

WlenDelta = (WlenStop – WlenStart) / (WlenPoints – 1) 

The query returns the number of points specified in the current PMD:WS 
measurement settings. 
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Disper:WLen:{Start | Stop | Delta}{? | :<Wavelength nm>}

Specifies the Start, Stop, or Delta wavelengths for the PMD:JME measure-
ment. Changing any of these values causes the number of points in the Optical 
Source Setup window to change according to: 

WlenPoints = ((WlenStop – WlenStart) / WlenDelta) + 1 

The query returns the value of the setting in nanometers. Using the <Wave-
length nm> parameter sets the value. 

Disper:WLen:Steps{? | :<NumPoints>}

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Disper:WLen:Points{? | :<NumPoints>}” on 
page 8-42. 

Sets the number of steps between the start and stop wavelengths for the 
polarization mode dispersion (PMD) measurement. Each step corresponds to 
two adjacent wavelengths for PMD measurements. If the number of steps does 
not correlate with the delta value and the start and stop wavelengths, the 
delta value is reset to accommodate the number of steps according to: 

WlenDelta = (WlenStop – WlenStart) / WlenSteps 

The query returns the number of steps specified in the current PMD:WS mea-
surement settings. 

Note

The Start and Stop values can never have the same value. For example, when segment-
ing a wavelength range over several measurements and sweeping from low to high, 
always issue the command Disper:WLen:Stop before the command Disper:WLen:Start 
when specifying the next wavelength segment. This will prevent the Start and Stop val-
ues from being equal when switching from one segment to the next. 

Note

The value returned/set by Disper:WLen:Points is one more than the value returned/set 
by Disper:WLen:Steps. Steps are transitions between the Points. 
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Display:Angles:{Off | On}

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Angles:{Off | On}” on page 8-34. 

Display:Angles:{Degrees | Radians}

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Angles:{Degrees | Radians}[?]” on page 8-33. 

Sets the displayed angles to degrees or radians (see “Display:Angles:{Off | On}” 
on page 8-44). 

Display:Power:{Linear | Log}

The lightwave power measurement can be displayed either in log format 
(dBm) or linear format (uW). The setting can be changed through this com-
mand. 

Display:Update{? | :<NumPoints>}

The number of points plotted to the Poincare sphere between updates of the 
other displays, power, DOP, and Stokes. A large number of points plotted to 
the Poincare sphere will slow down updates of the other displays. A small 
number of points plotted to the Poincare sphere will slow down the plotting on 
the Poincare sphere. This number may be set using <NumPoints>, or queried 
using’?’. 

Drive?

Returns the letter of the drive currently set up for HPIB initiated data storage. 

Drive:<MS-DOS Drive Spec>

Sets the specified drive for HPIB initiated data transfers. Drive C is the 
Agilent 8509C system default drive. If using drive C, all saved data files using 
HPIB will be placed in the Agilent 8509C directory unless a specific directory 
path is specified for the file. If another drive, such as A or B, is designated, all 
files will be saved to the root directory unless an alternate path is specified. 
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GetFile:<“filename”>

This command will, via HPIB, transfer an ASCII data file from the 
Agilent 8509C system instrument controller to the external controller. The file 
is transferred as an ASCII string. An ENTER HPIB command must be used to 
access the file from the Agilent 8509C instrument controller. The file must be 
placed into a large enough string variable. Otherwise, data will be lost. In the 
HPIB2DDE window, the user can specify whether the string separator is a 
comma or a carriage return/linefeed. The user should specify the format which 
coincides with the string variable specified in the ENTER HPIB command 
statement. For path information on "filename", see “Command Syntax” on 
page 8-27. 

HPIB Operation only. 

GetMarker:{A | B | C}

Not Recommended 

See “GetMarker:{A | B | C}” on page 8-45. 

GetMarker?:{A | B | C}

Places the specified marker at the current state of polarization and returns the 
results S
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, S

1
, S
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, S
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. S

0
 is the power in milliwatts, and S

1
, S

2
, S

3
 are the normal-

ized Stokes parameters which serve as coordinates on the Poincare sphere. 

Jones?

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:{JonesData? | PolDepData?}” on 
page 8-51. 

Jones:{Absolute | Relative}[?]

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:{Absolute | Relative}[?]” on page 8-50. 
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Jones:Calibrate[A | B | C]

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:Calibrate[A | B | C]” on page 8-50. 

Jones:Clear

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:Clear” on page 8-50. 

Jones:Done

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:Done” on page 8-51. 

Jones:{External | Internal}[?]

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:{Internal | External}[?]” on page 8-51. 

Jones:{MagRadians | MagDegrees | RealImag}[?]

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:{MagRadians | MagDegrees | Real-
Imag}[?]” on page 8-52. 

Jones:Measure[A | B | C]

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:Measure[A | B | C]” on page 8-52. 
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Jones:NewThruCal

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:NewThruCal” on page 8-52. 

Jones:ReStart

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:Clear” on page 8-50. 

Load:Config:Preset

Loads the factory default configuration for the LPA. 

Load:Config:<“filename”>

Loads the user created configuration file <“filename”>. For compatibility with 
previous versions, the search path for "filename" is: 

1 The windows working directory. 

2 The Agilent 8509C application directory. 

3 The Windows directory (usually C:\WINDOWS). 

For path information on "filename", see “Command Syntax” on page 8-27. 

Load:Single:<“filename”>

Loads a timed measurement from the file <“filename”>. 

For path information on "filename", see “Command Syntax” on page 8-27. 

OperVer[?]

Opens the Operation Verification window. The query returns the results of the 
operation verification procedure in the following format: 

<Result of OperVer>,<Max DOP%>,<Mean DOP%>,<Min DOP%>,
<Angle AB>,<Angle AC>

where <Result of OperVer> is "1" if success, "0" if fail. 
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OperVer:{Start | Cancel | Done}

Opens the Operation Verification window, if not already open, and activates 
the specified command button. 

PdlMaxMin[?]

Shows the PDL:Max-Min window on the Agilent 8509C screen. The query 
returns the PDL:Max-Min data as follows: 

Dbm Max, s1 Max, s2 Max, s3 Max, Dbm Min, s1 Min, s2 Min, s3 Min 

PdlMaxMin:{Max | Min}

Centers the Poincare Sphere on the Max or Min point. 

PdlMaxMin:Delta?

Returns the Max-Min power in dBm. 

PdlMaxMin:{Reset | Clear | Done}

Activates the appropriate button on the PDL:Max-Min window. 

Per?

Returns the polarization extinction ratio (dB) for a previously performed 
polarization maintaining (PM) fiber launch alignment.

Poincare:Center:{Stokes | A | B | C}

If the parameters A, B, or C are sent; upon command execution, the Poincare 
sphere is rotated so that the specified marker is at the center of the Poincare 
sphere display. The marker must first be set before the command is executed. 
If the parameter Stokes is sent, the Poincare sphere is rotated so that the cur-
rent state of polarization is at the center of the Poincare sphere display. 

Poincare:Clear

Clears all visible measurement traces on the Poincare sphere. After clear, 
measurement continues at the current state of polarization. 
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Poincare:Hold:{Off | On}

Toggles Hold on or off. When toggled on, the Poincare sphere display is held at 
the current measurement state. When toggled off, continuous measurement is 
initiated. 

Poincare:Marker:{A | B | C}

Places the specified marker at the currently measured state of polarization as 
shown on the Poincare sphere. The specified marker is turned on and the 
marker measurement is displayed on the Agilent 8509C instrument window. 
The marker measurement is in terms of the normalized Stokes parameters 
S

0
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1
, s

2
, s

3
. 

Poincare:Marker:Clear

Clears all measurement markers from the Poincare sphere and turns them off. 

Polarizer:{A | B | C | None}[?]

When using internal polarizers, the command inserts the specified polarizer at 
the source output. The query returns 1 if the particular polarizer is inserted, 
0 if not. 

Polarizer:Angle{A | B | C}{? | :<Degree Value>}

The <Degree Value> parameter sets the angle for the specified external polar-
izer. The user must be careful to enter the correct angles. Each polarizer will 
pertain to a marker as defined by the user. The query returns the value of the 
specified internal or external polarizer, depending on the setting.

Polarizer:Done

Closes the Polarizers frame in the analyzer window. 

Note

Using <Degree Value> is valid only when the polarizers are External as the internal polar-
izers are fixed. This command will execute when the polarizers are in internal mode, but 
the angles specified will not be used in calculations until the polarizers are put in exter-
nal mode using Polarizer:External. See also “Polarizer:{External | Internal}” on page 8-50. 
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Polarizer:{External | Internal}

Sets up the analyzer for the use of internal or external polarizers. When using 
internal polarizers, the specified polarizer is automatically inserted. When set 
to external polarizers, the appropriate polarizer must be inserted by the user 
when so required. 

PolDep?

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:{JonesData? | PolDepData?}” on 
page 8-51. 

PolDep:{Absolute | Relative}[?]

Specifies the type of polarization dependent loss (PDL) measurement. An 
absolute measurement requires a thrupath calibration prior to the PDL mea-
surement. A relative measurement does not require a thrupath calibration. 
The query returns "1" if the condition is true, "0" otherwise. 

PolDep:Calibrate[A | B | C]

This command is used for an absolute polarization dependent loss (PDL) mea-
surement. Triggers a measurement-thrupath calibration. If a PDL calibration 
was previously performed, execute PolDep:NewThruCal before PolDep:Cali-
brate. Otherwise the calibration constants will not be updated. When optional 
selections A, B, or C are used, external polarizers are assumed to be used. The 
user must insert the appropriate polarizer and send a command for each 
polarizer. The polarizer angles pertaining to each of the three markers (a, b, 
and c) must be specified using the polarizer command. (See “Polar-
izer:Angle{A | B | C}{? | :<Degree Value>}” on page 8-49.) The 
PolDep:NewThruCal and the PolDep:Calibrate[A|B|C] commands are valid 
only for absolute measurements, that is, when the transmission measurement 
is either Delta, Max, or Min. 

PolDep:Clear

Aborts or restarts a polarization dependent loss measurement process. Any 
current measurements are cleared. The command does not erase the thrupath 
calibration corrections from memory. 
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PolDep:Done

Ends a polarization dependent loss (PDL) measurement process. The PDL 
measurement controls are removed from the screen. 

PolDep:{Internal | External}[?]

Specifies whether internal or external polarizers will be utilized in a polariza-
tion dependent loss measurement. Internal polarizers are those which are a 
part of the Agilent 8509C system. The user must implement and specify exter-
nal polarizers through the polarizer command. The query returns the selected 
polarizers. 

PolDep:{JonesData? | PolDepData?}

When the mandatory selection is PolDepData?, the instrument returns data in 
one of two ways, depending on whether it is in absolute mode or relative 
mode. 

For absolute measurements the analyzer returns the polarization dependent 
loss as either Delta, Max, Min. 

delta_transmission, max_transmission, min_transmission 

For relative measurements it returns the polarization dependent loss as Delta. 

delta_transmission 

When the mandatory selection is JonesData?, the analyzer returns the Jones 
matrix as: 

j00.real, j00.imag, j01.real, j01.imag, ..., j11.imag 

or 

J00.magnitude, j00.phase, j01.magnitude, j01.phase, ...., j11.phase. 

Before sending this command using either selection, be sure that a measure-
ment has been taken. 

To take a measurement: If the analyzer is in absolute mode, a calibration is 
performed first using PolDep:Calibrate[A|B|C]. The measurement is performed 
using PolDep:Measure[A|B|C]. Use optional selection A, B, or C when external 
polarizers are selected. 
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PolDep:{JonesMode | PolDepMode}[?]

Selects the data format as polarization dependent loss values or Jones values. 
This is similar to selecting the option button at the bottom of the window. Use 
this command to open the Polarization Dependence window. The query 
returns "1" if the condition is true, "0" otherwise. 

PolDep:{MagRadians | MagDegrees | RealImag}[?]

Sets the format of the Jones matrix numerical results to a polar (magnitude 
and phase) or rectangular (real, imaginary) format. Through this command, 
the angle of the polar numerical results can be presented either in radians, 
degrees, or as complex numbers. The query returns "1" if the indicated format 
is selected, "0" if not selected. 

PolDep:Measure[A | B | C]

Calculates the polarization dependent loss of a given device under test. The 
results can be read from the analyzer through the use of the poldep? HPIB 
remote command. With internal polarizers, the measurement is performed 
automatically. When optional selections A, B, or C are used, then external 
polarizers are assumed to be used. The user must insert the appropriate polar-
izer and send a command for each polarizer. The polarizer angles pertaining to 
each of the three markers (A, B, and C) must be specified using the polarizer 
command. (See “Polarizer:Angle{A | B | C}{? | :<Degree Value>}” on page 8-49.) 

PolDep:NewThruCal

Clears any current thrupath calibration and begins a new calibration 
sequence. A calibration must first be done using PolDep:Calibrate[A|B|C]. The 
PolDep:NewThruCal and the PolDep:Calibrate[A|B|C] commands are valid 
only for absolute measurements, that is, when the transmission measurement 
is either Delta, Max, or Min. 

PolDep:ReStart

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolDep:Clear” on page 8-50. 
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PolMarker:{A | B | C}

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “PolMarker?:{A | B | C}” on page 8-53. 

PolMarker?:{A | B | C}

When using the internal polarizers, the parameters for this command are such 
that A refers jointly to polarizer A and marker A, similarly for parameters B 
and C. When the internal polarizers are used, this command inserts the speci-
fied polarizer (A for 0°, B for 60°, and C for 120°) at the source output. The 
marker pertaining to the specified polarizer (A, B, or C) is placed, as observed 
on the Poincare sphere, at the resulting state of polarization. Command exe-
cution also returns the resulting state of polarization in the form of the nor-
malized Stokes parameters S
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When external polarizers are used, this command should be executed when 
the desired state of polarization has been set using an external polarizer. The 
command execution places the specified marker, as observed on the Poincare 
sphere, at the resulting state of polarization. The resulting state of polarization 
is returned as the normalized Stokes parameters S

0
, S

1
,S

2
,S

3
. 

The main purpose of this command is for use in placing and reading markers 
when external polarizers are utilized. Specifically, this is done when perform-
ing a Jones matrix measurement, a polarization dependent loss measurement, 
or when the application of a two- or three-point reference frame is required. 

Range:Auto{? | :Off | :On}

Through this command, the range function auto mode is, as specified by the 
user, turned on or off. The query returns an ASCII "1" if the range function is 
in auto mode and an ASCII "0" if it is not. 

Range:{Done | Down | Up}

When the auto function is turned Off, the user may, through this command, 
increase Up or decrease Down the power measurement range of the 
Agilent 8509C. (See “Range:Auto{? | :Off | :On}” on page 8-53). Using the Done 
parameter closes the Range frame in the analyzer window. 
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Range{? | :<GainValue>}

The query returns the gain range and the state of the autorange check box in 
the Range frame. "0"= not checked, "1"= checked. 

Using <GainValue> allows the range to be set and returns an error if autorange 
is on. The valid values for <GainValue> are 0 to 6, where 0 is the highest gain 
and 6 is the lowest gain. (This corresponds to Range:{Done | Down | Up}). See 
“Range:Auto{? | :Off | :On}” on page 8-53. 

RawDat?

Returns the raw ADC voltages, with offsets subtracted, associated with the 
four photodiode detectors within the Agilent 8509C receiver. The voltages are 
returned in terms of a scaled value in the range 0 to 65,535. Each value within 
that scale is proportionally related to a value from –10 to 10 volts. The sub-
tracted offsets correspond to the voltage values generated by the detectors 
under zero input conditions. The resulting information can be converted to 
voltage through the following equation: 

rawdat (volts) = ( obtained rawdat/65536 * 20 ) – 10 

RefFrame?

Returns information regarding the quality of a currently applied reference 
frame. If a two-point reference frame has been established, the command will 
return the polarization angle and a grade for the frame quality. If a three-point 
reference frame has been established, the command will return the transmis-
sion ratio and a grade for the frame quality. The definitions of the returned 
parameters are provided below: 

polarization angle = 90 / ( pi * Acos(angle between 2pts) ) 

In the above equation, "angle between 2pts" refers to the angular separation, 
as observed in the Poincare sphere, between the two state-of-polarization 
points used to establish the two-point reference frame. 

transmission ratio = The ratio of the highest polarization dependent loss to 
the lowest polarization dependent loss of the thrupath used to establish the 
three-point reference frame. A small transmission ratio is a desirable result. 
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The grading system for the applied reference frame is: 

* invalid = 0 
* very poor = 1 
* poor = 2 
* fair = 3 
* good = 4 

RefFrame:{Off | On}[?]

Applies or un-applies a two- or three-point reference frame. (See “Ref-
Frame:{2pt | 3pt}[?]” on page 8-55.) If using internal polarizers, the reference 
frame is set up and applied (or not applied) automatically. With external polar-
izers, the appropriate markers must first be placed and read using the Pol-
Marker?:{A|B|C} command. The query returns an ASCII "1" if the specified 
function (Off | On) is active and a "0" is returned if it is not active. 

RefFrame:{2pt | 3pt}[?]

Specifies the type of reference frame to be applied. The query returns an 
ASCII "1" if the specified function {2pt | 3pt} is active and a "0" if it is not active. 
See “RefFrame:{Off | On}[?]” on page 8-55. 

Save:Config:<“filename”>

Saves the current instrument configuration into the file <“filename”>. For 
path information on "filename", see “Command Syntax” on page 8-27. 

Save:Disper:<“filename”>

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Disper:Save:<“filename”>” on page 8-41. 

Save:Jones:<“filename”>

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Save:PolDep:<“filename”>” on page 8-56. 
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Save:PolDep:<“filename”>

Saves a Jones matrix measurement/polarization dependent loss measurement 
to the file "filename". The file format is: 

<Absolute Measurement Flag>,<PDL Delta>,<PDL Max>,<PDL Min>
<J00.real>,<j00.imag> 
<J01.real>,<j01.imag> 
<J10.real>,<j10.imag> 
<J11.real>,<j11.imag>

Where <Absolute Measurement Flag> is "1" if the measurement is absolute 
and "0" if the measurement is relative. In the case of a relative measurement, 
<PDL Max> and <PDL Min> are both "0". For path information on "filename", 
see “Command Syntax” on page 8-27. 

Save:Single:<“filename”>

Saves a timed measurement to the "filename". The file format for the data is:    

<Wavelength of Source>
<S0, milliWatts>, <S1>, <S2>, <S3>, <DOP %>
. 
. (one line for each point) 
. 

The Stokes parameters are un-normalized. For path information on "filename", 
see “Command Syntax” on page 8-27. 

SerialNum?

Returns the serial number of the Agilent 8509C lightwave polarization ana-
lyzer. 

SetMarker:<S0>:<s1>:<s2>:<s3>:{A | B | C}

Sets the specified marker to a polarization state given by the normalized 
Stokes parameters S
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Single

Places the Timed measurement frame on the analyzer window. 

Single:Done

Closes the Timed measurement frame in the analyzer window. 

Single:DBase:Load:<“title”>

Loads a measurement from the current database with the specified title. 

Single:DBase:Save:<“title”> [:<“date code”> [:<“serial number”>]]

Saves a measurement to the current database with the specified title. 

Single:Freq{? | :<Hertz>}

Sets the timed measurement sampling frequency to be used. The frequency 
must correspond to a period with a resolution of 1 millisecond. The query 
returns the frequency. 

Single:Mode{? | :Single | :Timed | :FreeRun}

Sets the timed measurement mode. The query returns the mode. 

Single:Period{? | :<Seconds>}

Sets the timed measurement period. The query returns the period. 

Single:Points{? | :<NumPoints>}

Sets the number of sample points used in the reading of a timed measurement 
trace. 

Single:Start

Triggers the reading of a timed measurement trace. 
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Source?

Upon command reception, the analyzer returns a string which specifies the 
source settings of the Agilent 8509C analyzer window. In addition, the wave-
length, in nm, of the active source is returned. If a source is not currently 
turned on, the parameter off is returned instead of the source wavelength. 
The string is in the form of: 

<Name of Laser Source>,{<Wavelength nm> | off} 

The names of the laser sources are: 

Voltage tuned 
Agilent8164A/HPIB
Agilent8167A/HPIB 
Agilent8168A/HPIB 
Manually tuned 

Source:External?

The analyzer returns the wavelength, in nm, of the currently activated exter-
nal source for the analyzer window. 

Source:External:{Off | On}

Not Recommended 

Command may not be available in future versions. Plan your programming 
accordingly. 

Specifies the use of an external source and the state {Off | On} of the utilized 
external source. 

DDE only.

Note

The source settings for the analyzer window, the PMD:JME window, and the PMD:WS 
window are independently set. When a polarization mode dispersion measurement 
(PMD) is initiated, the analyzer window inherits the settings of that PMD measurement. 
The Source? command returns the setting of the analyzer window at the time of the 
command. 
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Source:External:<Wavelength nm>

Specifies the external source wavelength. The wavelength should be specified 
in nm. The settings for all open windows are affected. See Note in 
“Source:External:{Off | On}” on page 8-58 for information on TLS. 

Source:HPIB[?]

Sets the tunable laser source for the analyzer window to an HPIB TLS. The 
Agilent 8509C looks for a tunable laser source at the address specified with 
TLS:Address and uses it if it is an Agilent 8164, Agilent 8167, or Agilent 8168 
tunable laser source. 

The query returns two parameters. 

first: "0" (not HPIB TLS), "1" (HPIB TLS) 
second: The name of tunable laser source.

DDE only. 

Source:HPIB:{Off | On | <Wavelength nm>}

Specifies the state, Off | On, or the wavelength setting of the HPIB source. 
When turned on or set using <Wavelength nm>, the Agilent 8509C system 
automatically determines which tunable laser source (Agilent 8164, 
Agilent 8167, or Agilent 8168) is connected to the HPIB bus at the address set 
using TLS:<HPIB address>.

DDE only. 

Source:Manual[?]

Places the analyzer window in manual control mode. When the instrument is 
under manual control, the user must set the tunable laser source to the appro-
priate wavelength for each wavelength point. 

Note

The external TLS controlled is the last TLS selected. The LPA will automatically select 
the Manual TLS as the default unless another TLS (HPIB controlled 
Agilent 8164/8167/8168 or Voltage Tuned) has previously been selected. 
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The query returns two parameters: 

first: "0" (not manually tuned), "1" (manually tuned) 
second: The type of optical-source-setup source. 

Source:Shutter?

Returns an ASCII "1" if the shutter is currently activated (on) and returns an 
ASCII "0" if the shutter is not activated (off). See “Source:Shutter:{Off | On}” 
on page 8-60. 

Source:Shutter:{Off | On}

This command controls the shutter located in the path to the OPTICAL OUTPUT 
port of the Agilent 8509C. Any external source coupled into the external 
source port of the Agilent 8509C share a common instrument internal path to 
the optical output port of the Agilent 8509C. By sending the parameter on, a 
shutter in the path to the optical output port can be activated so that the 
source output is blocked. The shutter can also be removed by sending the 
parameter off. 

Source:VTune[?]

Sets the Optical Source Setup source selection to VTune in order to control a 
VTUNE tunable laser source. 

The query returns two parameters: 

first: "0" (not VTUNE), "1" (VTUNE) 
second: The type of optical-source-setup source. 

Source:VTune:{Start | Stop}{? | :<Voltage>}

The VTUNE start or stop voltage. The query returns the voltage value, the 
parameter <Voltage> sets the value. The settings for the analyzer window is 
affected if not a query. The query returns settings for the analyzer window. 

Status?

This command waits until all previous commands have executed and then 
returns the status of the last command. In this way it is similar to *OPC?. 
Append the Status? command to the command whose status is requested 
(separate the commands with a semicolon). If Status? returns either "FAIL" or 
"PROBLEMS", then a description of the problem may follow the return value. 
Return values are: 
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"PASS"  Command successful. 

"FAIL" 
<Optional Description> Command failed. 

"PROBLEMS" 
<Optional Description> Errors occurred during execution. 

"UNKNOWN"  Command not recognized. 

Stokes:<NumPoints>

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Stokes?:<NumPoints>” on page 8-61. 

Stokes?:<NumPoints>

Measures the input signal and returns degree of polarization (DOP) and 
Stokes parameter test data in the form of S

0
, S

1
, S

2
, S

3
, DOP. The measurement

is made by averaging over "npnts" points. S
0
 is linear power (milliwatts), S

1
, S

2
,

S
3
 are the normalized Stokes parameters (range +1.0 to –1.0), and DOP is the 

degree of polarization (range 0 to ~1.2). 

TLS?

Returns the name of the current tunable laser source. Valid return values are: 

Voltage tuned 
Agilent8164A/HPIB 
Agilent8167A/HPIB 
Agilent8168A/HPIB 
Manually tuned 

TLS:Address{? | :<HPIB Address>}

This setting is used for all windows. The HPIB address of a tunable laser 
source on the HPIB bus. 

DDE only. 
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TLS:Isc{? | :<HPIB card ISC>}

This setting is used for all windows. The ISC of the HPIB card installed in the 
Agilent 8509C instrument controller. 

DDE only. 

TLS:Power{?| :<Power>}

This setting is used for the analyzer window only. The power setting of the 
HPIB tunable laser source. The units are set in TLS:Unit:<units>. 

DDE only. 

TLS:{SettlePoint | SettleStart}{? | :<Millisec’s>}

Not Recommended 

Command may not be available in future versions. Plan your programming to 
use the alternate command: “Disper:Settle:{Point | Start}{? | :<Delay msec>}” 
on page 8-41. 

DDE only. 

TLS:Power:Unit{? | :dBm | :Watt}

The units of power for the HPIB tunable-laser-source power. This setting is 
used for the analyzer window only. See also: “Disper:Power:{dBm | 
uWatt}[:<value>]” on page 8-40 and “WaveScan:Power:{dBm | 
uWatt}[:<value>]” on page 8-66. If the power setting is not valid for the TLS, 
the command fails. 

DDE only. 

Trace:Points:<NumPoints>

Not Recommended

Although this command was documented for Version 1.x code, it was never 
implemented. This command is not valid. Command will not be available in 
future versions. Plan your programming to use the alternate command: “Sin-
gle:Points{? | :<NumPoints>}” on page 8-57.

Version?

Returns the current version number of the Agilent 8509C software. 
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WaveScan[?]

Shows the PMD:WS window on the display. Be sure to send ‘WaveScan’ before 
sending any other ‘WaveScan:....’ commands. The query returns the polariza-
tion mode display (PMD) values of the measurement as follows: 

Current wavelength (nm), Total PMD, PMD for s
1
, PMD for s

2
, PMD for s

3
 

WaveScan:Analysis?

Returns the type of analysis used to calculate the polarization mode display 
(PMD). Valid values are: 

Peaks,FullScan 
Peaks,FirstToLast 
Extrema,FullScan 
Extrema,FirstToLast 

WaveScan:Analysis:{Extrema | Peaks}:{FullScan | FirstToLast}

Sets the type of analysis to use in calculating the polarization mode dispersion 
(PMD). 

WaveScan:Atten{? | :<dBm value>}

The attenuation for the HPIB tunable laser source. The query returns the 
attenuation in dBm. Using <dBm value> sets the attenuation for an HPIB tun-
able laser source. If the attenuation setting is not valid for the TLS, the com-
mand fails. 

DDE only. 

WaveScan:Clear

Aborts a PMD:WS measurement process. This command is valid only if the 
optical source is set to Manual. 

Note

The running totals are returned. The measurement may not be complete. 
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WaveScan:Close

Closes the PMD:WS measurement window. The PMD:WS measurement pro-
cess is ended. 

WaveScan:DBase:Load:<“title”>

Loads a measurement from the current database using the specified title. 

WaveScan:DBase:Save:<“title”> [ :<“date code”>[<“serial number”>]]

Saves a measurement to the current database using the specified title. 

WaveScan:Feature{? | :<Min Feature Size>}

The query returns the minimum size of features (maxima and minima) that 
are considered for the analysis type selected. The query returns the value for 
the minimum size of features. 

WaveScan:FiberLen{? | :<km>}

The query returns the length of optical fiber used to normalize PMD:WS mea-
surements. Using <km> sets the length of optical fiber. 

WaveScan:HPIB[?]

Sets the tunable laser source for a PMD:WS measurement to an HPIB tunable 
laser source. The Agilent 8509C looks for a tunable laser source at the address 
specified with TLS:Address and uses it if it is an Agilent8164, Agilent 8167, or 
Agilent 8168 tunable laser source. Be sure that the wavelength range is set 
correctly for the connected HPIB tunable laser source before issuing this com-
mand. To change tunable laser source selections between Agilent8164, Agilent 
8167, and Agilent 8168: 

1 Issue the command WaveScan:Manual 

2 Change the wavelength range using WaveScan:WLen: 

3 Change the HPIB address using TLS:Address:<HPIB Address>

4 Issue the command WaveScan:HPIB 

The query returns an ASCII "1" if the PMD:WS next measurement process will 
be in HPIB mode and a "0" if it will not be in this mode. Also returns the name 
of the current laser source. 
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DDE only. 

WaveScan:Manual[?]

Places the PMD:WS measurement in manual control mode. When the instru-
ment is under manual control, set the tunable laser source to the appropriate 
wavelength for each wavelength point between the start and stop wave-
lengths. The query returns two parameters. In manual control mode, send the 
command "WaveScan:Measure" once to begin the measurement process and 
once for each wavelength point as returned by the command "WaveS-
can:WLen:Points?" 

The query returns an ASCII "1" if the PMD:WS next measurement process will 
be in MANUAL mode and a "0" if it will not be in this mode. Also returns the 
name of the current laser source. 

WaveScan:Measure

Initiates a PMD:WS measurement. If the tunable laser source is "Manually 
Tuned", then send this command for each point in the wavelength range. 

WaveScan:Mode{? | :<Mode Constant>}

The Mode Calculation Constant (k) is set or queried. 

WaveScan:PmdResult{? | :Avg | :Max | :Median}

The PMD:WS total is calculated in one of three different ways, using the aver-
age, maximum, or median value of the polarization mode display (PMD) val-
ues calculated for the s

1
, s

2
, and s

3
 traces. This command selects the type of 

PMD total to calculate. The query returns the type of PMD result. 

WaveScan:Polarizer{? | :A | :B | :C | :None}

The internal polarizer to insert before starting the PMD:WS measurement. 
The query returns the selected polarizer. 

WaveScan:Power?

Returns the power and the power units for the tunable laser source. 

DDE only. 
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WaveScan:Power:{dBm | uWatt}[:<value>]

Sets the power units for the tunable laser source (TLS). If the <value> param-
eter is specified, the power setting can also be changed. If the power setting is 
not valid for the TLS, the command fails.

DDE only. 

WaveScan:Save:<“filename”>

Saves a PMD:WS measurement trace into the file <“filename”>. The trace is 
saved as a series of ASCII strings separated by commas. Each line of the saved 
trace information is in the form of: 

Wavelength_1, Power(dBm), s
1
, s

2
, s

3
, DOP(%) 

. 

. 

. 
Wavelength_n, Power(dBm), s

1
, s

2
, s

3
, DOP(%) 

The above is for the dispersion measurement at "n" user defined wavelengths. 
The Stokes parameters are normalized. For path information on "filename", 
see “Command Syntax” on page 8-27. 

WaveScan:Settle:{Point | Start}{? | :<Delay msec>}

The settling time to wait, either initially (Start) or per point (Point), after set-
ting a tunable laser source to the desired wavelength in the sweep range dur-
ing a PMD:WS measurement. The query returns the current value. See also: 
“Disper:Settle:{Point | Start}{? | :<Delay msec>}” on page 8-41. 

WaveScan:Units:{? | :ps | :ps/L | :ps/sqrtL}

The units to use in PMD:WS measurements. The query returns the selected 
units. 

Note

When changing only the units, the numerical value of the power does not change. Be 
sure to change the value of the power to correspond to the new units. 
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WaveScan:VTune[?]

Sets the Optical Source Setup source selection to VTune in order to control a 
VTUNE tunable laser source. 

The query returns an ASCII "1" if the PMD:WS next measurement process will 
be in VTUNE mode and a "0" if it will not be in this mode. Also returns the 
name of the current laser source. 

WaveScan:VTune:{Start | Stop}{? | :<Voltage>}

The VTUNE start or stop voltage. The query returns the voltage value, the 
parameter <Voltage> sets the value. 

WaveScan:WLen?

Returns the next wavelength (in nm) at which the PMD:WS measurement will 
be conducted. This command is typically used only when the tunable laser 
source is "Manually Tuned". 

WaveScan:WLen:{Start | Stop | Delta}{? | :<Wavelength nm>}

Specifies the Start, Stop, or Delta wavelengths for the PMD:WS measurement. 
Changing any of these values causes the number of points to change according 
to: 

WLenPoints = ((WLenStop – WLenStart) / WLenDelta) + 1 

The query returns the value of the setting in nanometers. Using the <Wave-
length nm> parameter sets the value. 

Note

The Start and Stop values can never have the same value. For example, when segment-
ing a wavelength range over several measurements and sweeping from low to high, 
always issue the command WaveScan:WLen:Stop before the command WaveS-
can:WLen:Start when specifying the next wavelength segment. This will prevent the 
Start and Stop values from being equal when switching from one segment to the next. 
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WaveScan:WLen:Points{? | :<NumPoints>}

Sets the number of points between the start and stop wavelengths for the 
polarization mode display (PMD) measurement. Each point corresponds to a 
wavelength for PMD measurement. If the number of points does not correlate 
with the delta value and the start and stop wavelengths, the delta value is 
reset to accommodate the number of points according to: 

WLenDelta = (WLenStop – WLenStart) / (WLenPoints – 1) 

The query returns the number of points specified in the current PMD:WS 
measurement settings. 

Zero

Causes the measurement offsets to be referenced as a zero measurement 
state. The measurement offsets correspond to the voltages generated by the 
receiver photodiodes under a zero input condition. A zero valued measure-
ment state can thus be established by the user at any time during a measure-
ment process. 
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Specifications and Regulatory Information

This chapter lists specification and characteristics of the instrument. The dis-
tinction between these terms is described as follows: 

Specifications are the warranted performance. 

• Specifications describe warranted performance standards or limits against 
which the Agilent 8509C can be tested over the temperature range 23°C ±5°C 
and relative humidity <95% (unless otherwise noted). All specifications apply 
with the instrument oriented upright on a horizontal surface and warmed up 
for at least one hour. 

• Characteristics provide useful information by giving functional, but nonwar-
ranted, performance parameters. Characteristics are printed in italics. 

Calibration Cycle

This instrument requires periodic verification of performance. The instrument 
should have a complete verification of specifications once every year.
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General Specifications

Table 9-1. General Specifications

Use Indoor

Power (without instrument 
controller or monitor)

90 V to 132 V or 198 V to 264 V
100 VA

Voltage Mains supply voltage fluctuations not to exceed ±10% of the 
nominal voltage

Frequency 47.5 Hz to 66 Hz

Altitude Up to 2000 m

Operating temperature 5°C to 40°C

Maximum relative humidity 80% for temperatures up to 31°C decreasing linearly to 50% 
relative humidity at 40°C (unless otherwise specified)

Weight (without instrument 
controller or monitor)

10.5 kg (23 lbs)

Dimensions (H × W × D) 133.4 mm x 425.5 mm x 546.1 mm
5.25 in x 16.75 in x 21.5 in
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Warranted Specifications 

The warranted specifications on the lightwave polarization analyzer are valid 
over the temperature range of 23°C ±5°C, with the instrument oriented 
upright on a horizontal surface and warmed up for at least one hour. 

Polarization mode dispersion (PMD) specifications, 
JME method

The Jones matrix eigenanalysis (JME) method measures the differential 
group delay (DGD) of the test device as a function of wavelength. Average 
DGD (or PMD) is taken as the average of the DGD values across the wave-
length range. The measurement requires a tunable wavelength, single-line 
laser source such as the Agilent 8168A Tunable Laser Source. The JME mea-
surement is operational over the ranges of 1280 to 1340 nm and 1470 to 
1640 nm, however, the DGD uncertainty specification is warranted over the 
wavelength range of 1540 to 1560 nm. 

Table 9-2. Maximum Measurable DGD Using JME Delay 

Maximum Measurable DGD Using JME Methoda

a. Maximum measurable PMD delay = π / radian optical frequency interval.

Wavelength Step 1310 nm 1550 nm 

0.01 nm 280 ps 400 ps 

0.10 nm 28 ps 40 ps 

1.0 nm 2.8 ps 4 ps 

10.0 nm 0.28 ps 0.4 ps 
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Table 9-3. PMD Measurement Uncertainty Using the JME Method

PMD Measurement Uncertainty a,b,c,d

a. Receiver input level –20 to –40 dBm.
b. Does not include external laser tuning accuracy.
c. Measurement averaging set to 500 points.
d. PMD is the average value of DGD across the measurement wavelength range.

Wavelength Step Uncertainty (±) 

0.10 nm 310 fs 

1.0 nm 90 fs 

10.0 nm 60 fs 
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Characteristics

Jones matrix eigenanalysis PMD measurement 

Table 9-4 shows the repeatability of a measurement of a 0.218 ps quartz PMD 
standard in which the fibers do not move between measurements. 

Table 9-4. Repeatability of JME PMD Measurement with Fixed Pigtail Positions

Repeatability of JME PMD Measurement a,b,c,d

a. Test device is a pigtailed quartz PMD standard, under development.
b. Measurement wavelength range of 1500 to 1560 nm.
c. Measurement wavelength interval of 10 nm.
d. No movement of test device or pigtails between measurements.

Number of measurements 20 measurements 

Expected value of DGD 0.218 ± 0.010 ps e

e. The ± 0.010 ps tolerance is provided to allow for the effects of pigtails and packaging.

Mean 0.2173525 ps 

Standard deviation 0.0000085 ps 

Maximum - minimum 0.00003 ps 

Maximum 0.21737 ps 

Minimum 0.21734 ps 
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Table 9-5 shows the repeatability of 20 measurements of a pigtailed quartz 
PMD standard in which Pigtail positions are randomized before each measure-
ment. 

Table 9-5. Repeatability of JME PMD Measurement with Randomized Pigtail 
Positions

Repeatability of JME PMD Measurement a,b,c,d

a. Test device is a pigtailed quartz PMD standard, under development.
b. Measurement wavelength range of 1500 to 1560 nm.
c. Measurement wavelength interval of 10 nm.
d. Reposition pigtails randomly before each measurement.

Number of measurements 20 measurements 

Expected value of DGD 0.218 ± 0.010 ps e

e. The ± 0.010 ps tolerance is provided to allow for the effects of pigtails and packaging.

Mean 0.21821 ps 

Standard deviation 0.00246 ps 

Maximum - minimum 0.00787 ps 

Maximum 0.22271 ps 

Minimum 0.21484 ps 
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Wavelength scanning PMD measurement 

Table 9-6 shows the minimum measurable PMD for the wavelength scanning 
method for two types of devices. Non-mode coupled devices include most 
components. Highly mode coupled devices include most long, single-mode 
optical fibers. 

Table 9-6. Minimum Measurable PMD Using the Wavelength Scanning Method

Minimum Measurable PMDa

a. Assumes 100 nm wavelength tuning range.

Type of test device Minimum measurable PMD value 

non-mode-coupled devices b 
(most components)

b. Assumes a single peak and a single valley.

0.040 ps 

highly mode-coupled devices c (long fibers)

c. Assumes an average of 3 cycles of polarization change (4 peaks).

0.195 ps 
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Comparison of JME and wavelength scanning methods 

The figure below is a comparison between the Jones matrix eigenanalysis and 
wavelength scanning measurement methods. Agilent 8509C JME and WS mea-
surements agree to within approximately +15% for this test device. 

 

Comparison of JME and WS measurement methods for long optical fiber test

Comparison of JME and WS Measurement Methods for Long Optical 

Fiber Test 

1 The test device was 14 km of loosely-spooled, dispersion-shifted fiber. Eleven 
measurements of each type were taken with random arrangements of the loose 
turns of the fiber.

2 Wavelength scanning responses typically exhibited 16 extrema (# of extrema = 
# of peaks + # of valleys).

3 Wavelength scanning measurements use mode coupling factor of 0.82.
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Receiver characteristics 

Table 9-7. Receiver Characteristics

Wavelength operating range a

a. The Agilent 8509C performs polarization measurements over this range. See individual measurement
specifications or characteristics for details.

1280 to 1640 nm 

Input power operating range +10 to –55 dBm 

Input average power damage level +16 dBm 

Average power measurement uncertainty b

b. Does not include the effects of optical connectors.

±15% 

Degree of polarization measurement uncertainty c,d,e

c. Uncertainty introduced in defining an external reference frame in open beam applications is not included.
d. 500 point display averaging (running average).
e. Characteristic applies for 100% polarized light for the purpose of practical verification.

1280 to 1340 nm, ±2.0% 
1470 to 1580 nm, ±2.0% 
1580 to 1630 nm, ±3.0% 
1630 to 1640 nm, ±5.0%

Poincare representation uncertainty d,f,g,h

f. Characterized in degrees on the Poincare sphere.
g. For input light at least 98 percent polarized. Uncertainty increases as degree of polarization decreases.
h. For uncertainty in the angle between two displayed points, multiply by two.

1200 to 1340 nm, ±1.5° 
1470 to 1640 nm, ±1.5° 

Measurement rate > 3500 per second 

Display update rate > 3500 per second 
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Polarization dependence, Jones matrix method 

Polarization dependence, power max–min method 

Table 9-8. Measurement of Polarization Dependence Jones Matrix Method

Measurement of Polarization Dependence, Jones Matrix Method a,b

a. Polarization dependence is the peak to peak variation in transmission of the device under test over all
polarization states.

b. Specified with single-line laser source.

Polarization dependence wavelength operating range 1280 to 1340 nm 

1470 to 1620 nm 

Polarization dependence uncertainty c,d,e

c. For measured values less than 3 dB, receiver input level > –20 dBm.
d. Does not include the effect of optical connectors.
e. Measurement averaging set to 500 points.

±0.1 dB 

Table 9-9. Measurement of Polarization Dependence Power Max–Min Method

Measurement of Polarization Dependence Power Max - Min Method a,b

a. Polarization dependence is the peak to peak variation in transmission of the device under test over all
polarization states.

b. Specified with single-line laser source.

Polarization dependence wavelength operating range 1280 to 1340 nm

1470 to 1620 nm 

Polarization dependence uncertainty c,d,e

c. For measured values less than 3 dB, receiver input level > –20 dBm.
d. Does not include the effect of optical connectors.
e. Measurement averaging set to 500 points.

±0.1 dB 
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Other characteristics 

Table 9-10. External Source Input Port, Fiber Size, and Analog Output Range 
Characteristics

Wavelength operating range 1280 to 1640 nm 
Insertion loss a

a. Internal path loss between EXTERNAL SOURCE INPUT and OPTICAL OUTPUT connectors with no polarizer
selected.

8.5 dB 

Return loss b,c

b. Does not include the effects of optical connectors.
c. When optical output is connected with return loss of 30 dB or better.

35 dB 

Compatible fiber 9/125 micron
Analog output range ±10 volts 
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Regulations and Licensing

Notice for Germany: Noise Declaration

Acoustic Noise Emission/Geraeuschemission

LpA < 70 dB LpA < 70 dB

Operator Position am Arbeitsplatz

Normal Position normaler Betrieb

per ISO 7779 nach DEN 45635 t. 19
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Declaration of Conformity
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E
edit menu, 2-3
end of line, 8-29
EOL, 8-29

F
fiber optics

care of, i-v
cleaning connections, 7-14
connectors, covering, 7-28

file menu, 2-3
Jones matrix, 3-10
polarization dependence, 3-10
polarization mode dispersion, 3-10
single sweep trace, 3-10

filename, 8-27
foam swabs, 7-21
format, 4-19
frame, 8-29
fuse values, i-iii

H
Help menu, 2-3
histogram, JME, 4-22

I
IEC Publication 61010-1, i-iii
input

connector, i-v, 7-14
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instrument, returning for service, 7-27

J
Jones matrix, 3-10

measurement, 4-70
Jones Matrix Eigenanalysis (JME), 8-29

PDL measurement, 4-54
PMD measurement, 4-5

L
licensing, 9-13
line-power

cables, 7-12
specifications, 9-3

LPA, 8-29

M
main menu, 2-3

display menu, 2-3
edit menu, 2-3
file menu, 2-3
help menu, 2-3
measurement menu, 2-3
system menu, 2-3

Mandatory Selection, 8-27
marker, centering the sphere, 2-8
markers

clear, 2-8
on/off, 2-7

measurement
annotation area, 4-18
data, 3-2
format, 4-19
menu, 2-3
summary bar, 4-17

N
noise emission, 9-13

O
OBSOLETE, 8-29
Optical Source Setup (OSS), 8-29
options and accessories, 7-11

overrange message, 2-4

P
packaging for shipment, 7-28
PDL, 8-29
PDL measurement

Jones matrix, 4-54
power meter, 4-64

pipe, 8-27
PMD, 8-29
PMD measurement

Jones matrix eigenanalysis, 4-5
wavelength scanning, 4-38

PMF alignment, 4-79
poincare sphere, 2-4

trace recalled/saved, 3-2
polarization

coordinate system, 7-9
dependence, 3-10
ellipse, 2-4
maintaining fiber launch, 4-79
mode dispersion, 3-10
reference frame, 4-85
right-handed circular, 7-9

Polarization Dependent Loss. See PDL

Polarization Mode Dispersion. See PMD

power display, 2-4
overrange message, 2-4
underrange message, 2-4
zero message, 2-4

power meter measurement, PDL, 4-64
print

graph, 4-27
tabular format, 4-21

Q
Query, 8-27
question mark, 8-27

R
recalling data, 3-2
receiver characteristics, 9-6
reference frame

apply, 2-9
define, 2-9

book.book  Page 2  Thursday, March 29, 2001  12:14 PM



Index-3

Index

three-point, 2-9
two-point, 2-9

regulations, 9-13
regulatory duration, 9-2
returning for service, 7-27

S
safety, i-iii

laser classification, i-iii
sales and service offices, 7-30
save

as window, 3-10
database format, 4-28
Jones matrix, 3-10
polarization dependence, 3-10
polarization mode dispersion, 3-10
single sweep trace, 3-10
text file, 4-28

saving data, 3-2
Selection Separator, 8-27
service, 7-27

returning for, 7-27
sales and service offices, 7-30

set markers
at current data point, 2-5
at user-specified point, 2-5

shipping procedure, 7-28
single sweep trace, 3-10
SOP measurements, 4-93
specifications, 9-2

definition of terms, 9-2
operating, 9-3

state of polarization measurements, 4-93
statistical display, 4-22
string, 8-29
swabs, 7-21
system menu, 2-3

T
text files

Jones matrix, 3-10
polarization dependence, 3-10
polarization mode dispersion, 3-10
saving, 4-28
single sweep trace, 3-10

timed measurements, 4-103

Tunable Laser Source (TLS), 8-29

U
underrange message, 2-4

V
VTUNE, 8-29

W
wavelength-scanning (WS), 8-29

PMD measurement, 4-38

Y
Y-scale, changing graph, 4-20

Z
zero message, 2-4
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	8509C User’s/Reference Guide
	General Safety Considerations
	WARNING No operator serviceable parts inside. Refer servicing to qualified personnel. To prevent ...
	WARNING For continued protection against fire hazard, replace line fuse only with same type and r...
	WARNING Verify that the value of the line-voltage fuse is correct.
	WARNING This is a Safety Class 1 product (provided with a protective earthing ground incorporated...
	WARNING To prevent electrical shock, disconnect the Agilent�8509C from mains before cleaning. Use...
	WARNING If this instrument is not used as specified, the protection provided by the equipment cou...
	WARNING Do not stare directly into any optical port or into the ends of optical fiber patch cords...
	WARNING When a laser source is connected to the Agilent 8509C external source input, the Optical ...
	WARNING To avoid inadvertent exposure to laser light, extinguish the external laser source and en...
	WARNING Use of controls or adjustments or performance of procedures other than those specified he...
	CAUTION Always use the three-prong ac power cord supplied with this product. Failure to ensure ad...
	CAUTION This product is designed for use in Installation Category II and Pollution Degree�2 per I...
	CAUTION VENTILATION REQUIREMENTS: When installing the product in a cabinet, the convection into a...
	CAUTION Maximum input power: The optical damage level for the Agilent 8509C Optical Input port is...
	Laser Aperture Location
	Measurement accuracy—it’s up to you!



	1
	Setting Up the Lightwave Polarization Analyzer
	2

	A Quick Tour
	3

	Using the File Menu
	4

	Using the Measurement Menu
	5

	Using the Display Menu
	6

	Using the System Menu
	7

	Reference
	8

	Measurement Programming and Examples
	9

	Specifications and Characteristics

	Setting Up the Lightwave Polarization Analyzer
	Setting Up the Lightwave Polarization Analyzer
	Setting Up the Lightwave Polarization Analyzer
	• Tips on avoiding costly repairs by proper optical connection cleaning techniques.
	• List of available options, accessories, and power cords.
	• Instructions on returning your instrument to Agilent Technologies for service.
	• Agilent Technologies service offices.
	• Accuracy enhancement and troubleshooting information.

	Installation
	Tools needed
	Installation overview

	Power Requirements
	Table�1�1.� Fuses
	Note
	Figure�1�1.� Voltage selector

	CAUTION Do not attempt to rotate the voltage selector cam while it is installed in the line modul...
	1 Pry open line module cover door.
	2 Pull out fuse carrier.
	3 Insert fuse of proper rating.
	4 Place carrier back into line module.
	1 Pry open line module cover door.
	2 Remove cam from the line module.
	3 Rotate the cam to the desired voltage. (When the line module cover is closed, the selected volt...
	4 Insert the cam back into the line module.
	5 Close the line module cover door.


	Step 1. Unpack and Inspect the System
	Figure�1�2.� Package contents for the Agilent�8509C
	Inspect the shipping container for damage.
	Inspect the instrument.
	Verify that you received the options and accessories you ordered.
	Gather the items shown in Figure�1�2, and put all other hardware, documentation, and software asi...

	Step 2. Stack and Connect the System
	Figure�1�3.� Agilent�8509C system
	1 Set the lightwave polarization analyzer on your work surface. Place the instrument controller n...
	Note

	2 Connect the system as shown in Figure�1�4.
	a Connect the lightwave polarization analyzer to the instrument controller using the dedicated in...
	b Connect the monitor, keyboard, and mouse to the instrument controller. Refer to Figure�1�4 for ...
	c Tighten connections with a small flat-blade screwdriver.
	Figure�1�4.� System connections



	Step 3. Power Up the System
	1 Connect the three power cords (one each from the instrument controller, the monitor and the ana...
	2 Press the front-panel power switches on the analyzer, instrument controller, and monitor.
	3 After the instrument controller is turned on, Microsoft Windows and the Agilent�8509C software ...
	Figure�1�5.� The Agilent�8509C user interface basic measurement screen

	4 Perform the operation verification now to ensure the lightwave polarization analyzer is working...

	Step 4. Operation Verification
	Figure�1�6.� Agilent�8509C front panel
	Required Equipment
	• Optical source of known wavelength in one of the two following ranges.
	• High-quality single mode patchcords. Refer to Table�1�2.
	Table�1�2.� Recommended Patchcords
	Preliminary Steps

	1 Turn on the lightwave polarization analyzer and allow it to warm up for at least one hour.
	2 Clean all optical connectors and adapters using isopropyl alcohol and cotton swabs. Refer to “C...
	3 Ensure that the optical cable connecting the external source to the lightwave polarization anal...
	4 Connect the equipment as shown in Figure�1�7 on page�1�14.
	5 Zero the analyzer by selecting System and then Zero. You will notice the green zero message wil...
	Figure�1�7.� Equipment setup
	Setup Your Source

	6 Select l. The Optical Source Setup window will appear on the display, as shown in Figure�1�8.
	Figure�1�8.� Optical Source Setup window

	7 Select your source type from the Optical Source Selection menu.
	8 Input the wavelength of your optical source (to an accuracy of ±1 nm) using the keyboard.
	9 Select Done. The optical source setup window will disappear.
	Adjust For Maximum Power

	10 Adjust the two large External Source Polarization knobs to obtain maximum power into the recei...
	Figure�1�9.� Agilent�8509C basic measurement screen
	Operation Verification

	11 Make sure that the optical cable connecting the polarizer to the lightwave polarization analyz...
	12 Select System from the main window display, then select Operation Verification.
	Figure�1�10.� Operation Verification window

	13 Select Start. When the verification procedure is finished, the message Operation Verification ...
	14 The operation verification is now complete. You may select Done to clear the window and begin ...


	A Quick Tour
	A Quick Tour
	A Quick Tour
	The Main Menu
	Figure�2�1.� The Agilent�8509C basic measurement screen

	Data Displays
	Power
	DOP
	Polarization ellipse
	Markers
	Figure�2�2.� The Marker window
	To set a marker
	• set a marker at the current data point, or
	• set a marker at a user-specified point on the sphere (regardless of where the current data poin...

	To set a marker at the current data point
	1 Select A, B or C (on the left side of the Marker window) to set a marker on the Poincare sphere...
	Additional Information
	Figure�2�3.� Setting a marker



	To set a marker at a user-specified point
	1 Move the mouse pointer to the point on the front face of the sphere where you want to place a m...
	2 Double-click the left button on the mouse. The Set Marker window appears below the Poincare sph...
	3 Use the mouse to select A, B, or C to set a marker at the place on the sphere where you double-...
	4 Notice that the Stokes parameters for that point appear in the marker table in the marker window.
	5 If you have decided not to set a marker and wish to close the Set marker window, select None.
	Figure�2�4.� Set marker window


	To turn the markers on and off
	Figure�2�5.� Turn markers on/off

	To clear the markers
	Figure�2�6.� Clear markers

	To center the sphere on a marker or current point
	Figure�2�7.� Center sphere on marker

	To set a two- or three-point polarization reference

	Poincare sphere
	Zoom and Rotate
	Figure�2�8.� Zoom and Rotate
	To zoom in or out
	To set the zoom factor
	• Select this function in a zoomed condition to immediately bring the zoom factor back to 1 witho...
	• Select this function when the factor is 1 to set the zoom factor to the most recently visited z...

	To rotate the sphere
	To return the sphere to the default orientation
	CAUTION Any time you rotate the sphere, the trace is cleared. The only exception to this is when ...
	Additional Information



	Clear Trace and Hold
	Figure�2�9.� Clear Trace and Hold
	To clear the Poincare sphere of previously displayed data points
	To activate the hold function

	l and Cal
	Figure�2�10.� l and Cal
	To display the Optical Source window
	To display the source wavelength
	To display whether a user-performed calibration has been applied


	The Menu Bar
	File menu
	Edit menu
	Measurement menu
	Display menu
	System menu
	Help menu


	Using the File Menu
	Using the File Menu
	The File Menu
	Figure�3�1.� File menu
	Additional Information
	Using the Load functions
	Figure�3�2.� Load menu
	To save and recall instrument configurations
	• First in the windows working directory.
	• Second in the application’s directory.
	• Finally in the Windows system directory.

	To create a configuration file with factory defaults
	1 From the lightwave analyzer Windows menu, select File, Load, PRESET Configuration.

	2 Select File, Save, User Configuration.
	3 Name the file. The application default file name is hp8509.cfg. Give the file this name if you ...
	Additional Information
	To recall the preset configuration
	Procedure
	1 Load the preset condition by selecting File, Load, PRESET Configuration.


	2 A window appears asking you to confirm the load preset command. See Figure�3�3. Select OK to lo...
	Figure�3�3.� PRESET confirmation window
	To recall a user configuration
	Procedure
	1 Select File, Load in the main menu.


	2 Select User Configuration.
	3 The Load: Configure File window opens. See Figure�3�4 on page�3�6.
	4 Choose a configuration to open by specifying the drive, directory and filename by typing the co...
	5 Select OK when the file you want appears in the File Name box.
	Figure�3�4.� Load: Configure File window
	To recall measurement results
	Agilent�8509C File Recall
	Procedure
	1 Select FILE, LOAD, and then one of the Load sub-menu selections shown in Figure�3�2 on page�3�4.


	2 For text files, select the drive, directory, and file where the desired trace is stored, and th...
	3 For database files, select the desired measurement from the drop-down list then select LOAD.
	Additional Information

	4 For a detailed description of the database file loading operation, refer to “To perform databas...
	5 To resume normal operation of the lightwave polarization analyzer, toggle the Hold function by ...
	Agilent�8509C File Recall
	Results
	Figure�3�5.� Viewing a stored Timed measurement trace on the Poincare sphere


	Word Processor, Spreadsheet and Database Numeric File
	Format

	PMD: Jones Matrix Eigenanalysis Save
	Format
	Example

	PMD: Wavelength-Scanning Save
	Format
	Example

	PDL: Jones Matrix and Jones Matrix Save
	Format
	Example

	Timed Measurement As Text Save
	Format
	Example
	Additional Information



	Using the Save functions
	Figure�3�6.� Save menu
	To save measurement results
	Additional Information
	Procedure

	1 To save measurement results, first make the desired measurement.

	2 Save the resulting data by selecting File, Save.
	3 Select one of the following items.
	4 You will see either the Save As: Text File window (Figure�3�7), or a dialog box for adding the ...
	Figure�3�7.� Save As: Text File window

	5 Specify the drive, path and filename by typing it in the File Name window, or type the filename...
	6 Once you have named the file, drive and directory, select OK, and the measurement data will be ...
	To save a user configuration
	Procedure
	1 Select File, Save from the main menu.


	2 Select User Configuration.
	3 The Save As: Configure File window opens. See Figure�3�8 on page�3�13.
	4 Enter the drive, path and filename by typing it in the File Name box, or by typing the filename...
	5 Select OK, and the file is stored.
	Figure�3�8.� File Save As: Configure File window


	Using the Print functions
	Figure�3�9.� Print menu
	To print measurement results
	Standard printing
	Procedure

	1 Select File, Print.

	2 Select one of the following options:
	Customized printing
	Results
	Figure�3�10.� Customized printing example

	Procedure

	1 Create the desired Agilent�8509C measurement display. You may choose to maximize the display by...

	2 Press Print Screen on the upper-right side of the Agilent�8509C instrument controller keyboard.
	3 Select Hold.
	4 Use the mouse to minimize the Agilent�8509C measurement window by selecting the down carrot in ...
	5 Locate the Accessories icon and select it using the mouse.
	6 When the Accessories icon opens, select the Paintbrush icon.
	7 When the Paintbrush program is running, select the View menu at the top of the screen. Select Z...
	8 Highlight the Edit menu and select Paste and Paste again.
	9 From the View menu, select Zoom In and begin customizing graphics and text.
	10 When the desired Paintbrush display is achieved, save it to a file name using the appropriate ...
	Table�3�1.� Summary of Agilent�8509C Measurement Results Save/Recall Features


	Using the Database functions
	Figure�3�11.� Database Interface
	To retrieve previously archived measurements
	To perform database operations



	Using the Measurement Menu
	Using the Measurement Menu
	The Measurement Menu
	Figure�4�1.� Measurement menu

	Making PMD Measurements
	Using the Jones matrix eigenanalysis method
	Figure�4�2.� Example of data display for a PMD:JME measurement
	• Differential group delay (DGD) is measured as a function of wavelength.
	• Measurement of low PMD components can be accomplished with a narrow wavelength range.
	• The measurement is independent of pigtail position and polarization launch condition.
	• Optical fiber DGD data can be shown in a histogram and compared with the expected distribution ...
	To make a PMD:JME measurement
	Measurement setup
	1 Connect your measurement system as shown in Figure�4�3. Install the thru cable for the one-time...
	Enhancing Accuracy
	Figure�4�3.� Measurement setup
	External source preparation

	Additional Information

	2 To set up the optical source, select System from the main menu, and then select Optical Source....
	Figure�4�4.� System menu

	3 Select the external tunable laser source and set the wavelength to the approximate center of th...
	Figure�4�5.� Optical Source Setup window

	4 Select System from the main menu, and then select Polarizers.
	Figure�4�6.� Polarizer selection menu

	5 Set the polarizers to Internal and select No Polarizer. If the screen on your instrument contro...
	Figure�4�7.� Polarizer setup window

	6 Select 3pt Ref from the Markers Area on the Main Screen, wait 5 seconds, and then select Apply ...
	Figure�4�8.� 3pt reference applied window
	Additional Information

	7 Adjust the External Source Polarization knobs on the front panel of the Agilent�8509C until the...
	Figure�4�9.� Circular polarization display
	Making the measurement

	8 Remove the fiber cable connecting the optical output to the optical input on the Agilent�8509C.
	9 Connect your test device between the optical output and the optical input.
	Enhancing Accuracy

	CAUTION Observe proper connection techniques. Refer to “Cleaning Connections for Accurate Measure...
	10 Select Measurement from the main menu, and then select PMD:Jones Matrix Eigenanalysis... F2.
	Figure�4�10.� JME measurement selection menu

	11 Verify that the source and start and stop wavelengths are correct for your measurement, and th...
	Figure�4�11.� JME Source Setup window
	Additional Information

	12 The window is called Find Minimum # of Points. Sample measurements will be performed to identi...
	Figure�4�12.� Segment selection window
	For More Information

	13 When the automatic routine is finished, you will be advised what minimum number of measurement...
	Figure�4�13.� Find Minimum # of Points window
	Enhancing Accuracy

	14 Select Done in the Optical Source Setup window.
	Figure�4�14.� Optical Source Setup for PMD: JME window

	15 Select Start Measurement from the Agilent�8509C Graphs screen.
	Figure�4�15.� PMD: JME measurement start window
	Figure�4�16.� Measurement results window



	To manipulate the measurement results
	• review the results in the Measurement Summary bar.
	• review the measurement setup conditions in the Measurement Annotation area.
	• examine the differential group delay at a particular wavelength, by using the cursor bar.
	• display, edit, and print the data in tabular form.
	• print the graph with or without measurement annotation and data listing.
	• save your measurement and annotation information to a database for future use, or to reload the...
	• save your measurement data as a text file for use with spreadsheets.
	• perform other PMD measurements without leaving the Graphs window.
	• display all of your measurements in one window, using windows tile or cascade modes.

	The Measurement summary bar
	Figure�4�17.� The Measurement summary bar window

	The Measurement annotation area
	Figure�4�18.� The Measurement annotation area window
	Additional Information

	The Cursor Bar window
	Figure�4�19.� The Cursor bar window
	To change the measurement format
	Figure�4�20.� Graphs Format menu
	1 Select Format from the Main Graphs window menu to access the measurement formatting functions. ...
	2 Choose Fiber Length... from the Format menu to enter the length of the fiber you have just meas...
	Additional Information


	To change the graph’s Y-scale
	Figure�4�21.� Graphs Y-Scale menu
	1 To change the vertical axis on the measurement graph, select Display and then Y-Scale from the ...
	Autoscale/Zero Based
	Autoscale
	Fixed Scale...


	To display data in tabular format
	Figure�4�22.� Graphs Tabular Data menu
	1 Display the tabular measurement data by selecting Display and then Tabular Data from the Graphs...
	Additional Information


	To print data in tabular format
	1 To print all of the text box information just press the Print tabular data button at the top of...
	2 To return to the graphic display, press the Return to graph button or re-select Tabular Data un...

	To display data in a statistical format
	Figure�4�23.� Graphs PMD Statistics menu
	1 After making your PMD:JME measurement, and while still in the PMD:JME measurement window, you m...
	Figure�4�24.� Displaying data in a statistical format window

	2 Single or multiple PMD:JME measurements can be displayed in the PMD Statistics window. Use any ...
	Additional Information
	Figure�4�25.� PMD Statistics File menu

	The File menu
	Add from Selected JME Window F2
	Add from Database...F3
	Add from Text File...F4
	Load Statistics...F5
	Save Statistics...F6
	Print Bitmap
	Print Data
	Exit

	The Edit menu
	Undo Last Add Alt+Bksp
	Clear All Data
	Copy Bitmap to Clipboard

	The Format menu
	Wavelength Range
	Histogram X-Axis

	The Help menu
	The annotation area
	Mean
	Minimum, Maximum
	Last file added
	Total size
	Subset size
	Number of bins
	Maxwell alpha parameter



	To print the PMD:JME graph
	Figure�4�26.� Printing the PMD:JME graph menu
	1 Select File and then Print from the Graphs main window.
	Graph
	Graph & Annotation
	Graph, Annotation, & Data


	To save your measurement as text
	Figure�4�27.� Save as Text menu
	1 Select File and then Save JME as Text from the Graphs main window. A standard window Save scree...
	2 At this point you can select a file name and a directory in which the data will be stored. Colu...

	To save in database format
	Figure�4�28.� Saving in database format menu
	1 Select File and then Save JME to Database... from the Graphs main window to save the entire mea...
	Specialized measurement methods


	To perform a cascade measurement
	Figure�4�29.� Targeted test device
	Setting up the system
	1 Attach the device to be calibrated out (DCO), between the OPTICAL OUTPUT and the OPTICAL INPUT ...
	Figure�4�30.� Measurement setup
	Making the measurement

	2 Prepare the external source to provide a circular state of polarization by following the proced...
	3 Select Measurement from the main window menu selections, and then PMD: Jones Matrix Eigenanalys...
	4 Set up the optical source for the desired wavelength range and the number of points, then selec...
	5 Select Measurement from the graphs main window menu selections, and then Cascaded Device.
	Figure�4�31.� Measurement start window

	6 Note that the measurement control area at the bottom of the graphs window, a yellow Cascade ban...
	Figure�4�32.� Thru calibration window

	7 The resulting measurement characterizes PMD effects of the DCO. When the thru calibration is co...
	8 Remove the output pigtail of the DCO from the optical input of the Agilent�8509C, taking care t...
	Figure�4�33.� Connecting the device

	9 Select Start Measurement. When the measurement is complete, the PMD effects of the first DCO ar...
	Figure�4�34.� The results

	CAUTION In general, the PMD values of cascaded devices do not simply add. Single Device measureme...
	Additional Information


	To use a voltage-tuned source
	1 To perform a measurement with a voltage-tuned source, open a JME PMD window and select Optical ...
	2 Use the Optical Source Selection to choose the voltage-tuned mode. You will see a change in the...
	3 Enter the wavelength parameters and number of points as you would for an HPIB source.
	4 Enter the tuning voltages corresponding to the start and stop wavelengths. This "calibrates" yo...
	5 Set the settling times as required for your source, or use the default values.
	6 Connect the tuning voltage from BNC connector "A" on the rear panel of the Agilent�8509C to the...
	7 Close the Optical Source Setup window and start the measurement.

	To use a manually-tuned source
	1 To perform a measurement with a manual source, open a JME PMD window and select Optical Source ...
	2 Use the Optical Source Selection to choose the manually tuned mode. The settling time parameter...
	3 Enter the wavelength parameters and number of points as you would for an HPIB source.
	4 Close the Optical Source Setup window and start the measurement.
	PMD:JME concepts



	Polarization mode dispersion
	Polarization modes
	General effects
	Mode coupling
	PMD units

	Fiber PMD statistics
	Fitting the Maxwell curve to the distribution
	Enlarging the sample size

	Source spectral characteristics
	Should I use the reference frame?
	Cascade measurements
	What is a cascade measurement?
	Typical applications


	Using the wavelength-scanning method
	Figure�4�35.� Example of data display for a wavelength-scanning PMD measurement
	• Measurement speed is slightly faster than the JME method.
	• The method can be performed with the Agilent�8509C.
	• The method provides more optical power to the DUT than the JME method does.
	• A single PMD value, or average differential group delay, is produced from measurement across a ...
	• Broad wavelength ranges are required for measurement of low PMD values.
	• The measurement is influenced by pigtail position and polarization launch condition, particular...
	To make a PMD:WS measurement
	Measurement setup
	1 Connect your measurement system as shown in Figure�4�36.
	Figure�4�36.� Wavelength-scanning system setup
	External source preparation
	Making the measurement

	2 Connect your test device between the OPTICAL OUTPUT of the laser source and the OPTICAL INPUT o...
	Enhancing Accuracy

	CAUTION Observe proper connection techniques. Refer to “Cleaning Connections for Accurate Measure...
	3 Select Measurement from the main menu, and then select PMD:Wavelength Scanning... Shift+F2.
	Figure�4�37.� Wavelength-scanning measurement menu

	4 Verify that the source and wavelength are correct for your measurement, and that the power is o...
	Figure�4�38.� Optical source setup for PMD:wavelength scanning window
	Additional Information

	5 Select Start Measurement from the Agilent�8509C Graphs screen.
	Figure�4�39.� PMD: WS measurement start window
	Enhancing Accuracy
	Figure�4�40.� Measurement results




	To manipulate the measurement results
	The Measurement summary bar
	Figure�4�41.� Measurement summary bar window

	The Measurement annotation area
	Figure�4�42.� Measurement annotation area window

	The Cursor bar
	Figure�4�43.� Cursor bar window
	To change the measurement format
	Figure�4�44.� Changing the measurement format menu
	1 Select Format from the Graphs window menu to access the measurement formatting functions. For a...
	Delay
	Delay/L
	Delay/sqrt(L)
	Fiber Length...
	Avg/Median/Max Delay
	Analysis
	Minimum Feature Size....
	Mode Coupling Factor (k)...
	Polarizer A, Polarizer B, Polarizer C, No Polarizer

	2 Select the appropriate units for the measurement results. If the fiber is long enough to exhibi...

	To display data in tabular format
	Figure�4�45.� Displaying data in tabular format menu
	1 Display the tabular measurement data by selecting Display and then Tabular Data from the Graphs...
	Additional Information


	To print data in tabular format
	1 To print all of the text box information just press Print tabular data on the Graphs window area.
	2 To print a portion of the text box information, select the desired text with the mouse before p...
	3 To return to the graphic display, select Return to Graph at the top of the window or re-select ...

	To print the PMD:WS graph
	Figure�4�46.� Printing your graph menu
	1 Select File and then Print PMD from the Graphs main window.

	To save your measurement as text
	Figure�4�47.� Saving as text menu
	1 Select File and then Save WS as Text from the Graphs main window. A standard window Save screen...
	2 At this point you can select a file name and a directory for the data to be stored. Columns of ...

	To save in database format
	Figure�4�48.� Saving in database format menu
	1 Select File and then Save WS to Database... from the Graphs main window to save the entire meas...
	PMD:WS concepts



	Polarization mode dispersion
	Polarization modes
	General effects
	Mode coupling
	PMD units

	Optimizing the setup for fiber or component test
	Wavelength tuning range
	Analysis mode
	Minimum feature size
	Statistical characterization of fiber PMD



	Making PDL Measurements
	Using the Jones matrix method
	Figure�4�49.� Example of a Jones matrix PDL measurement data display
	• Measurements are typically completed in two to three seconds.
	• Measurement uncertainty is typically ±0.1 dB.
	• Measurement range is 3.0 dB.
	• Operation is completely automatic.
	To make a PDL:JME measurement
	Measurement setup
	1 Connect your measurement system as outlined in Figure�4�50. Begin by connecting the thru cable ...
	Enhancing Accuracy
	Figure�4�50.� Measurement setup
	External source preparation


	2 Select System from the main menu, and then select Optical Source.
	Figure�4�51.� System menu

	3 Select the external laser source and set the CW wavelength for your measurement. Use the defaul...
	Figure�4�52.� Optical Source Setup window

	4 Select System from the main menu, and then select Polarizers.
	Figure�4�53.� Polarizer selection menu

	5 Set the polarizers to Internal and select No Polarizer. If the screen on your instrument contro...
	Figure�4�54.� Polarizer setup window

	6 Select 3pt Ref from the Markers Area on the Main Screen, wait 5 seconds, and then select Apply ...
	Figure�4�55.� 3pt reference applied window
	Additional Information

	7 Adjust the External Source Polarization knobs on the front panel of the Agilent�8509C until the...
	Figure�4�56.� Circular polarization display
	Making the measurement

	8 Remove the fiber thru cable connecting the optical output to the optical input on the Agilent�8...
	9 Connect your test device between the optical output and the optical input.
	Enhancing Accuracy

	CAUTION Observe proper connection techniques. Refer to “Cleaning Connections for Accurate Measure...
	10 Select Measurement from the main menu, and then select PDL:Jones Matrix... F3.
	Figure�4�57.� Jones matrix measurement menu

	11 Select Internal polarizers and Delta transmission measurement from the Polarization Dependence...
	Figure�4�58.� Jones matrix measurement window

	12 Connect the device you wish to measure.
	13 Press the Measure button with your mouse pointer. The results of the measurement will appear i...
	Figure�4�59.� Measurement results



	To save the measurement results

	Using the power max-min method
	Figure�4�60.� Example of a PDL measurement data display
	• Measurements are typically completed in 10 seconds to three minutes.
	• Measurement uncertainty is typically ±0.06 dB.
	• Measurement range is 30.0 dB.
	• Operation is completely automatic, when an automatic polarization controller is used.
	To make a PDL:PMM measurement
	Measurement setup
	1 Connect your measurement system as shown in Figure�4�61. The Agilent�11896A Polarization Contro...
	Enhancing Accuracy
	Figure�4�61.� Measurement setup
	External source preparation


	2 Select System from the main menu, and then select Optical Source.
	Figure�4�62.� System menu

	3 Select the external laser source and set the wavelength. Use the default power level or set as ...
	Figure�4�63.� Optical Source Setup window
	Making the measurement

	4 Connect your test device between the polarization controller and the optical input.
	Enhancing Accuracy

	CAUTION Observe proper connection techniques. Refer to “Cleaning Connections for Accurate Measure...
	5 Connect the device you wish to measure, then select Measurement from the main menu, and then se...
	Figure�4�64.� PDL measurement menu

	6 Select the Reset button with your mouse pointer.
	Figure�4�65.� PDL:Power Max-Min measurement window

	7 Vary the polarization at the input of your device under test, preferably using an automatic (li...
	Figure�4�66.� Measurement results window



	To save the measurement results


	Making Jones Matrix Measurements
	Figure�4�67.� Example of data display for a Jones matrix measurement
	To make a Jones matrix measurement
	Measurement setup
	1 Connect your measurement system as shown in Figure�4�68. The Agilent�11896A polarization contro...
	Enhancing Accuracy
	Figure�4�68.� Measurement setup
	External source preparation


	2 Select System from the main menu, and then select Optical Source.
	Figure�4�69.� System menu

	3 Select the external laser source and set the CW wavelength for your measurement. Use the defaul...
	Figure�4�70.� Optical Source Setup window

	4 Set the Agilent�8509C to use external polarizers. In the main window, select System menu and Po...
	5 Adjust the source polarization so that approximately circularly polarized light is applied to t...
	a Set the external reference polarizer to a starting angle, say 0 degrees, and select marker A on...
	b Set the polarizer approximately 60 degrees from the original position and select marker B. Care...
	c Select 2pt Ref and Apply 2pt with the mouse. Adjust the source assembly polarization adjuster u...

	6 Un-apply the 2-pt reference before proceeding. Replace the reference polarizer in the light beam.
	Making the measurement
	• A polarization reference frame is established in the open beam by mathematically removing the b...
	• The test device is inserted in the open beam, Jones Matrix measurement window is opened and the...


	To establish the polarization reference frame
	1 Place the reference polarizer in the open beam, allowing enough space following the polarizer t...
	2 Rotate the polarizer to the position you wish to define as horizontal. Select marker A.
	Enhancing Accuracy

	3 Rotate the reference polarizer by 60 degrees. Select marker B.
	4 Rotate the reference polarizer another 60 degrees, for a total of 120 degrees from the initial ...
	5 From the Markers area, select 3pt Ref and then Apply 3pt.
	CAUTION Observe proper connection techniques. Refer to “Cleaning Connections for Accurate Measure...

	To measure the Jones matrix of a device
	6 Select Measurement from the main menu, and then select Jones Matrix... F4.
	Figure�4�71.� Jones matrix measurement menu

	7 Select External Polarizers and Delta Transmission Measurement.
	Figure�4�72.� Jones matrix measurement window

	8 Insert the test device into the polarization reference frame location with the desired angular ...
	9 Set the external polarizer angle to 0 degrees and then select Meas at 0.0 from the Jones Matrix...
	10 Set the external polarizer angle to 60 degrees and then select Meas at 60.0 from the Jones Mat...
	11 Set the external polarizer angle to 120 degrees and then select Meas at 120.0 from the Jones M...
	Figure�4�73.� Measurement results window
	Concepts


	The relative Jones matrix
	The sign of s3
	Description of the Jones matrix measurement algorithm
	Figure�4�74.� Comparing the output Jones vectors to 3 known input Jones vectors

	Application of the Jones matrix
	Figure�4�75.� Jones matrix application


	Making Polarization Maintaining Fiber Launch Alignments
	Figure�4�76.� Example of a polarization maintaining fiber alignment data display
	To make a PMF alignment
	Measurement setup
	1 Connect your measurement system as shown in Figure�4�77.
	Figure�4�77.� Measurement setup
	External source preparation

	2 Select System from the main menu, and then select Optical Source.
	Figure�4�78.� System menu

	3 Select the external laser source and set the CW wavelength for your measurement. Use the defaul...
	Figure�4�79.� Optical Source Setup window
	Making the measurement
	Additional Information

	CAUTION Observe proper connection techniques. Refer to “Cleaning Connections for Accurate Measure...
	4 Select Measurement from the main menu, and then select PM Fiber Launch.
	Figure�4�80.� PM fiber launch measurement menu

	5 Slightly stress the PMF cable by pulling or heating it until an arc appears on the Poincare sph...
	Figure�4�81.� PM fiber launch alignment window

	6 Place three points along this arc by using the mouse pointer and then clicking the left mouse b...
	7 Select the Center button to center the display.
	8 Rotate the fiber chuck until the active point on the Poincare sphere approaches the center of t...
	9 Use the Poincare display Zoom and PM Fiber Launch Center functions to optimize the view of the ...
	10 Slightly stress the PMF cable by pulling or heating it until an arc appears again.
	11 Select the New Circle button, place three points on the arc using the mouse pointer.
	12 Continue the previous steps until the value in the dB extinction ratio window is maximized.
	13 Select the Done button to finish this procedure.
	14 To align another PMF cable, connect it to the analyzer and repeat the previous procedure.
	Concepts



	Explanation of polarization maintaining fiber launch mathematics
	Figure�4�82.� How PMF cable launch extension ratio is calculated


	Making Polarization Reference Frame Measurements
	Figure�4�83.� Example of the results that can be achieved with and without a polarization referen...
	To make a polarization reference frame measurement
	Measurement setup
	1 Connect your measurement system as shown in Figure�4�84.
	Enhancing Accuracy
	Figure�4�84.� Measurement setup
	External source preparation
	Figure�4�85.� System menu



	2 Select System from the main menu, and then select Optical Source.
	3 Select the external laser source and set the wavelength to the desired value. Use the default p...
	Figure�4�86.� Optical Source Setup window


	To choose the polarizers
	1 You may choose the external polarizers by first selecting System, with your mouse pointer, from...
	2 When the Polarizers window appears, select External with the mouse pointer, then select Done.

	To set the reference frame
	1 Set the external polarizer to horizontal linear polarization, and select the A�Marker.
	2 Rotate the external polarizer 60 degrees from original position and select the B�Marker.
	3 Rotate the external polarizer an additional 60 degrees, to a position 120° from the original. S...
	4 Select 3pt Ref with your mouse pointer.
	Additional Information


	To check the reference frame quality
	1 To check the quality of the reference frame, select System and then Reference Frame Info....
	2 If the quality is poor then you must repeat the previous steps, starting at “To choose the pola...
	3 If the quality is good, select OK to continue, then select Apply 3pt with your mouse pointer fr...

	To set a circular state of polarization
	1 Remove the Rotatable Reference Polarizer.
	2 Use the mouse pointer to select the Clear Trace button.
	3 Adjust the polarization adjuster until the active data point approaches a pole on the Poincare ...
	4 Reinsert the Rotatable Reference Polarizer into the test setup and repeat the Reference frame p...

	To use the reference frame
	Enhancing Accuracy
	CAUTION Observe proper laser safety; refer to “General Safety Considerations” at the front of thi...

	Additional measurement applications
	2pt and 3pt polarization reference frames
	Measurement of the retardance of an optical device
	Measurement of output polarization of an optical integrated circuit
	Measuring polarization state at a connector surface
	Concepts

	Explanation of polarization reference frame mathematics
	Transmission ratio (3pt reference frame)

	Making State of Polarization Measurements
	Figure�4�87.� Example of a SOP measurement data display
	To make signal polarization parameters measurements
	Measurement setup
	1 Connect your measurement system as shown in Figure�4�88.
	Figure�4�88.� Measurement setup
	External source preparation

	2 Select System from the Main menu, and then select Optical Source.
	Figure�4�89.� System menu

	3 Select the external laser source and set the desired wavelength.
	Figure�4�90.� Optical Source Setup window
	Making the measurement

	1 Activate the laser source and ensure that the fiber and the laser are thermally and vibrational...
	2 The main window should now display the correct input state of polarization, DOP, and power leve...
	CAUTION Observe proper connection techniques. Refer to “Cleaning Connections for Accurate Measure...
	Figure�4�91.� SOP and DOP measurement results screen
	Concepts


	Degree of polarization
	DOP = (S12 + S22 + S32)1/2 / S0 = (s12 + s22 + s32)1/2

	Electric fields and polarization
	Figure�4�92.� Polarization changes with Ex(t) and Ey(t)
	Elliptical displays of polarization
	Figure�4�93.� Elliptical displays of polarization
	Figure�4�94.� Mathematical description of an elliptical display of polarization

	Poincare sphere
	Figure�4�95.� Polarization states on a poincare sphere

	Stokes parameters


	Making Marker Angles
	To make a marker angles measurement
	1 Select Measurement and then Marker Angles. A Marker Angles group will appear in the main window...
	2 Check the On box from the Markers area to set a marker.
	3 Click on Clear Markers to clear any previous data.
	4 Select A to define your first marker for your first state of polarization measurement. Define m...
	5 Read the Marker Angles from the Marker angles group just below the power meter and DOP bars.
	6 When finished, select Done to close the marker angles group.

	Making Timed Measurements
	Figure�4�96.� Timed Measurement selection
	Figure�4�97.� Timed Measurement
	To make a free run mode measurement
	1 Select Free Run from the drop-down list of the Timed Measurement Mode.
	2 In the Number of Samples box, enter the number of measurement samples you want to collect. A ma...
	3 Check the Large Dot Size to display the Poincare Sphere using 9x9 pixel display or clear the ch...
	4 Select Start Sample Sequence to begin the measurement.

	To make a timed mode measurement
	1 Select Timed from the drop-down list of the Timed Measurement Mode.
	2 In the Number of Samples box, enter the number of measurement samples you want to collect. A ma...
	Figure�4�98.� Timed measurement mode.

	3 Enter either the period (0.010 to 7209 seconds) or rate (0.00013 to 100 Hz) of the time measure...
	4 Select Start Sample Sequence to start the measurement. The data acquisition status box appears,...
	Figure�4�99.� Status of the time measurement


	To make a single mode measurement
	1 Select Single from the drop-down list of the Timed Measurement Mode. Refer to “Single mode meas...
	Figure�4�100.� Single mode measurement

	2 Press Take Sample once for each polarization measurement desired.
	3 From the System > Averaging menus, select Display Averaging On and specify the number of sample...

	To view timed measurements on the Poincare sphere
	Figure�4�101.� Rotate and zoom controls

	To save timed measurements
	1 Select File > Save > Timed Measurement to Database to save a time measurement to the database. ...
	2 Select File > Save > Timed Measurement As Text to save a timed measurements to a text file.
	Figure�4�102.� Save a timed measurement


	To recall (load) timed measurements
	1 Select File > Save > Timed Measurement to Database As Text to load a timed measurement from the...
	2 Select File > Load > Timed Measurement As Text to load a timed measurement from a text file.
	Figure�4�103.� Load a timed measurement from text file





	Using the Display Menu
	Using the Display Menu
	The PRESET Configuration
	Figure�5�1.� PRESET configuration window

	The Display Menu
	Figure�5�2.� Display menu
	Using the Show functions
	To display the marker table
	Figure�5�3.� The Show Markers menu
	Figure�5�4.� Marker window hidden display

	To display the Poincare sphere
	Figure�5�5.� Show Sphere menu
	Figure�5�6.� Poincare sphere display turned off window

	To display the polarization ellipse
	Figure�5�7.� Show Ellipse menu
	Figure�5�8.� Polarization ellipse display turned off window

	To exchange the Poincare sphere and the polarization ellipse
	Figure�5�9.� Show Sphere <-> Ellipse menu
	Figure�5�10.� Sphere and ellipse exchanged display window


	Using the Power Display functions
	Figure�5�11.� Power Display menu
	To change the power display units
	Figure�5�12.� Power display in watts mode window


	Using the Mark Current Point functions
	Figure�5�13.� The Mark Current Point menu
	To mark the current point
	Figure�5�14.� Mark current point activated display window


	Using the Display Update functions
	Figure�5�15.� Display Update menu
	To change the display update frequency
	Figure�5�16.� Display Update window
	CAUTION The display update frequency cannot be smaller than the display averaging factor. Display...


	Using the Hold functions
	Figure�5�17.� Hold menu
	To hold the data display
	Figure�5�18.� Hold function display window


	Using the Clearing Trace functions
	Figure�5�19.� Clear Trace menu
	To clear the trace from the sphere

	Using the Auto Refresh functions
	Figure�5�20.� Auto Refresh menu
	To set the display to refresh automatically



	Using the System Menu
	Using the System Menu
	The System Menu
	Figure�6�1.� System menu
	Using the Optical Source functions
	To open the Optical Source Setup window
	Figure�6�2.� Optical Source Setup window
	• Select System, Optical Source, or
	• Select l (located in the upper right corner of the basic measurement screen), or
	• Press F8 on your keyboard.


	Using the Zero functions
	To initiate the receiver zeroing routine
	• Select System, Zero.
	• Press F9 on your keyboard.
	Making Accurate Measurements



	Using the Calibration functions
	• Optimize performance when using a source whose wavelength is uncertain to greater than ±1 nm.
	• Optimize performance when using a source with broad optical spectrum, such as a Fabry-Perot las...
	• Minimize any uncertainty caused by ambient temperature change or instrument aging.
	Additional Information

	• Fixed wavelength source calibration
	• Tunable wavelength source calibration
	• Applying and deleting calibrations
	Figure�6�3.� Calibration window
	Enhancing Accuracy

	To calibrate for use with a fixed wavelength source
	To select the source to be calibrated
	1 Open the Optical Source Setup window by selecting l.
	2 Select an external source.
	Figure�6�4.� Optical Source Setup window


	To calibrate at the selected wavelength
	1 Open the Calibration window by using the mouse to select System, Calibration, or by pressing F1...
	Figure�6�5.� Calibration window

	2 Select the "Fixed l" source type.
	3 Be sure that your source is turned on and tuned to the desired wavelength (if it is an external...
	4 The calibration works best if the optical signal is polarized before it is applied to the Agile...
	5 Move the fiber ahead of the polarizer, or adjust the front panel knobs (if necessary) to assure...
	6 Select Calibrate.
	Enhancing Accuracy

	7 You will hear some clicking from inside the Agilent�8509C as the calibration is being performed...
	8 Calibrate at other wavelengths by repeating the above procedure.

	To save and/or apply the calibration
	1 The calibration list for fixed wavelengths provides the following information:
	Figure�6�6.� Calibration list window

	2 To save all calibrations in the list with the "New" designation, select Save new calibrations.
	3 To apply a calibration, select Apply Calibration On in the Calibration window. (See “To apply a...
	Additional Information


	To calibrate for use with a tunable wavelength source
	To select an external source and input wavelength
	1 Open the Optical Source Setup window by selecting l.
	Figure�6�7.� Optical Source Setup window

	2 Select an external source, such as the Agilent�8168A.
	3 Select Manually tuned for other, non-automatic tunable sources.
	4 Input the first wavelength you want to calibrate.

	To calibrate at the selected wavelength
	1 Open the Calibration window by using the mouse to select System, Calibration, or by pressing F1...
	Figure�6�8.� Calibration window

	2 Select a tunable wavelength source.
	3 Be sure your source is turned on and tuned to the desired wavelength.
	4 The calibration works best if the optical signal is polarized before it is applied to the Agile...
	5 Move the fiber ahead of the polarizer, or adjust the front panel knobs (if necessary) to assure...
	6 Select Calibrate.
	7 You will hear clicking from inside the Agilent�8509C as the calibration is being performed. The...
	8 To calibrating subsequent wavelengths, enter the new wavelength in the wavelength box in the Ca...
	9 Select Calibrate.

	To save wavelength calibrations
	Figure�6�9.� Calibration list window

	To apply a calibration
	Applying a calibration
	• If you are still working within the Calibration window and wish to apply your calibration, use ...
	• To apply another calibration, select the item in the calibration list. Select Apply Calibration...
	Additional Information
	How to tell if a calibration is applied
	Figure�6�10.� Calibration applied window




	To delete a calibration
	1 A calibration can be deleted by selecting an entry in the Calibration List, and then selecting ...
	Figure�6�11.� Deleting a selection in the Calibration window

	2 A window appears to confirm that you want to delete the calibration or cancel the delete calibr...
	Figure�6�12.� Confirm or abort the deletion process window

	3 When calibration data is deleted, it is deleted from memory and from the disk file.


	Using the Polarizers function
	Figure�6�13.� Polarizers window
	To open the Polarizers window
	To select an internal polarizer
	1 To select an internal polarizer, select Internal in the Polarizers window.
	2 Select polarizer A, B, or C.
	3 Select No Polarizer to remove an internal polarizer from the signal path.
	About internal polarizers


	To select an external polarizer
	1 Select External from the Polarizers window.
	Note

	2 Input your angle values, in degrees, for external polarizers A, B, and C: select the numbers in...
	Polarizer angles and the Poincare display



	Using the Shutter functions
	Figure�6�14.� Shutter window
	To put the shutter into the signal path manually

	Using the Averaging functions
	Figure�6�15.� Averaging window
	To open the Averaging window
	To select Display Averaging
	Additional Information
	About display averaging


	To select Measurement Averaging
	About measurement averaging
	• a polarizer is used in a measurement and
	• when markers are set, as in the setting of an external reference frame.


	Using the Range functions
	Figure�6�16.� Range window
	To open the Range window
	To select Autorange
	To select a specific gain state
	1 Deselect Autorange.
	2 To accommodate high signal levels, select �. For operation with low level signals, select Ø.
	3 Continue pressing � or Ø until the power display (in the upper-left corner of the lightwave pol...
	4 Once you have reached the Overrange or Underrange condition, press � or Ø once to remove the Ov...
	5 The gain will stay in this state until a different range is selected or until Autorange is sele...
	About range



	Using the Analog Outputs functions
	Figure�6�17.� Analog Outputs window
	To open the Analog Outputs window
	To use the DOP and normalized Stokes parameters mode
	Table�6�1.� Analog Outputs for DOP and Normalized Stokes Parameters Mode

	To use the raw photodiode currents
	Table�6�2.� Analog Outputs for Raw Diode Currents Mode


	Using the Reference Frame Info functions
	To open the Reference Frame Info window
	Figure�6�18.� No Defined Reference Frame Info window
	• The type of reference frame (two- or three-point), and whether or not it has been applied.
	• The polarization angle (two-point reference only) or the transmission ratio (three-point only).
	• The quality of the reference frame (one of the following):
	Figure�6�19.� Two-Point Reference Frame Info window
	Figure�6�20.� Three-Point Reference Frame Info window



	Using the Operation Verification functions
	To verify that your system is working properly
	1 Allow the instrument to warm up for at least 1 hour and then zero the instrument.
	2 Make sure the optical cable connecting the polarizer to the lightwave polarization analyzer’s O...
	3 Select System, Operation Verification from the main window display.
	Figure�6�21.� Operation Verification window

	4 Select Start. When the verification procedure is finished, the message Operation Verification p...
	5 The operation verification is complete. Select Done to clear the window and begin your measurem...


	To establish a Dynamic Data Exchange (DDE) link between the 8509 and another application
	Establishing DDE links
	• The name of the application it wants to talk to
	• The subject of the conversation, called a topic
	• The name of the item with which the DDE conversation should take place

	To execute a DDE command manually
	1 Select System and then DDE Server from the drop-down list.
	2 Click on the Execute Command to send the command to the 8509.

	To update the list of DDE commands available from the DDE server window



	Reference
	Reference
	Accuracy Enhancement and Troubleshooting
	• Connect the electrical power and turn the instrument on.
	• Connect the interface cable between the instrument controller and the Agilent�8509C.
	• Connect the HPIB cable to the external optical source, if necessary.
	• Allow the instrument to warm up for at least one hour and zero the instrument following warm-up.
	• Allow the tunable laser source to warm up completely, if used.
	• Clean all connector surfaces.
	• Stabilize the optical fiber during some types of measurements.
	Note
	Figure�7�1.� Measurement troubleshooting matrix


	Symptoms
	Solutions

	Generating of Right-Hand Circularly Polarized Light
	Options and Accessories
	Power Cords
	* Part number shown for plug is the industry identifier for the plug only. Number shown for cable...

	Cleaning Connections for Accurate Measurements
	Choosing the right connector
	• How much insertion loss can be allowed?
	• Will the connector need to make multiple connections? Some connectors are better than others, a...
	• What is the reflection tolerance? Can the system take reflection degradation?
	• Is an instrument-grade connector with a precision core alignment required?
	• Is repeatability tolerance for reflection and loss important? Do your specifications take repea...
	• Will a connector degrade the return loss too much, or will a fusion splice be required? For exa...
	Figure�7�2.� Basic components of a connector
	Figure�7�3.� Universal adapters to Diamond HMS-10
	Figure�7�4.� Cross-section of the Diamond HMS-10 connector


	Inspecting connectors
	• Never use metal or sharp objects to clean a connector and never scrape the connector.
	• Avoid matching gel and oils.
	Figure�7�5.� Clean, problem-free fiber end and ferrule
	Figure�7�6.� Dirty fiber end and ferrule from poor cleaning
	Figure�7�7.� Damage from improper cleaning

	• When inserting a fiber-optic cable into a connector, gently insert it in as straight a line as ...
	• When inserting a fiber-optic connector into a connector, make sure that the fiber end does not ...
	• Avoid over tightening connections.
	• Keep connectors covered when not in use.
	• Use fusion splices on the more permanent critical nodes. Choose the best connector possible. Re...
	Measuring insertion loss and return loss
	Visual inspection of fiber ends

	WARNING Always remove both ends of fiber-optic cables from any instrument, system, or device befo...

	Cleaning connectors
	CAUTION Agilent Technologies strongly recommends that index matching compounds not be applied to ...
	Table�7�1.� Cleaning Accessories
	Table�7�2.� Dust Caps Provided with Lightwave Instruments
	To clean a non-lensed connector

	CAUTION Do not use any type of foam swab to clean optical fiber ends. Foam swabs can leave filmy ...
	1 Apply pure isopropyl alcohol to a clean lint-free cotton swab or lens paper.
	2 Clean the ferrules and other parts of the connector while avoiding the end of the fiber.
	3 Apply isopropyl alcohol to a new clean lint-free cotton swab or lens paper.
	4 Clean the fiber end with the swab or lens paper.
	5 Immediately dry the fiber end with a clean, dry, lint-free cotton swab or lens paper.
	6 Blow across the connector end face from a distance of 6 to 8 inches using filtered, dry, compre...

	CAUTION Do not shake, tip, or invert compressed air canisters, because this releases particles in...
	7 As soon as the connector is dry, connect or cover it for later use.
	To clean an adapter
	Figure�7�8.� Universal adapters


	1 Apply isopropyl alcohol to a clean foam swab.
	2 Clean the adapter with the foam swab.
	3 Dry the inside of the adapter with a clean, dry, foam swab.
	4 Blow through the adapter using filtered, dry, compressed air.



	If You Have a Problem
	Problems requiring additional resources
	The system appears to be dead
	• The instrument controller’s fan and disk drive will make a certain amount of noise when the ins...
	• The monitor has an indicator light on the power button that should light up when the monitor is...
	That the instrument controller, monitor and analyzer are all connected to the ac power source.
	Check the line voltage selector switch on the rear of the Agilent�8509C to ensure that it is set ...
	Check the line fuse on the lightwave polarization analyzer to ensure that it is not damaged. The ...
	If the instrument controller does not respond

	Make sure that the mouse and keyboard are plugged into the correct sockets on the back of the ins...
	Make sure that the mouse and keyboard cables are plugged in all the way and that a good connectio...
	If you get the “EEprom not formatted or Box on?” error message

	Ensure that the lightwave polarization analyzer voltage selector switch is properly set, that it ...
	Ensure that the dedicated interface cable is properly connected to both the lightwave polarizatio...
	If operation verification fails
	DOP measurement is out of specification
	Ensure the connectors are clean. Use isopropyl alcohol and cotton swabs to clean optical connecto...
	Ensure that the optical connections are properly seated and finger tightened.
	If the operation verification still fails, perform and apply a calibration for the particular sou...
	If the operation verification still fails, contact Agilent Technologies. Refer to “Agilent Techno...
	Power display reads underrange

	If you are using an external source, ensure that the source is turned on.
	If the source is turned on and the power display still reads underrange, contact Agilent Technolo...


	Returning the Instrument for Service
	Preparing the instrument for shipping
	1 Write a complete description of the failure and attach it to the instrument. Include any specif...
	2 Cover all front or rear-panel connectors that were originally covered when you first received t...
	CAUTION Cover electrical connectors to protect sensitive components from electrostatic damage. Co...
	CAUTION Instrument damage can result from using packaging materials other than the original mater...
	3 Pack the instrument in the original shipping containers. Original materials are available throu...
	4 Seal the carton with strong nylon adhesive tape.
	5 Mark the carton “FRAGILE, HANDLE WITH CARE”.
	6 Retain copies of all shipping papers.



	Agilent Technologies Service Offices

	Measurement Programming and Examples
	Measurement Programming and Examples
	HPIB Overview
	Bus Structure
	Data Bus
	Handshake Lines
	Control Lines

	Sending Commands

	HPIB for the Agilent 8509
	HPIB to DDE Interface
	‘Command Line’ Setup Options
	/Errors Only
	/HP8509=<Name>
	/HP8509TimeOut=<Number of Minutes>
	Agilent 8509 Control Frame
	HPIB Frame
	Dynamic Data Exchange (DDE) Frame

	Basic Instrument Control
	Data Requesting Commands
	Operation Complete
	Preparing for HPIB Control

	Interacting with the Agilent 8509C Through the DDE
	Establishing DDE links
	• The name of the application it wants to talk to
	• The subject of the conversation, called a topic
	• The name of the item with which the DDE conversation should take place

	Sending Agilent 8509 Commands via DDE
	Retrieving Agilent 8509 Data via DDE
	Measurement Sequence
	1 Zero the instrument.
	2 Calibrate the instrument.
	3 Set up the instrument.
	4 Connect the device.
	5 Take data.
	6 Transfer data.
	7 You will not be prompted to "Block the external laser", but you must either cover the OPTICAL I...

	Calibrate the instrument
	Set up the instrument
	Connect the device
	Take data
	Transfer data
	HPIB Programming Examples

	Command Syntax
	Table�8�1.� Conventions

	Abbreviations/Definitions
	Changes from Version 1.2 Software
	*OPC[?]
	Cal:Calibrate
	Disper:Close
	Source? Source:External? Source:Internal?
	Note


	Common Commands
	*IDN?
	*OPC[?]

	Device Specific Commands
	Analog?
	Analog:Done
	Analog:{Off | Raw | Stokes} [?]
	Angles:{AB? | AC? | BC?}
	Angles:{Degrees | Radians}[?]
	Angles:Done
	Not Recommended

	Angles:{Off | On}
	Average:Display:{Off | On}
	Average:Display{? | :<NumPoints>}
	Average:Done
	Average:Measure{? | :<NumPoints>}
	Cal?
	Cal:Calibrate
	Cal:{Done | Save}
	Cal:Delete:<Wavelength nm>
	Cal:List?
	Cal:{Off | On}
	ClearParams
	DBase:Close
	DBase:Compact
	DBase:Filename?
	DBase:Open:<“filename”>
	DBase:Repair
	Disper
	Disper?
	Disper:ActiveWindow?
	Disper:Atten{? | :<dBm value>}
	Disper:Calibrate
	Disper:{Cascade | Single}[?]
	Disper:Chain[?]
	Not Recommended

	Disper:Clear
	Disper:Close
	Disper:DBase:Load:<“title”>
	Disper:DBase:Save:<“title”> [ :<“date code”> [ :<“serial number”>]]
	Disper:Done
	Not Recommended

	Disper:FiberLen{? | :<km>}
	Disper:FindMinPoints[:<Num Samples>]
	Disper:HPIB[?]
	1 Issue the command Disper:Manual
	2 Change the wavelength range using Disper:WLen:
	3 Change the HPIB address using TLS:Address:<HPIB Address>
	4 Issue the command Disper:HPIB

	Disper:Manual
	Disper:Manual?
	Disper:Measure
	Disper:NewThruCal
	Not Recommended

	Disper:Power?
	Disper:Power:{dBm | uWatt}[:<value>]
	Note

	Disper:Restart
	Not Recommended

	Disper:Save:<“filename”>
	Disper:Settle:{Point | Start}{? | :<Delay msec>}
	Disper:Start
	Not Recommended

	Disper:Trace:<“filename”>
	Not Recommended

	Disper:Units{? | :ps | :ps/L | :ps/sqrtL | :fs | :fs/L | :fs/sqrtL}
	Disper:VTune[?]
	Disper:VTune:{Start | Stop}{? | :<Voltage>}
	Disper:WLen?
	Disper:WLen:Points{? | :<NumPoints>}
	WlenDelta = (WlenStop – WlenStart) / (WlenPoints – 1)

	Disper:WLen:{Start | Stop | Delta}{? | :<Wavelength nm>}
	WlenPoints = ((WlenStop – WlenStart) / WlenDelta) + 1
	Note


	Disper:WLen:Steps{? | :<NumPoints>}
	Not Recommended
	WlenDelta = (WlenStop – WlenStart) / WlenSteps
	Note


	Display:Angles:{Off | On}
	Not Recommended

	Display:Angles:{Degrees | Radians}
	Not Recommended

	Display:Power:{Linear | Log}
	Display:Update{? | :<NumPoints>}
	Drive?
	Drive:<MS-DOS Drive Spec>
	GetFile:<“filename”>
	GetMarker:{A | B | C}
	Not Recommended

	GetMarker?:{A | B | C}
	Jones?
	Not Recommended

	Jones:{Absolute | Relative}[?]
	Not Recommended

	Jones:Calibrate[A | B | C]
	Not Recommended

	Jones:Clear
	Not Recommended

	Jones:Done
	Not Recommended

	Jones:{External | Internal}[?]
	Not Recommended

	Jones:{MagRadians | MagDegrees | RealImag}[?]
	Not Recommended

	Jones:Measure[A | B | C]
	Not Recommended

	Jones:NewThruCal
	Not Recommended

	Jones:ReStart
	Not Recommended

	Load:Config:Preset
	Load:Config:<“filename”>
	1 The windows working directory.
	2 The Agilent�8509C application directory.
	3 The Windows directory (usually C:\WINDOWS).

	Load:Single:<“filename”>
	OperVer[?]
	OperVer:{Start | Cancel | Done}
	PdlMaxMin[?]
	PdlMaxMin:{Max | Min}
	PdlMaxMin:Delta?
	PdlMaxMin:{Reset | Clear | Done}
	Per?
	Poincare:Center:{Stokes | A | B | C}
	Poincare:Clear
	Poincare:Hold:{Off | On}
	Poincare:Marker:{A | B | C}
	Poincare:Marker:Clear
	Polarizer:{A | B | C | None}[?]
	Polarizer:Angle{A | B | C}{? | :<Degree Value>}
	Note

	Polarizer:Done
	Polarizer:{External | Internal}
	PolDep?
	Not Recommended

	PolDep:{Absolute | Relative}[?]
	PolDep:Calibrate[A | B | C]
	PolDep:Clear
	PolDep:Done
	PolDep:{Internal | External}[?]
	PolDep:{JonesData? | PolDepData?}
	PolDep:{JonesMode | PolDepMode}[?]
	PolDep:{MagRadians | MagDegrees | RealImag}[?]
	PolDep:Measure[A | B | C]
	PolDep:NewThruCal
	PolDep:ReStart
	Not Recommended

	PolMarker:{A | B | C}
	Not Recommended

	PolMarker?:{A | B | C}
	Range:Auto{? | :Off | :On}
	Range:{Done | Down | Up}
	Range{? | :<GainValue>}
	RawDat?
	rawdat (volts) = ( obtained rawdat/65536 * 20 ) – 10

	RefFrame?
	polarization angle = 90 / ( pi * Acos(angle between 2pts) )

	RefFrame:{Off | On}[?]
	RefFrame:{2pt | 3pt}[?]
	Save:Config:<“filename”>
	Save:Disper:<“filename”>
	Not Recommended

	Save:Jones:<“filename”>
	Not Recommended

	Save:PolDep:<“filename”>
	Save:Single:<“filename”>
	SerialNum?
	SetMarker:<S0>:<s1>:<s2>:<s3>:{A | B | C}
	Single
	Single:Done
	Single:DBase:Load:<“title”>
	Single:DBase:Save:<“title”> [:<“date code”> [:<“serial number”>]]
	Single:Freq{? | :<Hertz>}
	Single:Mode{? | :Single | :Timed | :FreeRun}
	Single:Period{? | :<Seconds>}
	Single:Points{? | :<NumPoints>}
	Single:Start
	Source?
	Note

	Source:External?
	Source:External:{Off | On}
	Not Recommended
	Note

	Source:External:<Wavelength nm>
	Source:HPIB[?]
	Source:HPIB:{Off | On | <Wavelength nm>}
	Source:Manual[?]
	Source:Shutter?
	Source:Shutter:{Off | On}
	Source:VTune[?]
	Source:VTune:{Start | Stop}{? | :<Voltage>}
	Status?
	"PASS"
	"FAIL" <Optional Description>
	"PROBLEMS" <Optional Description>
	"UNKNOWN"

	Stokes:<NumPoints>
	Not Recommended

	Stokes?:<NumPoints>
	TLS?
	TLS:Address{? | :<HPIB Address>}
	TLS:Isc{? | :<HPIB card ISC>}
	TLS:Power{?| :<Power>}
	TLS:{SettlePoint | SettleStart}{? | :<Millisec’s>}
	Not Recommended

	TLS:Power:Unit{? | :dBm | :Watt}
	Trace:Points:<NumPoints>
	Not Recommended

	Version?
	WaveScan[?]
	Note

	WaveScan:Analysis?
	WaveScan:Analysis:{Extrema | Peaks}:{FullScan | FirstToLast}
	WaveScan:Atten{? | :<dBm value>}
	WaveScan:Clear
	WaveScan:Close
	WaveScan:DBase:Load:<“title”>
	WaveScan:DBase:Save:<“title”> [ :<“date code”>[<“serial number”>]]
	WaveScan:Feature{? | :<Min Feature Size>}
	WaveScan:FiberLen{? | :<km>}
	WaveScan:HPIB[?]
	1 Issue the command WaveScan:Manual
	2 Change the wavelength range using WaveScan:WLen:
	3 Change the HPIB address using TLS:Address:<HPIB Address>
	4 Issue the command WaveScan:HPIB

	WaveScan:Manual[?]
	WaveScan:Measure
	WaveScan:Mode{? | :<Mode Constant>}
	WaveScan:PmdResult{? | :Avg | :Max | :Median}
	WaveScan:Polarizer{? | :A | :B | :C | :None}
	WaveScan:Power?
	WaveScan:Power:{dBm | uWatt}[:<value>]
	Note

	WaveScan:Save:<“filename”>
	WaveScan:Settle:{Point | Start}{? | :<Delay msec>}
	WaveScan:Units:{? | :ps | :ps/L | :ps/sqrtL}
	WaveScan:VTune[?]
	WaveScan:VTune:{Start | Stop}{? | :<Voltage>}
	WaveScan:WLen?
	WaveScan:WLen:{Start | Stop | Delta}{? | :<Wavelength nm>}
	WLenPoints = ((WLenStop – WLenStart) / WLenDelta) + 1
	Note


	WaveScan:WLen:Points{? | :<NumPoints>}
	WLenDelta = (WLenStop – WLenStart) / (WLenPoints – 1)

	Zero


	Specifications and Characteristics
	Specifications and Characteristics
	Specifications and Regulatory Information
	• Specifications describe warranted performance standards or limits against which the Agilent�850...
	• Characteristics provide useful information by giving functional, but nonwarranted, performance ...
	Calibration Cycle


	General Specifications
	Table�9�1.� General Specifications

	Warranted Specifications
	Polarization mode dispersion (PMD) specifications, JME method
	Table�9�2.� Maximum Measurable DGD Using JME Delay
	Table�9�3.� PMD Measurement Uncertainty Using the JME Method


	Characteristics
	Jones matrix eigenanalysis PMD measurement
	Table�9�4.� Repeatability of JME PMD Measurement with Fixed Pigtail Positions
	Table�9�5.� Repeatability of JME PMD Measurement with Randomized Pigtail Positions

	Wavelength scanning PMD measurement
	Table�9�6.� Minimum Measurable PMD Using the Wavelength Scanning Method

	Comparison of JME and wavelength scanning methods
	Comparison of JME and WS Measurement Methods for Long Optical Fiber Test
	1 The test device was 14 km of loosely-spooled, dispersion-shifted fiber. Eleven measurements of ...
	2 Wavelength scanning responses typically exhibited 16 extrema (# of extrema = # of peaks + # of ...
	3 Wavelength scanning measurements use mode coupling factor of 0.82.

	Receiver characteristics
	Table�9�7.� Receiver Characteristics

	Polarization dependence, Jones matrix method
	Table�9�8.� Measurement of Polarization Dependence Jones Matrix Method

	Polarization dependence, power max–min method
	Table�9�9.� Measurement of Polarization Dependence Power Max–Min Method

	Other characteristics
	Table�9�10.� External Source Input Port, Fiber Size, and Analog Output Range Characteristics


	Regulations and Licensing
	Declaration of Conformity


